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ВСТУП 

 

Навчальний посібник призначений для студентів та майбутніх фахівців у 

галузі інформаційних технологій. Сьогодні на ринку праці відчувається великий 

попит на знавців у цій галузі. Однак з кожним роком кількість професіоналів 

буде зростати, а попит, як наслідок, втрачати свої лідируючі позиції. Для того 

щоб бути конкурентноздатними у будь-які часи, необхідно зробити правильний 

вибір та раціонально розпорядитися своїм часом на опанування справи, яка зго-

дом, можливо, стане справою життя. 

Перш за все, цей курс розроблено з метою ознайомлення з сучасними на-

прямками розвитку індустрії графічного дизайну та надання допомоги у зрозу-

мінні вимог конкретної галузі, де студенти зможуть реалізуватися як кваліфіко-

вані фахівці. 

Привести в рух творчі можливості допоможуть такі напрямки: ретуш фо-

тографії, відтворення чаруючих візуальних ефектів, робота з поліграфічною про-

дукцією, створення анімації та розробка макета сайту. 

По-друге, посібник допоможе ознайомитися з основними принципами ро-

боти з растровими зображеннями, методами відновлення та колоризації пошко-

джених та чорно-білих зображень, особливостями роботи з різними кольоровими 

моделями, векторними фрагментами, оволодіти способами здійснення тонової та 

кольорової корекції, створенням текстових складових, роботою з фільтрами, ос-

новними прийомами автоматизації, створенням анімаційних зображень, застосу-

ванням пакета для потреб WEB.
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1. ЗНАЙОМСТВО З ІНТЕРФЕЙСОМ, ІНСТРУМЕНТАМИ ВИДІЛЕННЯ ТА МОЖЛИВОСТЯМИ 

ТРАНСФОРМУВАННЯ ЗОБРАЖЕНЬ 

 

1.1. Загальні поняття 

 

‒ Adobe Photoshop ‒ багатофункціональний графічний редактор, який роз-

роблено та поширюється фірмою Adobe Systems. Переважно працює з растро-

вими зображеннями, але має декотрі векторні інструменти [1, 2, 3]. 

‒ Растрове зображення ‒ зображення, що складається з сітки пікселів на 

моніторі, папері та інших відображальних пристроях та матеріалах[1, 2, 4]. 

‒ Піксель ‒ найменший логічний елемент двовимірного растрового зобра-

ження або фізичний елемент матриці дисплеїв. Піксель є неподільним об’єктом 

прямокутної або круглої форми, що характеризується певним кольором, яскраві-

стю та інколи прозорістю [1, 2, 5]. 

‒ Формати растрової графіки ‒ BMP, GIF, PNG, JPEG, TIFF, RAW та ін. 

‒ При створенні нового документа в середовищі Adobe Photoshop відкри-

вається відповідне вікно (рис. 1.1). 

 
Рис. 1.1. Вікно створення нового документа
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Розглянемо основні поля для налаштування параметрів створюваного зо-

браження [1, 2, 6, 7, 8]. 

‒ Name ‒ дозволяє присвоїти ім’я новому документу. 

‒ Document type ‒ дозволяє обрати один із запропонованих шаблонів доку-

мента. Так, наприклад, для документа типу Web, роздільна здатність запропоно-

вана 72ppi, для International paper розмір аркуша за замовчуванням буде задано 

формату А4 із можливістю обрання інших форматів. У більшості випадків є сенс 

обирати замовний тип, що налаштовує документ під конкретне зображення. 

‒ Size ‒ надає список шаблонів розмірів залежно від обраного типу доку-

мента. 

‒ Width и Height ‒ налаштування ширини та висоти відповідно, а також 

зручних одиниць виміру. 

‒ Resolution – роздільна здатність документа, що створюється. Це кількість 

пікселів на одиницю площини або довжини (щільність), яка формує чіткість зо-

браження. Чим більше щільність пікселів, тим вище роздільна здатність та чіт-

кість зображення. Для розміщення у вебпросторі достатньо 72ppi, для підготовки 

до друку 300ppi. 

‒ Color Mode ‒ кольорова модель. Найбільш поширені з них RGB та 

CMYK. RGB найчастіше використовують для виведення зображення на екрани, 

дисплеї та монітори, в той час як CMYK призначена для виведення зображення 

на друк. Варто згадати і про Grayscale «градації сірого», яка призначена для під-

готовки до друку для чорно-білих принтерів. Чим вище параметр глибини ко-

льору, тим менше будуть помітні колірні деформації після застосування n-го фі-

льтра або коригуючого шару до зображення. Зі збільшенням цього параметра збі-

льшується розмір створюваного документа, тому важливо знайти баланс залежно 

від кінцевої мети. Для редагування зображень у середовищі Adobe Photoshop ре-

комендується працювати з глибиною кольору 16bit. 
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‒ Background Contents ‒ фон документа, що створюється, який залежить  

суто від поставлених завдань. Є можливість обрати як фон будь-який колір, а 

також прозорий фон. 

‒ Color Profile ‒ потребує вибору колірного профілю під різні пристрої ви-

ведення зображення. Найпоширеніші – це sRGB і Adobe RGB (1998). Рекомен-

дується використовувати sRGB для 8 бітових зображень, тому що цей профіль 

не має великого колірного охоплення (наприклад, у порівнянні з ProPhoto RGB), 

але кольори в ньому досить насичені і добре підходять для використання у веб-

середовищі. Adobe RGB (1998) буде охоплювати більший колірний спектр, який 

може надати 16-ти бітове зображення з його 281 трильйонами кольорів. 

‒ Pixel Aspect Ratio ‒ попіксельна пропорція. Найчастіше використовують 

квадратні пікселі. Однак, якщо формується зображення, яке в подальшому буде 

використано у відео, необхідно узгодити розміри (співвідношення сторін) піксе-

лів для того, щоб зображення не деформувалося після рендерингу. 

Розглянемо далі інтерфейс програми починаючи з розташування основних 

панелей робочого вікна (рис. 1.2). 

 

 

Рис. 1.2. Розташування основних панелей робочого вікна. 
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1 – рядок меню; 2 – панель налаштувань параметрів обраного інструмента; 3 – сторінка 

поточного документа (назва, масштаб, кольорова модель/глибина кольору); 4 – панель інстру-

ментів; 5 – поточний документ; 6 – рядок стану; 7 – палітра кольорів; 8 – властивості докуме-

нта; 9 – палітра шарів; 10 – панель швидкого доступу до додаткових налаштувань. 

 

1.2. Практичні завдання 

 

1.2.1. Складання пейзажу з його фрагментів 

1. Створюємо новий документ (Ctrl + N) та обираємо його параметри 

(рис.1.3. 

 

Рис. 1.3. Параметри нового документа 

 

2. Пересуваємо всі 12 фрагментів майбутнього зображення на створену ро-

бочу область (рис. 1.4). 

 

 

Рис. 1.4. Початкові фрагменти зображення 
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3. Інструментом Пересування (V) та наступним трансформуванням (Ctrl + 

T) змінюємо розміри та розташовуємо фрагменти таким чином, щоб були видні 

одразу усі частини зображення (рис. 1.5). Для зміни розміру обираємо необхід-

ний фрагмент і тиснемо (Ctrl + T). Утримуючи клавішу Shift, пересуваємо кутові 

маркери. Для пропорційного масштабування з центру утримуємо поєднання кла-

віш Shift + Alt. 

 

 

Рис. 1.5. Розташування фрагментів зображення в правильній послідовності 

 

За допомогою тих самих операцій домагаємося максимально схожого ре-

зультату (рис. 1.6). 

 

 

Рис. 1.6. Результат роботи 
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4. Зберігаємо документ у форматі «.psd». File→Save As (Ctrl + Shift + S), 

що дає змогу редагувати документ після завершення проєкту (рис. 1.7). 

 

 

Рис. 1.7. Збереження зображення в форматі «.psd» 

 

Щоб уникнути втрати прогресу, треба регулярно зберігати файл (Ctrl + S) 

після n-ї зміни! 

5. Експортуємо отримане зображення в формат «.jpg». 

File→Export→Export As (Alt + Shift + Ctrl + W) (рис. 1.8). 

 

 

Рис. 1.8. Експорт отриманого зображення в формат «.jpg» 
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1.2.2. Заміна фрагментів зображення 

Настав час тюнінгу авто завдяки підвищенню його прохідності внаслідок 

«перевзування». Фотографуємо своє авто або знаходимо зображення машини 

будь-якої марки та дизайну на доступних Internet ресурсах (рис. 1.9). Замінюємо 

в нашому авто гуму, скориставшись арсеналом засобів Photoshop. Недарма цей 

пакет вважають таким багатофункціональним, його можливості редагування зо-

бражень практично необмежені. Зробимо наше авто по-справжньому особливим, 

надавши йому потужності, агресивності та надійності згідно зі своїм задумом 

(рис. 1.10). 

 

 

Рис. 1.9. Вихідне зображення автомобіля 

 

  

Рис. 1.10. Результат роботи 



1. ЗНАЙОМСТВО З ІНТЕРФЕЙСОМ, ІНСТРУМЕНТАМИ ВИДІЛЕННЯ ТА МОЖЛИВОСТЯМИ ТРАНСФОРМУВАННЯ ЗОБРАЖЕНЬ 

 

13 

 

1.  Запускаємо Photoshop та відкриваємо зображення з машиною 

File→Open (Ctrl + O). Після цього розміщуємо зображення трактора в нашому 

документі (рис. 1.11) так само, як у попередньому завданні, коли розташовували 

фрагменти пейзажу, збираючи пазл (рис. 1.4). 

 

 

Рис. 1.11. Відкриття вихідних зображень 

 

2. Растреризуємо шар з трактором для подальших маніпуляцій над ним. 

Тиснемо правою клавішою миші (ПКМ) на шарі з назвою «Layer 1» у палітрі 

шарів та обираємо «Rasterize Layer» (рис. 1.12). 

 

 

Рис. 1.12. Растеризування шару з трактором 

 

3. Збільшуємо трактор (Ctrl + T) до зручних розмірів та будь-яким інстру-

ментом виділення виділяємо заднє колесо (еліптичне виділення (M), магнітне 
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ласо (L), пензель, що виділяє (W) ). В наведеному прикладі використаний остан-

ній інструмент, оскільки він чудово може впоратися з контрастними зображен-

нями (рис. 1.13). 

 

  

Рис. 1.13. Інструменти та процес виділення потрібного фрагмента зображення 

 

4. За необхідністю видалити випадково виділену непотрібну область утри-

муємо клавішу Alt та ліву клавішу миші. Поряд з курсором з’явиться «-». Якщо 

необхідно додати до виділеної області ще частину, то реалізуємо той же алго-

ритм тільки з клавішею Shift. Поряд з курсором з’явиться «+». Також ці режими 

можна перемикати на панелі налаштувань параметрів обраного інструменту 

(рис. 1.14). 

 

 

Рис. 1.14. Видалення непотрібної частини виділення 
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5. Після виділення колеса, вирізаємо його (Ctrl + X) та видаляємо шар з 

трактором, натиснувши на іконку в палітрі шарів або клавішу Delete. Створюємо 

новий пустий шар, натиснувши на іконку в палітрі шарів або поєднання клавіш 

(Ctrl + Shift + N) (рис. 1.15). 

 

 

Рис. 1.15. Видалення шару з трактором та створення нового шару 

 

6. Обираємо «Layer 2» в палітрі шарів та розміщуємо на ньому колесо 

(Ctrl + V) (рис. 1.16). 

 

 

Рис. 1.16. Розташування в одному шарі фрагментів зображення 
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7. Підлаштовуємо розміри за допомогою трансформування (Ctrl + T). Копі-

юємо та вставляємо готове колесо (Ctrl + C), (Ctrl + V) (рис. 1.17). 

 

 

Рис. 1.17. Трансформація та суміщення фрагментів 

 

8. Інструментом «Ластик» (E) стираємо зайві частини колеса. Розмір лас-

тику можна регулювати гарячими клавішами ([), (]) (рис. 1.18). 

 

 

Рис. 1.18. Видалення непотрібних частин зображення 
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9. Для остаточного нюансування застосуємо інструмент затемнення (O), 

щоб затемнити світлі ділянки на колесах. Бажано зробити акцент на верхню час-

тину покришки, де повинна знаходитися тінь від кузова машини (рис. 1.19). Пі-

сля досягнення потрібного результату, зберігаємо документ у «.psd» и «.jpg» фо-

рматах. 

 

Рис. 1.19. Додавання тіні на покришки коліс 

 

1.3. Завдання на самостійну роботу 

 

Підібравши не менш ніж 5 зображень, створити колаж на тему «Пам’ятки 

рідного міста». Результуюче зображення повинно мати розміри Full HD 

(1920 х 1080px) з роздільною здатністю 96ppi, прозорий фон. Зберегти в форма-

тах .psd, .jpg, .png. 

 

Запитання для самоконтролю 

 

1. Яка функція пікселя у моніторі? 

2. За що відповідає функція «Color Mode»? 

3. Навіщо необхідна колірна модель Grayscale? 

4. Який параметр слід налаштувати при створенні документа, якщо резуль-

туюче зображення буде використовуватися у відео? 

5. Яка щільність пікселів на дюйм використовується у вебсередовищі?
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2. ІНСТРУМЕНТИ ВИДІЛЕННЯ, ШАР-МАСКА, ТРАНСФОРМУВАННЯ ФРАГМЕНТІВ 

ЗОБРАЖЕННЯ 

 

2.1. Загальні поняття 

 

2.1.1. Інструменти виділення 

1. Прямокутна та еліптична області − мають однойменну форму виділення 

й викликаються клавішею (М). Інструменти мають такі параметри: 

‒ Розтушовка − пом’якшує край виділеної області так, щоб вона почала пе-

реходити за область за рамкою виділення; 

‒ Згладжування − використовується для згладжування країв виділеної об-

ласті; 

‒ Пропорції − дозволяє виставити розмір виділення, прописавши його з 

клавіатури або використовуючи вбудований шаблон; 

‒ Уточнити край — використовується, щоб ввести зміни у виділений фра-

гмент та зробити його більш точним; 

‒ Створення нового виділення, об’єднання області з іншою виділеною, ви-

далення області з  виділеної та область, що утворена перетином двох інших. 

2. Область (горизонтальний / вертикальний рядок) − виділяють один гори-

зонтальний або вертикальний рядок товщиною в один піксель. Для створення 

такого виділення потрібно просто клацнути ЛКМ (лівою кнопкою миші) в пот-

рібному місці зображення. 

3. Ласо, прямолінійне ласо, магнітне ласо − виділяють довільну область і 

викликаються клавішею (L): 

‒ Ласо − довільне виділення. Повторює параметри прямокутної і еліптич-

ної областей; 

‒ Прямолінійне ласо − виділення у вигляді замкнутої ламаної лінії. Повто-

рює параметри прямокутної і еліптичної областей; 

‒ Магнітне ласо − виділяє область, ґрунтуючись на контрасті сусідніх об-

ластей.
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Ласо має такі налаштування: 

‒ Ширина − задає діапазон розпізнавання меж; 

‒ Контрастність – для високої контрастності зображень значення параме-

тра більше, для низької контрастності менше; 

‒ Частота – збільшує / зменшує кількість опорних точок на одиницю дов-

жини. Чим більший цей параметр, тим точніше виділення. 

4. Чарівна паличка − виділяє область пікселів за схожою кольоровою га-

мою. Викликається клавішею (W), має такі налаштування: 

‒ Допуск − регулює діапазон кольорів, які виділяються. Чим менше зна-

чення параметра, тим менше виділена область і навпаки; 

‒ Суміжні пікселі − якщо цей прапорець не встановлено, пікселі одного ко-

льору будуть виділенні на всій фотографії; 

‒ Зразки всіх шарів − якщо прапорець встановлений, то кольори виділя-

ються відразу на всіх активних шарах. 

5. Швидке виділення − створює виділення на основі схожості кольорів і 

текстур. Виділення не обов’язково  має бути точним: «Швидке виділення» авто-

матично створює кордон виділення, заснований на інтуїтивній схожості. 

6. Швидка маска − режим, який надає можливість виділення з точністю до 

одного пікселя. Викликається клавішею (Q). Виділити область можна будь-яким 

растровим інструментом для рисування, при чому зарисована область буде за за-

мовчуванням червоного напівпрозорого кольору. Для того щоб перевести виді-

лення, необхідно повторно натиснути (Q) [1, 2, 6, 7, 9]. 

 

2.1.2. Трансформування 

1. Масштаб − збільшення або зменшення елемента відносно контрольної 

точки − заданої точки, відносно якої відбувається трансформування. 

2. Rotate (Поворот) − поворот елемента навколо контрольної точки. За за-

мовчуванням ця точка знаходиться в центрі об’єкта. 

3. Нахил − нахил елемента по вертикалі або по горизонталі. 

4. Викривлення − розтягування елемента в усіх напрямках. 
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5. Перспектива − до вибраного елемента застосовується перспектива схо-

дження в одній точці. 

6. Деформація − зміна форми елементна. 

7. Обертання на 180°, обертання на 90° за годинниковою стрілкою, обер-

тання на 90° проти годинникової стрілки. Обертає елемент на вказане число гра-

дусів за годинниковою, або проти годинникової стрілки. 

8.  Відобразити − відображення обраної області в горизонтальній або вер-

тикальній площині [1, 2, 6, 7, 10]. 

 

2.1.3. Смарт-об’єкт 

Смарт-об’єкт − контейнер, який зберігає у собі n-ну кількість змін, що за-

стосовуються до зображення. Дозволяє трансформувати зображення без втрати 

якості, застосовувати розумні фільтри (з можливістю їх скасування), створювати 

зв’язані копії (при редагуванні вихідного зображення, зміни будуть застосовува-

тися до всіх створених копій) [1, 2 ,6, 7, 11]. 

 

2.2. Практичне завдання 

 

Відпрацьовуємо основні інструменти виділення та трансформування на 

прикладі розташування порому на звичайному венеціанському каналі. Створимо 

незвичайний пейзаж та прикрасимо ним кімнату, надавши зображенню власти-

вості художнього твору, що виконаний пензлем на полотні. 

1. Запускаємо Photoshop та відкриваємо фонове зображення «Венеція» 

(Ctrl + O). Перетягуємо на отриманий фон зображення «Пором.jpg». Растеризу-

ємо шар «Пором» (рис. 2.1). 

2. Відображаємо зображення «Пором» по горизонталі Edit → Transform → 

Flip Horizontal або (Ctrl + T) → ПКМ (права клавіша миші) → Flip Horizontal. 

ПКМ (рис. 2.2). 
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Рис. 2.1. Вихідні зображення 

 

 
Рис. 2.2. Відображення порома по горизонталі 

 

3. Наближуємо зображення з поромом (Alt + колесо миші) або (Ctrl +/-), 

або інструментом Zoom  (Z). Обираємо інструмент «Magnetic Lasso Tool» 
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(Магнітне ласо)  (L). Умовною лінією розмежовуємо частини води з відобра-

женням заходу та без нього. Ставимо опорну точку за межею зображення та, при-

тримуючись умовної лінії розподілу, ведемо курсор до порома (рис. 2.3). 

 

 
Рис. 2.3. Початок процесу виділення 

 

4. Переміщуючи зображення за допомогою курсора та зажатого пробілу, 

виділяємо весь пором, включаючи розводи від кільватера зліва (рис. 2.4). Нама-

гаємося зробити виділення якомога точніше, користуючись можливостями збі-

льшення необхідних частин зображення. 

 

 
Рис. 2.4. Замикання виділення 
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5. Інвертуємо виділення Select→Inverse (Ctrl + Shift + I) і включаємо режим 

швидкої маски, натиснувши  (Q) (рис. 2.5). 

 

 
Рис. 2.5. Робота в режимі швидкої маски 

 

6. Обираємо інструмент «Brush Tool»  (B), виставляємо такі налашту-

вання (рис.2.6). 

 

 
Рис. 2.6. Налаштування пензля 



2. ІНСТРУМЕНТИ ВИДІЛЕННЯ, ШАР-МАСКА,ТРАНСФОРМУВАННЯ ФРАГМЕНТІВ ЗОБРАЖЕННЯ 

 

24 

 

7. Наближуємо пором і, переходячи з білого на чорний колір  (X), за-

фарбовуємо пропущені дрібні частини порома (рис. 2.7). Щоб зафарбувати зали-

шаємо чорний колір, щоб стерти – білий. Розмір пензля регулюємо за допомогою 

клавіш ([),(]). 

 

 
Рис. 2.7. Коригування контурів порома 

 

8. Щоб повернути виділення, натискаємо  (Q). Інвертуємо виділення 

(Ctrl + Sfift + I) і на панелі палітри кольорів натискаємо на піктограму Add layer 

mask . Поруч з виділеним шаром з’явиться маска (рис. 2.8). Цей крок забез-

печить можливість у будь-який момент відновити частину зображення, якої не 

вистачає, обравши інструмент пензель білого кольору та зафарбувавши необ-

хідну область шару-маски. 

 

 
Рис. 2.8. Створення маски 
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9. Інструментом «Переміщення» (V) шар з поромом пересуваємо в правий 

нижній кут (рис. 2.9). Переводимо цей шар у смарт-об’єкт. Переходимо у режим 

вільного редагування (Ctrl + T). 

 

 
Рис. 2.9. Застосування переміщення 

 

10.  Змінюємо перспективу. Для цього натискаємо ПКМ по зображенню 

порома та обираємо «Perspective». Перетягуємо лівий верхній маркер вгору доти, 

поки зміна не досягне шести з половиною градусів (рис. 2.10). 

 

 

Рис. 2.10. Застосовування перспективи 



2. ІНСТРУМЕНТИ ВИДІЛЕННЯ, ШАР-МАСКА,ТРАНСФОРМУВАННЯ ФРАГМЕНТІВ ЗОБРАЖЕННЯ 

 

26 

 

11. Клікаємо ПКМ по порому та обираємо «Wrap» (деформація). Утриму-

ємо частину зображення курсором і пересуваємо в потрібний бік для досягнення 

ефекту, при якому пором упливає в далину (рис. 2.11). Натискаємо Enter. 

 

 
Рис. 2.11. Застосування деформації 

 

12.  Растеризуємо шар з поромом (ПКМ по шару → Rasterize Layer). Дода-

ємо коригувальний шар Hue/Saturation (Колір/Насиченість) і прив’язуємо його 

до шару «Пором», затиснувши Alt і клацнувши між шарами. Таким чином ми 

створили відсічну маску (рис. 2.12). 

 

 
Рис. 2.12. Створення відсічної маски 
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13.  У панелі властивостей коригуючого шару у випадаючому списку оби-

раємо «Yellows» і виставляємо повзунки на вказані відмітки (рис. 2.13). Приби-

раємо залишки заходу, знижуючи насиченість і яскравість жовтого кольору на 

поромі. 

 
Рис. 2.13. Налаштування коригуючого шару 

 

14. Переходимо на шар-маску «Пором». Налаштовуємо пензель (В). Виста-

вляємо розмір пензля 100рх, непрозорість 80 %. Проходимо пензлем по краях 

кільватера для досягнення необхідного ефекту (рис. 2.14). 

 

 
Рис. 2.14. Коригування непрозорості кільватера 
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15. Не змінюючи розміру пензля, знижуємо значення «Opacity» (Непрозо-

рості) до 20 % для того, щоб пройти контури кільватера. Потім зменшуємо не-

прозорість на 10 % і встановлюємо «Flow» (Натиск) 10 % для тіні, що відкида-

ється поромом (рис. 2.15). 

 

 
Рис. 2.15. Коригування контурів кільватеру 

 

16. Переводимо паром у смарт-об’єкт. Повторно застосовуємо вільне тра-

нсформування (Ctrl + T). Робимо так, щоб паром був за розмірами наближений 

до реальних відносно будинків. За допомогою затиснутої клавіші Ctrl і курсора 

перетягуємо кутові маркери для досягнення потрібного результату ( рис. 2.16). 

 

 
Рис. 2.16. Трансформування зображення порому 
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17. Растризуємо шар. Для того щоб паром краще вписувався в композицію, 

додаємо коригувальний шар «Photo Filter», утворюємо відсічну маску і обираємо 

такі налаштування (рис. 2.17). 

 

 
Рис. 2.17. Додавання коригуючого шару «Photo Filter» 

 

18. Об’єднуємо всі шари в один і розміщуємо утворений шар над іншими 

(Ctrl + Alt + Shift + E) (рис. 2.18). 

 

 
Рис. 2.18. Зведення шарів 
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19. Відкриваємо зображення кімнати (Ctrl+O) → «Комната.jpg» та копію-

ємо/перетягуємо шар «Layer 1» на шар з кімнатою (рис. 2.19). 

 

 
Рис. 2.19. Додавання відредагованого об’єкта до зображення кімнати 

 

20. Щоб надати зображенню вид картини, накладаємо фільтр Filter → Filter 

Gallery та вибираємо Texture → Texturizer (рис. 2.20). 

 

 
Рис. 2.20. Застосування фільтра 
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21. Отриманий результат зменшуємо таким чином, щоб картина повністю 

перекривала ту, що в кімнаті. Перетягуємо зображення «Рамка.jpg». Не растери-

зуючи зображення з рамкою, поміщаємо її на картину та узгоджуємо розміри за 

допомогою маркерів (рис. 2.21). Зберігаємо обидва документи в форматі «.psd» і 

експортуємо (Ctrl + Shift + Alt + W) отримане зображення з кімнатою в формат 

«.jpg». 

 

 
Рис. 2.21. Результат роботи 

 

2.3. Завдання на самостійну роботу 

 

Створити цілісну композицію, застосувавши не менш ніж три зображення, 

а саме: фон, особисте фото та фото улюбленого персонажу (актор, спортсмен, 

музикант, суспільний діяч, тощо).  

Вимоги до макета: 

‒ вихідні зображення кольорові, кольорова модель CMYK; 

‒ розмір результуючого зображення: ФА4 (210 х 297); 

‒ роздільна здатність 300ррі; 

‒ результат зберегти в форматах .psd, .jpeg. 
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Запитання для самоконтролю 

 

1. Що необхідно зробити з зображенням перед застосуванням деформації, 

щоб те не втратило якість? 

2. За допомогою якого параметра можна розтягувати зображення за всіма 

напрямками? 

3. Який інструмент виділяє область пікселів однієї колірної гами? 

4. Що регулює параметр допуск? 

5. Як виділити пікселі одного кольору на всьому зображенні? 
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3. РЕТУШ ТА КОЛОРИЗАЦІЯ РАСТРОВИХ ЗОБРАЖЕНЬ 

 

3.1. Загальні поняття 

 

1. Spot Healing Brush tool (Точковий відновлювальний пензель)   ̶  ін-

струмент, що використовує змішування кольору, світла, тіні, текстури та прозо-

рості довколишніх областей для перекриття пошкоджених ділянок. Не потребує 

виділення області, що клонується. Типи пензля такі: 

‒ Mode (Режим) ‒ визначає режим накладення. Щоб зберегти шум, зерни-

стість фотоплівки та текстуру по краях мазка при використанні пензля з м’яким 

кінчиком, треба обирати режим «Замінити». Proximity Match (Відповідність на-

ближення) ‒ використовує пікселі по краю виділеного фрагмента, щоб знайти 

область, яка повинна бути використана як накладка; 

‒ Create Texture (Створення текстури) ‒ використовує пікселі виділеної об-

ласті для створення текстури. Якщо текстура не підійшла, доцільно повторно пе-

ретягнути її крізь область, що виправляється; 

‒ Content-Aware (З урахуванням вмісту) ‒ оцінює найближчий вміст, щоб 

заповнити виділену область без помітних меж, зберігши такі ключові деталі як 

тіні та межі об’єктів; 

2. Healing Brush tool (Відновлювальний пензель)  ‒ інструмент, що ви-

правляє дефекти на основі порівняння сусідніх областей. Співвідносить текс-

туру, освітленість, прозорість та затемнення ділянок, що клонується та заміню-

ється. Налаштування пензля такі: 

‒ Mode (Режим) ‒ визначає режим накладення. Щоб зберегти шум, зерни-

стість фотоплівки та текстуру по краях мазка при використанні пензля з м’яким 

кінчиком, треба обрати режим «Замінити»; 
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‒ Source (Джерело) ‒ визначає джерело пікселів для відновлення. «Зразок» 

– для використання пікселів з активного зображення та «Візерунок» – для вико-

ристання пікселів з візерунку. При використанні параметру «Візерунок» необхі-

дно обрати його на висхідній панелі «Візерунок»; 

‒ Align (Вирівнювання) ‒ для безперервного семплування пікселів без 

втрати поточної точки семплування навіть при відпусканні кнопки миші. Для по-

довження використання семплованих пікселів вихідної точки кожного разу після 

завершення та повторного початку рисування необхідно зняти прапорець «Вирі-

внювання»; 

‒ Samle (Зразок) ‒ обирає дані з указаних шарів. Для обрання даних з акти-

вного шару та всіх видимих шарів, що розташовані під ним, необхідно обрати 

параметр «Поточний та наступні». Для вибірки тільки з поточного шару ‒ пара-

метр «Активний шар», для вибірки з усіх видимих шарів ‒ параметр «Всі шари», 

для вибірки із усіх видимих шарів за виключенням коригуючих ‒ «Всі шари» та 

ввімкнений значок «Ігнорувати корегуючи шари» справа від висхідного меню 

«Зразок»; 

‒ Diffusion (Дифузія) ‒ керує тим, як вставлені області адаптуються до ото-

чуючого їх зображення. Для зображення з високою зернистістю або дрібними 

деталями необхідно обрати низьке значення дифузії, для зображень високої яко-

сті ‒ більш високе. 

3. Patch tool (Латка)  ‒ інструмент відновлює виділену область за допо-

могою цільного фрагмента іншої області пікселів або візерунка. Режими роботи 

інструмента такі: 

‒ Normal (Нормальний) ‒ визначення інструменту (див. Patch tool (Латка)); 

‒ Content-Aware (З урахуванням вмісту) ‒ дозволяє синтезувати прилеглий 

вміст для безшовного злиття з навколишнім вмістом; 

‒ Source (Джерело) ‒ режим, в якому виділена область замінюється шля-

хом зміщення виділення на потрібний зразок; 
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‒ Destination (Місце призначення) ‒ режим, в якому виділена область є зра-

зком для заміни проблемної ділянки; 

‒ Transparent (Прозорість) ‒ слугує для вилучення текстури з прозорим фо-

ном. У разі необхідності повної заміни цільової області зразком потрібно зняти 

цей прапорець. 

4. Content-Aware Move tool (Пересування з урахуванням вмісту)  ‒ при-

значений для виділення та пересування частини зображення. Зображення компо-

нується заново, а пуста ділянка, що залишилася після пересування, заливається з 

використанням елементів зображення, що підходять. Режими роботи такі: 

‒ Move (Перемістити) ‒ дозволяє змінити розташування об’єктів (найкращі 

результати досягаються, якщо фон залишається схожим); 

‒ Extend (Розширити) ‒ дозволяє розтягнути або стиснути об’єкти типу во-

лосся, дерева або будівлі; 

‒ Structure (Структура) ‒ потребує введення значення між 1 і 7, щоб вказати 

як точно латка буде відповідати вихідному зображенню. При значенні 7 латка 

дуже точно відповідає візерунку, що копіюється, при значенні 1 ‒ приблизно; 

‒ Color (Колір) ‒ потребує введення значення між 1 і 10 для зазначення 

ступеня застосування алгоритмічного накладення кольорів до латки. При зна-

ченні 0 накладення кольорів буде відключено. Значення Колір, що дорівнює 10, 

позначає граничне накладення кольорів; 

‒ Sample All Layers (Зразок всіх шарів ‒ при включення цього налашту-

вання можна використати інформацію всіх шарів для створення результату пе-

реміщення в обраному шарі. Необхідно обрати цільовий шар у панелі «Шари»; 

‒ Transform On Drop (Перетворення при перетягуванні) ‒ якщо цей пара-

метр ввімкнений, можна масштабувати частину зображення, яка тільки що пере-

міщена в нове місце розташування. 

5. Red Eye (Червоні очі)  ‒ видаляє ефект червоних очей із зображень 

людей та тварин, що були зроблені із блискавкою. Має такі налаштування: 
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‒ Pupil Size (Розмір зіниці) ‒ збільшення або зменшення області, яка буде 

оброблятися інструментом «Червоні очі»; 

‒ Darken Amount (Величина затемнення) ‒ налаштування ступеня затем-

нення. 

6. Clone Stamp tool (Штамп)  ‒ призначений для нанесення однієї час-

тини зображення поверх іншої його частини або будь-якого іншого відкритого 

документа, що має той самий кольоровий режим. Крім того, можна переносити 

частину зображення з одного шару в інший. Налаштування інструменту такі: 

‒ Align (Вирівнювання) ‒ для безперервного семплювання пікселів без 

втрати поточної точки семплювання навіть при відпусканні кнопки миші; 

‒ Samle (Зразок) ‒ обирає дані з указаних шарів. Для обрання даних з акти-

вного шару та всіх видимих шарів, що розташовані під ним, треба обрати пара-

метр «Поточний та наступні». Для вибірки тільки з поточного шару ‒ параметр 

«Активний шар», для вибірки з усіх видимих шарів ‒ «Усі шари», для вибірки із 

усіх видимих шарів за виключенням коригуючих ‒ «Усі шари» та ввімкнений 

значок «Ігнорувати корегуючи шари» справа від висхідного меню «Зразок»; 

‒ Opacity (Непрозорість) ‒ зберігає виставлену непрозорість (навіть при 

рисуванні на одній і тій самій ділянці) доти, поки не буде відпущена ЛКМ і не 

почнеться нанесення другого шару (комп’ютерний підхід); 

‒ Flow (Натиск) ‒ працює за принципом: чим довше водити по одній діля-

нці, тим темніше (більш насиченою) вона стає (як при рисуванні маркером) [1, 2, 

6, 7, 12]. 

 

3.2. Практичні завдання 

 

3.2.1. Робота з інструментами «Spot Healing Brush Tool» (Точковий від-

новлювальний пензель) та «Healing Brush Tool» (Відновлювальний пензель) 

Для виклику інструментів «Spot Healing Brush Tool» та «Healing Brush 

Tool» можна застосувати піктограми (рис. 3.1). 
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За допомогою цих інструментів приберемо дефекти шкіри з обличчя дів-

чини(рис. 3.2, 3.3). 

 

Рис.3.1. Розташування інструментів «Spot Healing Brush Tool» та «Healing Brush Tool» 

 

  

Рис. 3.2. Вихідне зображення Рис. 3.3. Результуюче зображення 

 

1. Відкриваємо фото з обличчям дівчини. Підключаємо вікно з історією 

Windows→History (рис. 3.4). 

 

 

Риc. 3.4. Відкриття палітри «History» 
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2. Створюємо копію шару Leyer→Dublicate Leyer… (Ctrl + J) та обираємо 

інструмент «Spot Healing Brush Tool»  (Точковий відновлювальний пензель) 

(J). 

3. Виставляємо такі параметри пензля (рис. 3.5). Для досягнення найкра-

щого результату розмір бажано обирати індивідуально під кожний дефект трі-

шки більшим, ніж дефект, що ретушується. (Вікно налаштування пензля можна 

викликати кліканням ПКМ по зображенню). 

 

 

Рис. 3.5. Налаштування параметрів пензля 

 

4. Регулюючи розмір пензля за допомогою гарячих клавіш ([),(]), наводимо 

курсор на дефект та тиснемо ЛКМ (Ліва клавіша миші). Мета ‒ позбавитися від 

дефектів, що в першу чергу впадають в очі, тон шкіри буде вирівняний пізніше. 

Намагаймося досягнути такого результату (рис. 3.6). 

 

 

Рис. 3.6. Видалення найбільш помітних дефектів шкіри 
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5. Щоб трішки прибрати червоний колір та зайвий блиск, скористаємося 

інструментом «Healing Brush Tool»  (Відновлювальний пензель) (J) з відпо-

відними налаштуваннями (рис. 3.7). На відміну від попереднього інструменту 

цей призначений для більших за площиною пошкоджених ділянок. 

 

 

Рис. 3.7. Налаштування інструменту «Healing Brush Tool» 

 

6. Утримуючи Alt, натискаємо ЛКМ по здоровій частини шкірі тим, самим 

клонуючи її. Переходимо до пошкодженої ділянки та пересуваємо курсор, утри-

муючи ЛКМ (рис. 3.8). 

 

 

Рис. 3.8. Алгоритм роботи «Healing Brush Tool» 
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7. Щоб уникнути утворення так званого «бруду» (розмиті межі на контра-

стних ділянках) кожного разу слід змінювати донорську область та розмір пен-

зля. Також можна знов скористатися «Spot Healing Brush Tool» щоб згладити дрі-

бні дефекти. Намагаймося досягнути такого результату (рис. 3.9). 

 

 

Рис. 3.9. Результат роботи 

 

3.2.2 Робота з інструментом «Patch Tool» (Латка) 

Для виклику інструменту «Patch Tool» (Латка) Застосовуємо піктограму 

(рис. 3.10). Приберемо мильні бульбашки з зображення за допомогою «Patch 

Tool» (рис. 3.11, 3.12). 

 

 

Рис.3.10. Розташування інструменту «Patch Tool» (Латка) на панелі 
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Рис. 3.11. Вихідне зображення 

 

 

Рис. 3.12. Результат роботи 

 

1. Відкриваємо зображення «Мильна кулька.jpg». Створюємо дублікат 

шару (Ctrl + J) та обираємо інструмент «Elliptical Marquee Tool»  (M). Виді-

ляємо найбільшу кульку на фото (рис. 3.13). 
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Рис. 3.13. Виділення найбільшої кульки 

 

2. Обираємо інструмент «Patch Tool»  (Латка) (J) і налаштовуємо його 

таким чином (рис. 3.14). 

 

 

Рис. 3.14. Налаштування інструменту «Patch Tool» 

 

3. Далі перетягуємо виділену область на ту ділянку фото, якою хочемо за-

мінити мильну кульку (рис. 3.15). 



3. РЕТУШ ТА КОТОРИЗАЦІЯ РАСТРОВИХ ЗОБРАЖЕНЬ 

 

43 

 

 

Рис. 3.15. Заміна мильної кульки іншою ділянкою зображення 

 

4. Знімаємо виділення Select→Deselect (Ctrl+D). Замість мильної кульки 

залишився ледь помітний контур. Самостійно позбавляємося його за допомогою 

інструменту «Healing Brash Tool»  (J). Задля згладжування контуру необхі-

дно регулювати розмір та жорсткість пензля (рис. 3.16). 

 

 

Рис. 3.16. Видалення контуру кульки 
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5. Позбавляємося інших кульок, повторюючи той самий алгоритм дій: елі-

птичне виділення → латка → відновлювальний пензель (якщо потрібно) (рис. 

3.17, 3.18). 

 

 

Рис. 3.17. Видалення середньої кульки 

 

 

Рис. 3.18. Видалення найменшої кульки 

6. За допомогою «Spot Healing Brush Tool»  (Точковий відновлюваль-

ний пензель) (J) прибираємо мильні бризки (рис. 3.19) та отримуємо кінцевий 

результат (рис. 3.12). 

 

 

Рис. 3.19. Видалення бризок 
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3.2.3. Робота з інструментом «Content-Aware Move tool» (Пересування 

з урахуванням вмісту) 

Для виклику інструменту «Content-Aware Move Tool»  (Заміна з ураху-

ванням вмісту) застосовуємо таку піктограму (рис. 3.20). Пересунемо повітряну 

кулю в правий верхній кут зображення (рис. 3.21, 3.22). 

 

 

Рис.3.20. Розташування інструменту «Content-Aware Move Tool» на панелі 

 

 

Рис. 3.21. Вихідне зображення 

 

 

Рис. 3.22. Результат роботи 



3. РЕТУШ ТА КОТОРИЗАЦІЯ РАСТРОВИХ ЗОБРАЖЕНЬ 

 

46 

 

1. Відкриваємо зображення «Повітряна кулька jpg» та створюємо дублікат 

шару (Ctrl + J). Активуємо інструмент «Content-Aware Move tool»  (Пересу-

вання з урахуванням вмісту) (J) та виставляємо такі налаштування (рис.3.23). 

 

 

Рис. 3.23. Налаштування інструменту «Content-Aware Move tool» 

 

2. Виділяємо повітряну кулю з деяким запасом пікселів уздовж периметра 

(Photoshop «з’їсть» ці пікселі при адаптуванні кольору та текстури під нове по-

ложення об’єкта). Переміщуємо виділену область (рис. 3.24). 

 

 

Рис. 3.24. Переміщення об’єкта 
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3. Застосовуючи рамку вільного трансформування, що з’явилася, зменшу-

ємо кулю та тиснемо Enter. Знімаємо виділення Ctrl+D. Прибираємо контури, що 

залишилися, інструментом «Clone Stamp tool»  (Штамп) (S). Тиснемо Alt та 

обираємо ділянку неба, що клонується. Налаштовуємо жорсткість, розмір та не-

прозорість, зарисовуємо контрастні контури (рис. 3.25) і отримуємо кінцевий ре-

зультат (рис. 3.22). 

 

 

Рис. 3.25. Позбавлення контрастних контурів 

 

3.2.4.Робота з інструментом «Red Eye tool» (Червоні очі) 

Для виклику інструменту «Red Eye tool»  (Червоні очі) застосовуємо 

таку піктограму (рис. 3.26). Приберемо ефект червоних очей з зображення дів-

чини (рис. 3.27, 3.28). 

 

 

Рис.3.26. Розташування інструменту «Red Eye tool» на панелі 
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Рис. 3.27. Вихідне зображення 

 

 

Рис. 3.28. Результат роботи 

 

1. Відкриваємо фото дівчини та активуємо інструмент «Red Eye tool»  

(Червоні очі) (J). Значення «Pupil Size» (Розмір зіниці) та «Darken Amount» (Ве-

личина затемнення) виставляємо по 50 %. 
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2. Клікаємо по кожній зіниці по одному разу та якщо результат влаштовує, 

зберігаємо документ. 

3.2.5. Колоризація чорно-білого фото 

Розфарбуємо чорно-біле зображення дівчини (рис. 3.29, 3.30). 

 

 

Рис. 3.29. Вихідне зображення 

 

 

Рис. 3.30. Результат роботи 
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1. Відкриваємо зображення «Колоризація.jpg». Створюємо коригувальний 

шар Solid Color Layer→New Fill Layer→Solid Color або тиснемо на піктограму

 на панелі палітри шарів та обираємо «Solid Color». Заливаємо його відпо-

відно до таблиці (рис. 3.31). Нас цікавлять світла, тому прописуємо значення 85, 

14, 19 для кольорової моделі Lab (рис. 3.32) та тиснемо Enter. 

 

 

Рис. 3.31 Таблиця кольорів для тонування шкіри 

 

 

Рис. 3.32. Визначення кольору світлих ділянок шкіри 

 

2. Для подальшої роботи додаємо до коригувального шару маску. Білий ко-

лір проявляє зміни, а чорний ‒ закриває. Це основний принцип роботи маски. У 

даному випадку робимо чорну маску для того, щоб проявляти колір тільки на 

потрібних ділянках. Клікаємо ПКМ по білій масці та обираємо «Delete Layer 
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Mask». Вмикаємо маску чорного кольору (вона повинна зробити шар із заливкою 

невидимим). Утримуючи Alt, клікаємо на піктограмі в палітрі шарів . Щоб 

колір лягав не в площині, а повторював рельєф шкіри, обираємо режим накла-

дення «Color». Так повинна виглядати палітра шарів після всіх дій (рис. 3.33). 

 

 

Рис. 3.33. Додавання чорної маски до коригувального шару 

 

3. Обираємо м’який пензель (B) із жорсткістю 50%, виставляємо білий ко-

лір та, знаходячись на масці, починаємо зафарбовувати (проявляти) ті ділянки, 

на які потрапляє більш всього світла. Непрозорість 100 % виставляємо тільки на 

однотонних ділянках. Там, де буде перехід до півтонів, значення прозорості 

треба зменшувати (рис.3.34). 

 

 

Рис. 3.34. Фарбування світлих ділянок шкіри 
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4. За аналогією створюємо ще один коригувальний шар «Solid Color» та 

працюємо з півтонами. Задаємо значення 65, 31, 44 в кольоровій моделі Lab. Ре-

гулюємо «Opacity» (Непрозорість) та «Flow» (Натиск) для досягнення плавних 

переходів (рис. 3.35). Кожному шару даємо назву відповідно до зафарбованих 

ділянок. Для цього необхідно двічі клікнути на назві шару та змінити її. 

 

 

Рис. 3.35. Фарбування півтонів 

 

5. Повторюємо алгоритм, працюючи тепер з темними ділянками 38, 30, 40 

в кольоровій моделі Lab (рис. 3.36). 

 

 

Рис. 3.36. Фарбування тіней 
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6. Щоб не витрачати часу на створення кожного наступного коригуючого 

шару, рекомендується створити один та продублювати його 7 разів (Ctrl + J). Далі 

можна підібрати кольори індивідуально (рис. 3.37). 

 

 

Рисунок 3.37. Один з варіантів підбору кольорів 

 

7. Далі, використовуючи інструмент «Clone Stamp tool»  (Штамп) (S), 

приберемо зайві пасма волосся з одягу та фону. Затиснувши Alt, клікаємо на до-

норській ділянці як при роботі з відновлювальним пензлем. Налаштувавши не-

прозорість, жорсткість та розмір пензля, створюємо дублікат вихідного (чорно-

білого) шару. Намагаємося отримати наступний результат як на рис. 3.30. 

 

3.3. Завдання на самостійну роботу 

 

1. Обрати з родинного фотоальбому чорно-біле фото 

2. Оцифрувати обране фото 

3. Виконати ретуш та колоризацію 

4. Зберегти в форматах .psd, .tiff. 

Вимоги до макета: кольорова модель CMYK, роздільна здатність 300dpi, 

найменший розмір зображення 10 х 15см. 
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Запитання для самоконтролю 

 

1. У чому різниця між штампом та відновлювальним пензлем? 

2. Які режими роботи має інструмент Patch tool (Латка)? 

3. Які параметри необхідно налаштувати для об’єкта, що переміщують? 

4. Що таке зразок? 

5. Що необхідно зробити, щоб кожен раз при відпусканні миші використо-

вувати зразок для перекриття з одного і того ж місця? 
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4. ВЕКТОРНІ ІНСТРУМЕНТИ, КОНТУРИ, ВІДСІЧНІ МАСКИ, ПЕНЗЛІ 

 

4.1. Загальні поняття 

 

4.1.1. Векторні інструменти 

‒ Pen Tool (Перо)  – дозволяє точно рисувати прямі відрізки і криві. 

‒ Freeform Pen Tool (Вільне перо)  – дозволяє рисувати контури так, як 

виконується рисунок олівцем по аркуші. 

‒ Curvature Pen Tool (Перо кривизни)  – дозволяє інтуїтивно рисувати 

криві і прямі відрізки. 

‒ Add Anchor Point Tool (Додати опорну точку)  . 

‒ Delete Anchor Point Tool (Видалити опорну точку)  . 

‒ Convert Point Tool (Кут)  – відповідає за перетворення між гладкими 

вузловими точками і точками заломлення. 

‒ Path Selection Tool (Виділення контуру)  – використовують для виді-

лення всього контуру. 

‒ Direct Selection Tool (Стрілка)  – використовують для виділення сег-

мента контуру. 

‒ Custom Shape Tool (Довільна фігура)  – надає набір заготовок фігур з 

можливістю поповнення цього списку своїми фігурами [1, 2, 6, 7, 13]. 

 

4.1.2. Режими рисування 

‒ Шар-фігура. Створення фігури в окремому шарі. Для створення шару-

фігури можна використовувати або групу інструментів «Фігура», або групу ін-

струментів «Перо». Шари-фігури легко переміщати, масштабувати, вирівнювати 

і розподіляти, завдяки чому вони дуже зручні при створенні зображень для веб-

сторінок.
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В одному шарі можна нарисувати декілька фігур. Шар-фігура складається 

з шару заливки, що визначає колір фігури, і пов’язаної з ним векторної маски, 

яка задає межі фігури. Межами фігури є контур, який з’являється на панелі «Ко-

нтури». 

‒ Контури. Цей режим дозволяє рисувати в поточному шарі робочий кон-

тур, який можна використовувати для вибору фрагмента зображення, створення 

векторної маски, а також заливки або обведення довільним кольором з метою 

створення растрового зображення (приблизно так само, як це можна було зро-

бити за допомогою інструменту розмальовки). Робочий контур вважається тим-

часовим, поки не буде збережений. Контури відображаються на панелі «Кон-

тури». 

‒ Заливка пікселів. Режим розмальовки безпосередньо в шарі аналогічний 

роботі за допомогою інструментів фарбування. При роботі в цьому режимі ство-

рюються не векторні, а растрові зображення. Створені фігури можна обробляти 

так само, як і будь-яке растрове зображення. У цьому режимі працюють тільки 

інструменти групи «Фігура» [1, 2, 6, 7, 14]. 

 

4.2. Практичне завдання 

 

За допомогою арсеналу векторних та растрових інструментів створюємо 

двосторонню візитку для бренду чоловічого одягу BLAZER (рис. 4.1). 

Перед початком роботи слід зазначити таке. 

1. Для друкованих документів мінімальний розмір шрифту становить 7pt. 

2. Колірна модель визначається в поліграфії залежно від застосованої апа-

ратури. Однак зазвичай використовують CMYK. 

3. Напрямними відділяється безпечна зона для розміщення ключових еле-

ментів (Логотип, слоган, контактна інформація). 
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Рис. 4.1. Результат роботи 

 

1. Створюємо документ з такими параметрами. Висоту і ширину виставля-

ємо на 4 мм більше ніж стандарт. Цей відступ залишаємо під обріз. Кольоровий 

профіль необхідно дізнаватися в поліграфії, через це ми відключаємо управління 

кольором (рис. 4.2). Стандартні розміри візитних карток в країнах СНД 

90 х 50мм, міжнародний 85,6 х 53,98 мм. 

 

 
Рис. 4.2. Створення нового документу 

 

2. Вмикаємо лінійки View → Rulers (Ctrl + R). Виставляємо одиниці ви-

міру – мм. Edit → Preferences → Units & Rulers (рис. 4.3). 
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Рис. 4.3. Налаштування одиниць виміру 

 

3. Вказавши курсором на вертикальну лінійку, «витягуємо» напрямну, 

утримуючи ЛКМ. Встановлюємо першу напрямну на відстані 2мм від початку 

документа, другу на відстані 2мм від першої. Встановлюємо напрямні для кожної 

сторони документа (рис.4.4). 

 

 
Рис. 4.4. Встановлення напрямних 
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4. Беремо інструмент «Pen Tool»  (Перо) (P) і виставляємо для нього 

такі налаштування (рис. 4.5). Важливо працювати в режимі «Shape» (Фігура), 

щоб створювати саме векторну складову на окремому шарі. 

 

 
Рис. 4.5. Налаштування пера 

 

5. Ставимо опорну точку, натиснувши ЛКМ. Щоб створити криву (частина 

рукава), ставимо другу опорну точку і, утримуючи ЛКМ, тягнемо курсор вгору. 

Продовжуємо виставляти опорні точки, щоб вийшло щось схоже на ліву частину 

піджака. Щоб під час рисування пером міняти криву на пряму, необхідно, утри-

муючи затиснуту клавішу Alt, переміщати маніпулятори, що виходять з опорної 

точки (рис. 4.6). 

 

 
Рис. 4.6. Опановування принципу роботи пера 
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6. Дублюємо шар з лівою частиною піджака (Ctrl + J) і в режимі вільної 

трансформації (Ctrl + T), відображаємо нашу фігуру за горизонталлю. Розмір 

правій частині піджака бажано трохи збільшити, щоб піджак був розгорнутий у 

лівий бік. Називаємо шари відповідно до елементів на них. Інструментом 

«Convert Point Tool»  (Кут) закругляємо або робимо переломними опорні то-

чки (рис. 4.7). 

 

 
Рис. 4.7. Створення правої частини піджака 

 

7. Вибираємо два шари з частинами піджака, затиснувши Ctrl. Об’єднуємо 

шари ПКМ → Marge Shapes, називаємо отриманий шар «Піджак», потім вибира-

ємо «Combine Shapes» на панелі налаштування інструменту (рис. 4.8). 

 

 
Рис. 4.8. Зведення шарів 



4. ВЕКТОРНІ ІНСТУМЕНТИ, КОНТУРИ, ВІДСІЧНІ МАСКИ, ПЕНЗЛІ 

 

61 

 

8. Застосовуємо заливку до утвореної фігури (#1a2350), відключаємо обве-

дення (рис. 4.9). 

 

 
Рис. 4.9. Застосування заливки 

 

9. Створюємо новий порожній шар (Ctrl + Shift + N), називаємо «Тіні» і 

створюємо відсічну маску, затиснувши Alt і клацнувши між шарами (рис. 4.10). 

 

 
Рис. 4.10. Створення відсічної маски 

 

10. Використовуючи м’який пензель, прорисовуємо тіні (#181b48) по пе-

риметру піджака (рис. 4.11). 
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Рис. 4.11. Створення тіней 

 

11. Створюємо порожній шар (Ctrl + Shift + N), називаємо «Світла» 

(#252a6e), створюємо ще одну відсічну маску шару «Піджак» (рис. 4.12). 

 

 

Рис. 4.12. Створення світлих ділянок 

 

12. Створюємо порожній шар (Ctrl + Shift + N) називаємо «Текстура», знов 

створюємо відсічну маску шару «Піджак». Вибираємо пензель «kyle rain scatter», 

виставляємо розмір 175px, 100 % непрозорість, 100 % натиск і 100 % жорсткість. 
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Хаотично натискаємо ЛКМ по всій площі піджака поки не досягнемо задовіль-

ного ефекту (рис. 4.13). 

 

 
Рис. 4.13. Створення текстури 

 

13. Рисуємо сорочку. Інструментом «Pen Tool»  (P) так само, як рису-

вали ліву частину піджака. Щоб нарисувати комір можна використовувати ін-

струмент «Rectengle Tool»  (U) і, пересуваючи опорні точки інструментом 

«Direct Selection Tool»  (А), зробити трапецію (рис. 4.14). 

 

 
Рис. 4.14. Створення лівої частини коміру 
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14. Дублюємо шар з лівою частиною коміра (Ctrl + J), відображаємо гори-

зонтально і розміщуємо симетрично лівій частині. Виконуємо об’єднання як у 

кроці 7, називаємо отриманий шар «Комір» (рис. 4.15). 

 

 
Рис. 4.15. Створення другої частини коміру 

 

15. Створюємо новий порожній шар над шаром «Сорочка» (Ctrl + Shift + 

N), називаємо «Тіні» і створюємо відсічну маску, як у кроці 9. Повторюємо цю 

операцію як для коміра, так і для сорочки (рис. 4.16). 

 

 
Рис. 4.16. Створення тіней коміру 

 

16. Групуємо шари з фігурами і відповідними їм світлами і тінями. Виділя-

ємо із затиснутою клавішею Ctrl потрібні шари і натискаємо Ctrl + G. Вибираємо 

інструмент «Pen Tool»  (Р) і рисуємо лацкани. 



4. ВЕКТОРНІ ІНСТУМЕНТИ, КОНТУРИ, ВІДСІЧНІ МАСКИ, ПЕНЗЛІ 

 

65 

 

Після того як замкнемо контур, активуємо інструмент «Direct Selection 

Tool»  (А) і, переміщаючи опорні точки і маніпулятори, підправляємо кон-

тур, де це необхідно (рис. 4.17). Обов’язково присвоюємо кожному шару зручне 

найменування, це допоможе уникнути плутанини при роботі з великою кількістю 

шарів. 

 

 
Рис. 4.17. Створення лацкана 

 

17. Дублюємо шар з лацканом (Ctrl + J), відображаємо по горизонталі і ста-

вимо симетрично правому. Виконуємо об’єднання як у кроці 7, називаємо отри-

маний шар «Лацкан». Створюємо порожні шари «Тінь», «Текстура» і вмикаємо 

режим відсічної маски. За аналогією з попередніми кроками розрисовуємо оби-

два лацкани. На шари «Світла» з групи «Піджак» дорисовуємо тінь під кожним 

лацканом (рис. 4.18). 

 

 
Рис. 4.18. Створення текстури і тіні для лацканів 
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18. Об’єднуємо шари в групу «Лацкани» і переходимо до створення форми 

краватки. Швидше за все це зробити інструментом «Pen Tool»  (Р) (рис. 4.19). 

 

 
Рис. 4.19. Створення краватки 

 

19. Створюємо дві відсічні маски «Текстура», «Тінь». Шар «Текстура» за-

ливаємо піксельною червоною текстурою з набору «Кольоровий папір» інстру-

ментом «Paint Bucket Tool»  (G) у режимі «Pattern». Бордовим м’яким пенз-

лем прорисовуємо темні ділянки краватки. У групі «Сорочка» на шарі «Тіні» 

прорисовуємо легку тінь від краватки (рис. 4.20). 

 

 
Рис. 4.20. Завдання текстури та створення об’єму для краватки 
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20. Інструментом «Перо» нарисуємо два шви для рукавів. Щоб отримати 

незамкнений контур, тиснемо Esc, після встановлення останньої опорної точки. 

Товщина обведення 1px, колір #222355. Нарисуємо пензлем світлу лінію на шарі 

з текстурою піджака (рис. 4.21). Колір для пензля: #424482. 

 

 
Рис. 4.21. Створення швів на рукавах 

 

21. У групі «Піджак» рисуємо пером ще один шов, який буде розділяти пі-

джак на дві частини (рис. 4.22). Повторюємо дії кроку 20. 

 

 
Рисунок 4.22. Створення центрального шва 
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22. Створюємо ґудзики. За допомогою інструменту «Ellipse Tool»  (U) 

(рис. 4.23). 

 

 
Рис. 4.23. Створення ґудзика 

 

23. Попарно вирівнюємо майбутні отвори ґудзика. Об’єднуємо всі отвори 

в один шар (Merge layers). Об’єднуємо отримані шари «отвори» і «ґудзик» (Merge 

leyers). Інструментом «Path Selection Tool»  (А) з затиснутою клавішею Shift 

виділяємо всі чотири отвори і вибираємо властивість контуру «Substract Front 

Shape» (Віднімання) (рис. 4.24). 

 

 
Рис. 4.24. Створення отворів у ґудзику 
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24. Зменшуємо ґудзик (Ctrl + T). Дублюємо (Ctrl + J) і розміщуємо з пра-

вого боку від шва. На шарі з текстурою піджака дорисуємо тінь і отвір для засті-

бання ґудзиків (рис. 4.25). 

 

 
Рис. 4.25. Розміщення ґудзиків 

 

25. За аналогією з 16-м кроком рисуємо кишені. Додаємо шви над кожною 

кишенею (рис. 4.26). 

 

 
Рис. 4.26. Створення кишень 

 

26. Рисуємо пером задню частину піджака, нижню частину сорочки і ру-

кава сорочки. Нижня частина сорочки складається з двох напівпрозорих білих 

фрагментів (рис. 4.27). Значення прозорості для них виставляємо 82 %. 
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Рис. 4.27. Створення задньої поверхні одягу 

 

27. Додаємо логотип, слоган і фон візитки. Створюємо інструментом 

«Rectengle Tool»  (U) прямокутник так, щоб він займав 1/3 монтажної області 

(для зручності встановимо додаткову вертикальну напрямну на позначці в 64мм). 

Заливаємо його білим кольором, а шар з фоном заливаємо чорним (рис. 4.28). 

 

 
Рис. 4.28. Створення логотипу і фону візитки 
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28. Додаємо текст (рис. 4.29). Вибираємо інструмент «Horizontal Type 

Tool»  (T). Шрифт Trajan Pro, колір білий, розмір 30pt. 

 

 
Рис. 4.29. Створення тексту 

 

29. Додаємо ще один текстовий шар і прописуємо слоган кеглем 11 pt. Ви-

діляємо два текстових шари і вирівнюємо їх по лівому краю (рис. 4.30). 

 

 
Рис. 4.30. Вирівнювання тексту 

 

30. Горизонтальними напрямними розділимо візитку на три частини. Пе-

ршу встановлюємо на позначці 18,5 мм, другу – на 37 мм. Вирівнюємо текст між 
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встановленими напрямними (рис. 4.31). (Зараз ми скористалися правилом третин 

– спрощеним правилом золотого перетину). 

 

 
Рис. 4.31. Розстановка напрямних для розміщення тексту 

 

31. Створюємо відсічні маски для кожної строки шрифту і для білого пря-

мокутника. Додаємо вікно «Brushes» на панель швидкого доступу (рис. 4.32). 

Window → Brushes. (Щоб відключити підказки: напрямні, сітки та ін. допоміжні 

елементи, скористаємося клавішами Ctrl + H). 

 

 
Рис. 4.32. Створення відсічних масок і додавання панелі пензлів 
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32. У вікні пензлів вибираємо Special Effects Brushes → Kyle’s Spatter 

Brushes - Supreme Spatter & Texture та з розміром пензля в 200px проходимо по 

кожному рядку нашого тексту (рис. 4.33). 

 

 
Рис. 4.33. Створення текстури тексту 

 

33. У вікні «Brush Settings» обираємо пензель «Sampled Brush 116» та за-

фарбовуємо білий прямокутник. Для цього потрібно встановити курсор на центр 

піджака та натискати ЛКМ доти, поки не зафарбується вся область. Колір пензля: 

#232760, непрозорість 34 %, розмір 1000px (рис. 4.34). Групуємо залишки шарів, 

експортуємо отриманий документ (Ctrl + Shift + Alt + W) у формат .jpg, зберіга-

ємо у форматі .psd. 

 

 
Рис. 4.34. Налаштування пензля 
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34. Створюємо новий документ з аналогічними налаштуваннями (див. 

Крок 1). Так само налаштовуємо напрямні і рисуємо прямокутник на 1/3 докуме-

нта (рис. 4.35). Заливаємо кольором #130e37. 

 

 
Рис. 4.35. Створення задньої поверхні візитки 

 

35. За аналогією з 28-м кроком створюємо текст «BLAZER». Колір тексту 

#130f38. Так само створюємо перелік продукції кеглем 12pt. Вирівнюємо текс-

тові рядки (рис. 4.36). 

 

 
Рис. 4.36. Створення тексту на зворотному боці картки 

 

36. Як у 31-м і 32-м кроках створюємо відсічні маски для всіх текстових 

шарів і працюємо пензлем Kyle’s Spatter Brushes – Supreme Spatter & Texture (рис. 

4.37). 
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Рис. 4.37. Створення текстури для тексту 

 

37. Застосовуємо групування шарів, щоб мати до них швидкий доступ. До-

даємо контактну інформацію. Розмір шрифту 7pt. Вирівнюємо його по лівому 

краю і по висоті. Також вирівнюємо всю групу по напрямних, що з’являються 

під час переміщення. Вони позначені червоними стрілками (рис. 4.38). 

 

 
Рис. 4.38. Додавання та вирівнювання контактної інформації 

 

38. Створюємо відсічну маску синьому прямокутнику і, вибравши пензель 

«Sampled Brush 117», зафарбовуємо прямокутник як у пункті 33. Шар з маскою 

робимо непрозорим на 60 %. Виконуємо зведення шарів. Для цього виділяємо всі 
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шари і в контекстному меню вибираємо «Merge Layers» (Ctrl + Shift + E) 

(рис. 4.39). Експортуємо отриманий документ (Ctrl + Shift + Alt + W) у формат 

.jpg, зберігаємо у форматі .psd. 

 

  
Рис. 4.39. Створення фону для асортименту 

 

39. Зберігаємо проєкт для друку в поліграфії. File → Save as ... (Ctrl + Shift 

+ S) і вибираємо формат .pdf (рис. 4.40). 

 

 
Рис. 4.40. Збереження проєкту 

 

40. Вибираємо такі налаштування друку і стиснення документа (рис. 4.41, 

4.42). 
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Рис. 4.41 Налаштування параметрів збереження проєкту 

 

 
Рис. 4.42. Налаштування параметрів стиснення проекту 

 

41. Повторюємо той самий шлях збереження для фронтальної сторони та 

скористаємося Mock-Up-ом (макетом, шаблоном) для візуальної подачі візиток 

замовнику. Відкриваємо документ «Mock-Up.psd» і двічі натискаємо по прозо-

рому шару із позначкою смарт-об’єкта (рис. 4.43). Відкриється нова вкладка. Пе-

ретягуємо на неї збережене в форматі .jpg зображення задньої частини візитки. 

Розтягуємо під розмір полотна і зберігаємо зміни (Ctrl + S). 
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Рис. 4.43. Застосування Mock-Up-у 

 

42. Повторюємо той самий алгоритм для фронтальної частини і експорту-

ємо документ (Ctrl + Shift + Alt + W) у формат .jpg. По завершенню роботи, папка 

результатів повинна бути наповнена таким чином (рис. 4.44). 

 
Рис. 4.44. Демонстрація збережених файлів 

 

4.3. Завдання на самостійну роботу 

 

Створити двобічну корпоративну візитну картку, обравши її тематику довільно. 

Обов’язкові елементи макету такі: 

‒ зображувальна частина, що виконана за допомогою векторних інструментів; 

‒ текстова частина; 

‒ блок контактної інформації. 

Зберегти макет у форматах .psd, .pdf, jpg. Подати роботу у вигляді Mock-

Up-у. 
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Запитання для самоконтролю 

 

1. Якими інструментами можна редагувати контур не виходячи з режиму 

рисування пером? 

2. Що дозволяє режим рисування Path? 

3. Чому ми працюємо з мм, а не з px? 

4. Навіщо використовувати напрямні? 

5. Навіщо необхідний Mock-up? 
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5.1. Загальні поняття 

 

Усі відомі нам кольори поділяються на хроматичні і ахроматичні. Перші 

характеризуються трьома властивостями: тон, насиченість і яскравість (світ-

лість). Тон ‒ основна відмітна властивість хроматичного кольору, завдяки якій 

одні кольори називають червоними, інші жовтими та ін. Основний природний 

ряд кольорів являє собою спектр. Тон дозволяє розрізняти спектральні кольори. 

Насиченість ‒ ступінь відмінності даного кольору від ахроматичного, що рівний 

йому за світлістю. Насиченість визначається ступенем близькості до спектраль-

ного кольору. Спектральні кольори мають насиченість 1, ахроматичні ‒ 0. Кожен 

колір може змінюватися залежно від ступеня насиченості або чистоти. Яскра-

вість (світлість) ‒ кількість світлової енергії, що виходить від одиниці поверхні 

в одиницю часу. Залежить від здатності кольору до відбиття, яскравості та сили 

освітлення. Світлість відображає уявлення про інтенсивність, як про фактор, що 

не залежить від колірного тону та насиченості. Ахроматичні кольори мають 

лише одну властивість ‒ яскравість, і складаються з білого, чорного і нескінчен-

ної кількості градацій сірого (рис. 5.1) [1, 2, 6, 7]. 

 

 

Рис. 5.1. Ахроматичні та хроматичні кольори
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5.1.1. Кольорова модель RGB 

RGB ‒ абревіатура англійських слів Red, Green, Blue ‒ червоний, зелений, 

синій. Адитивна (Add, англ. ‒ додавати) кольорова модель, зазвичай, слугує для 

виведення зображення на екрани моніторів та інших електронних пристроїв. Як 

видно з назви вона складається з синього, червоного і зеленого кольорів, які ут-

ворюють усі проміжні (рис. 5.2). Така модель має велике колірне охоплення. 

Адитивна кольорова модель передбачає, що вся палітра кольорів склада-

ється з точок, що світяться. Тобто на папері, наприклад, неможливо відобразити 

колір у кольоровій моделі RGB, оскільки папір колір поглинає, а не світиться сам 

по собі. Підсумковий колір можна отримати, додаючи до вихідної чорної (яка не 

світиться) поверхні відсотки від кожного з ключових кольорів [15]. 

 

 

Рис. 5.2. Кольорова модель RGB 

 

5.1.2. Кольорова модель CMYK 

CMYK − Cyan, Magenta, Yellow, Key color − субтрактивна (subtract, англ. 

віднімати) схема формування кольору, яка використовується в поліграфії для 

стандартного тріадного друку. Має менше в порівнянні з RGB колірне охоп-

лення. 
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CMYK називають субтрактивною моделлю тому, що папір та інші матері-

али для друку є поверхнями, що відбивають світло. Зручніше розраховувати,   

скільки світла відбилося від тієї чи іншої поверхні, ніж скільки поглинулося. Та-

ким чином, якщо відняти від білого три первинні кольори − RGB, ми отримаємо 

трійку додаткових кольорів CMY. «Субтрактивний» означає «такий, що відніма-

ється» − з білого віднімаються первинні кольори. 

Key Color (чорний) застосований у цій кольоровій моделі як заміна змішу-

ванню в різних пропорціях фарб тріади CMY (рис. 5.3) [15]. 

 

 

Рис. 5.3. Кольорова модель CMY 

 

5.1.3. Кольорова модель LAB 

У колірному просторі Lab значення яскравості відокремлене від значення 

хроматичної складової кольору (тон, насиченість). Яскравість задана координа-

тою L (змінюється від 0 до 100, тобто від самого темного до самого світлого), 

хроматична складова − двома декартовими координатами a та b. Перша позначає 

стан кольору в діапазоні від зеленого до пурпурного, друга − від синього до      

жовтого (рис. 5.4). 

На відміну від колірних просторів RGB або CMYK, які є, по суті, набором 

апаратних даних для відтворення кольору на папері або на екрані монітора (колір 

може залежати від типу друкарської машини, марки фарб, вологості повітря на 
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виробництві або виробника монітора та налаштувань останнього), Lab одно-

значно визначає колір. Тому Lab знайшла широке застосування в програмному 

забезпеченні для обробки зображень як проміжний колірний простір, через який 

відбувається конвертація даних між іншими колірними просторами (наприклад, 

з RGB сканера в CMYK друкованого процесу). При цьому особливі якості Lab 

зробили редагування в цьому просторі потужним інструментом кольорокорекції 

[15]. 

 

 

Рис. 5.4. Кольорова модель LAB 

 

5.1.4. Кольорова модель HSB 

HSB − модель, яка в принципі є аналогом RGB, вона заснована на її кольо-

рах, але відрізняється системою координат. Будь-який колір у цій моделі харак-

теризується тоном (Hue), насиченістю (Saturation) та яскравістю (Brightness). Тон 

− це власне колір. Насиченість − відсоток доданої до кольору білої фарби. Яск-

равість − відсоток доданої чорної фарби. Отже, HSB − триканальна колірна мо-

дель. Будь-який колір у HSB виходить додаванням до основного спектра чорної 

або білої, тобто фактично сірої фарби (рис. 5.5). 

Модель HSB не є суворою математичною моделлю. Опис кольорів у ній 

не відповідає кольорам, які сприймаються оком. Справа в тому, що око сприймає 

кольори, як такі, що мають різну яскравість. Наприклад, спектральний зелений 

має більшу яскравість, ніж спектральний синій. У HSB всі кольори основного 
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спектра (каналу тони) вважаються такими, що володіють яскравістю 100 %. На-

справді, це не відповідає дійсності. 

Хоча модель HSB декларована як апаратно-незалежна, насправді в її основі 

лежить RGB. У будь-якому випадку HSB конвертується в RGB для відображення 

на моніторі та в CMYK для друку, а будь-яка конвертація не обходиться без втрат 

[15]. 

 

Рис. 5.5. Кольорова модель HSB 

 

5.1.5. Друк додатковими фарбами (Кольори Pantone) 

У зв’язку з тим, що для відтворення дуже яскравих кольорів CMYK-гами 

недостатньо, в окремих випадках використовується друк CMYK + додаткові 

(SPOT) фарби. Додаткові фарби зазвичай називають Pantone, хоча це не зовсім 

правільно (каталог Pantone описує всі кольори, які входять в CMYK, так і такі, 

що не містяться в ньому). Правильно називати такі кольори SPOT (плашечні), на 

відміну від сумішевих, тобто CMYK. 

Фізично це означає, що замість чотирьох друкованих секцій зі стандарт-

ними CMYK-кольорами використовується більша їх кількість. Якщо друкованих 

секцій усього чотири, організовується додатковий прогін, коли в уже готовий ви-

ріб додруковуються додаткові кольори. 
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Існують друкарські машини з п’ятьма друкованими секціями, тому друк 

всіх кольорів відбувається за один прогін, що, безсумнівно, покращує якість ві-

дображення кольору в готовому виробі. У разі друку в чотирьох CMYK-секціях 

і додатковим прогоном через друкарську машину з плашечними фарбами, то ко-

льорове відображення може страждати. Особливо це буде помітно на машинах з 

менше ніж чотири друкованими секціями. Зокрема, рекламні листівки, де за краї, 

наприклад, красивих яскраво-червоних букв може трохи виступати жовта рамо-

чка, яка є ні що інше, як жовта фарба з розкладки цього красивого червоного 

кольору [15]. 

 

5.1.6. Основні параметри вікна Color Picker 

Розглянемо структуру вікна Color Picker (рис. 5.6). 

 

 

Рис. 5.6. Основні параметри вікна Color Picker 

А – обраний колір; В – вихідний колір; С – відрегульований колір; D – позначка попе-

редження про вихід за межі кольорового охоплення; Е – позначка попередження для кольору, 

який не є вебкольором; F – відображення тільки вебсумісних кольорів; G – поле кольору; Н – 

повзунок кольору; І – значення кольору. 
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5.1.7. Вибір вебсумісних кольорів 

Вебсумісні кольори − це 216 кольорів, які використовуються браузерами 

незалежно від платформи. Щоб відобразити зображення на 8-бітовому дисплеї, 

браузер змінює всі кольори зображення на вебсумісні кольорі. Ці 216 кольорів є 

підмножиною 8-бітної кольорової палітри Mac OS. Працюючи тільки з цими ко-

льорами, можна бути впевненим, що ілюстрація, яка підготовлюється для вико-

ристання в Інтернет, і не буде піддана змішанню кольорів у системах, що відо-

бражають 256 кольорів. 

Щоб обрати вебсумісні кольори при роботі в Adobe Photoshop необхідно в 

лівому нижньому кутку палітри кольорів відмітити параметр «Тільки Вебко-

льори». Якщо обраний не вебсумісний колір, то в палітрі кольорів Adobe поруч 

з кольоровим прямокутником з’являється куб попередження. Треба клікнути на 

ньому для вибору вибрати найближчого вебсумісного кольору. (Відсутність куба 

попередження означає, що вибраний колір є вебсумісним) [1, 2, 6, 7]. 

 

5.1.8. Вибір плашечних кольорів 

Палітра кольорів Adobe дозволяє вибирати кольори з систем PANTONE 

MATCHING SYSTEM®, Trumatch® Swatching System ™, Focoltone® Colour 

System, Toyo Color Finder ™ 1050, ANPA-Color ™, HKS® і DIC Color Guide. 

Щоб гарантувати, що кінцеві друковані відбитки матимуть бажані ко-

льори, необхідно проконсультуватися в обраному друкованому або сервісному 

бюро та призначити кольори за друкованими зразками. Щоб можна було компе-

нсувати знебарвлення фарб та інші пошкодження, виробники рекомендують що-

року отримувати новий каталог зразків. 

Якщо відкрити палітру кольорів Adobe та клацнути на прапорці «Бібліо-

теки кольорів», то в діалоговому вікні «Кольори за замовленням» відобразиться 

колір, який буде найбільш близьким до обраного в палітрі кольорів Adobe [16]. 
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5.2. Практичні завдання 

 

5.2.1. Робота з інструментом Color Range (Кольоровий діапазон) 

Розбираємо принцип роботи інструмента Color Range (Кольоровий діапа-

зон), його можливості та налаштування. Допомагаємо дівчинці з обранням ко-

льору сукні, створюємо незвичайний букет екзотичних троянд та вирівнюємо тон 

шкіри звичайному хлопцю з Голівуду (рис. 5.7). 

 

 

Рис. 5.7. Вихідні та відредаговані зображення 

 

1. Відкриваємо зображення «Букет.jpg», «Сукня.jpg» і «Крис Еванс.jpg». 

Починаємо з сукні. Переходимо в режим Color Range для налаштування обрання 

кольорового діапазону (рис. 5.8). 

 

 

Рис. 5.8. Відкриття вікна Color Range 
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2. Налаштовуємо вікно Color Range. Параметр Fuzziness (розкид) відпові-

дає за охоплення додаткових відтінків кольору, що виділяється. Range (Діапазон) 

– якщо ввімкнений режим Localized Color Clusters (Локалізованих наборів) обме-

жує діапазон кольорів, що обираються. Режим перегляду у цьому випадку зруч-

ніше використовувати Grayscale (Градації сірого). Режим виділення Sampled 

Colors (За зразками) дозволяє виділити віддалені один від одного області одного 

і того ж кольору. Налаштовуємо параметри Fuzziness: 50, Range 60 % (рис. 5.9). 

 

 

Рис. 5.9. Налаштування параметрів вікна Color Range 

 

3. Піпеткою вибираємо ту ділянку, на якій ми хочемо замінити колір. Для 

виключення зайвої області, утримуючи Alt, вибираємо непотрібне біле виді-

лення. Для додавання області, утримуючи Shift, вибираємо решту зображення. 

Намагаємося якомога яскравіше зробити плаття і максимально затемнити інші 

деталі (рис. 5.10). Вибір зайвих областей не критичний, їх будемо видаляти мас-

кою та відніманням виділення. 

4. Тиснемо Ok та за допомогою будь-якого інструменту виділення, у ре-

жимі віднімання вилучаємо зайві виділені області (рис. 5.11). 
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Рис. 5.10. Уточнення виділення у вікні Color Range 

 

  

Рис. 5.11. Позбавлення зайвих виділених ділянок 

 

5. Створюємо коригуючий шар Hue/Saturation, для чого активуємо піктог-

раму  знизу в палітрі шарів (рис. 5.12). 

 

  

Рис. 5.12. Додавання коригуючого шару Hue / Saturation (Тон / Насиченість) 
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6. Здійснюємо редагування червоних тонів, для чого перетягуємо повзунок 

тону (Hue) вліво до значення 127 і надаємо сукні синього кольору (рис. 5.13). 

 

  

Рис. 5.13. Зміна кольору сукні 

 

7. Оскільки по краях і на лямках залишилися невеликі червоні контури, не-

обхідно ввести деякі корективи. Вибираємо м’який пензель (B) зі зручними па-

раметрами налаштування, виставляємо кольори у вікні Color picker таким чином: 

білий (основний) і чорний (фоновий). Для прискорення процесу досить натис-

нути клавішу D. Після того переходимо на шар-маску і зафарбовуємо червоні 

недоліки (рис. 5.14). 

 

 

Рис. 5.14. Видалення червоного контуру 
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8. Перефарбуємо букет троянд. Створюємо виділення з такими налашту-

ваннями вікна Color Range: розкид 160, діапазон 100 % (рис. 5.15). 

 

 

Рис. 5.15. Налаштування параметрів вікна Color Range 

 

9. Далі повторюємо той самий алгоритм, який було застосовано при реда-

гуванні попереднього зображення. У цьому випадку отримуємо перенасичені ко-

льори на кінчиках пелюсток троянд (рис. 5.16). 

 

 

Рис. 5.16. Налаштування параметрів вікна Color Range 

 

10. Щоб не переводити весь букет у світліші тони перемикаємо Reds (Чер-

воні) на Magentas (Пурпурові) і зміщуємо тон на позначку в 127. Переходимо на 

шар-маску і ліквідуємо червоні контури. Вибравши чорну кисть, можна зробити 

бант темнішим (рис. 5.17). 
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Рис. 5.17. Результат колоризації 

 

11. Щоб попрацювати з тілесними кольорами, перейдемо до зображення 

«Крис Еванс.jpg». Інструментами виділення прибираємо зайві виділені області, 

залишаючи тільки обличчя та волосся актора (рис. 5.18). Створюємо коригува-

льний шар Curves (Криві) (рис. 5.19). 

 

 

Рис. 5.18. Виділення необхідних областей 
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Рис. 5.19. Створення коригувального шару 

 

12. Обравши інструмент прямої корекції, встановлюємо курсор над самою 

світлою ділянкою шкіри та, затиснувши ЛКМ, трішечки протягуємо курсор до-

низу. Таким чином здійснюємо зниження яскравості полутонів та видалення зай-

вої яскравості з обличчя актора (рис. 5.20). 

 

 

Рис. 5.20. Остаточно відредаговане зображення 
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5.2.2. Створення морського пейзажу 

На прикладі простої композиції (рис. 5.21) розберемо декотрі основні по-

няття теорії кольору та засвоїмо нові терміни. 

 

 

Рис. 5.21. Морський пейзаж 

 

1. Створюємо новий проєкт з такими налаштуваннями (рис. 5.22). 

 

 

Рис. 5.22. Вікно налаштувань параметрів нового документа 
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2. Розміщуємо скетч у проект. Пропорційно збільшуємо його, розташову-

ючи посередині полотна (рис.5 .23). 

 

 

Рис. 5.23. Розміщення скетчу на полотні 

 

3. Інструментом перо обводимо кожен елемент рисунка, крім кола на тлі 

води. З усіма фігурами працюємо в режимі Shape (Фігура). Для зручності необ-

хідно вимкнути заливку. Бажано називати кожну нову фігуру згідно з наймену-

ванням об’єкта, який обводиться (рис. 5.24). 

 

 

Рис. 5.24. Обведення контуру скетчу інструментом перо 
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4. Кожну фігуру, крім тросів, заливаємо чорним кольором та вимикаємо 

контур. Для цього затискаємо клавішу Shift та обираємо всі шари, які хочемо за-

лити чорним кольором. Коло залишаємо без змін. Для контуру тросів встанов-

люємо чорний колір (рис. 5.25). 

 

 

Рис. 5.25. Заливка фігур чорним кольором 

 

5. Шар «Скетч» робимо невидимим (натискаємо око поряд з шаром.) Пра-

цюючи інструментами для роботи з контурами, робимо корабель більш реаліс-

тичним. Дублюємо прапор (Ctrl+J), вертикально віддзеркалюємо копію та ро-

бимо прапор таким, що майорить. Коли досягаємо потрібного ефекту, об’єдну-

ємо шари з частинами прапора. Далі працюємо з кормою. Для цього створюємо 

нову фігуру (рис. 5.26). Всі зміни помічені стрілками. 

 

 

Рис. 5.26. Коригування геометрії вітрильника 
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6. Створюємо чотири прямокутника з округленими кутами та, виділивши 

їх разом із кормою, об’єднуємо в один шар. Виділяємо прямокутники та корму 

(А) після чого застосовуємо операцію Subtract Front (рис. 5.27). 

 

 

Рис. 5.27. Застосування операції Subtract Front 

 

7. Додаємо заливку кормі. Для більш широкого вибору кольорів відкрива-

ємо вікно Color Picker. Застосуємо кольорову модель HSB, оскільки вона дуже 

добре розмежовує параметри кольорового тону, насиченості та яскравості. Оби-

раємо чорний колір та збільшуємо параметр Brightness. Отримуємо чорний колір 

яскравіший на декілька одиниць. Працюючи тільки з параметром Hue, можна 

втратити потрібний кольоровий тон, збільшуючи яскравість (рис. 5.28). 

 

 

Рис. 5.28. Додавання заливки кормі вітрильника 
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8. Коригуємо основу вітрильника (рис. 5.29). 

 

 

Рис. 5.29. Коригування основи вітрильника 

 

9. Створюємо борти та палубу, для чого рисуємо еліпс у режимі фігури та 

інструментами Convert Point Tool (Кут)  або Path Selection Tool (Виділення 

контуру)  (А) робимо гострою і витягуємо верхню опорну точку еліпса. Ду-

блюємо шар (Ctrl+J), зменшуємо його розмір і робимо заливку світлішою. Це 

буде палуба. Виділяємо всі об’єкти, що вище палуби, та збільшуємо їх розмір і 

трішки розтягуємо за вертикаллю. Палубу, борти та основу переміщуємо в самий 

низ полотна (рис. 5.30). 

 

 

Рис. 5.30. Створення бортів та палуби 
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10. Рисуємо ростр (балка на носі вітрильника), до нього опускаємо трос із 

щогли. Виділяємо всі шари з вітрильником та створюємо групу «Вітрильник» 

(Ctrl+G) (рис. 5.31). 

 

 

Рис. 5.31. Утворення групи «Вітрильник» 

 

11. Працюємо над водною поверхнею та створюємо простір для нічного 

пейзажу. Додаємо у проєкт зображення моря. Розташовуємо трішки вище самого 

нижнього вітрила та створюємо шар-маску (рис. 5.32). 

 

 

Рис. 5.32. Додавання зображення моря та шару-маски в проєкт 

 

12. Залишаючись на масці, активуємо інструмент Gradient Tool (Градієнт) 

 (G) та обираємо шаблон від чорного до білого. Проводимо крихітний відрі-

зок зверху вниз із затиснутою клавішею Shift (рис. 5.33). 
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Рис. 5.33. Додавання тонового контрасту до зображення 

 

13.  Уже зараз, не маючи світлого місяця і фону як такого, ми можемо по-

бачити роботу тонового контрасту. Спершу мозок сприймає світлі і темні діля-

нки зображення, лише потім реагує на кольори. Цей тип контрасту заснований 

на використанні тільки ахроматичних кольорів, але при цьому дозволяє відразу 

зрозуміти, що відбувається на композиції і в нашому випадку навіть виділити 

головне і другорядне. Тоновий контраст є одним із основоположних понять, без 

якого неможливо побудувати мальовничу композицію навіть у сфері CG. 

14. Створюємо новий шар і розміщуємо його під групою «Вітрильник» та 

шаром «Море» (рис. 5.34). 

 

 

Рис. 5.34. Створення нового шару 
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15. Обираємо інструмент градієнт (G) і тиснемо на шаблонний зразок. 

Створюємо потрібний нам новий зразок градієнта. Подвійним кліком по ниж-

ньому повзунку або віконцю Color викликаємо вікно Color Picker. Щоб поста-

вити новий повзунок, тиснемо на межу градієнта. Для видалення повзунка необ-

хідно натиснути клавішу Delete (рис. 5.35). 

 

 

Рис. 5.35. Вікно Gradient Editor 

 

16.  Для підбору кольорів, що гармонійно поєднуються, скористає-

мося кольоровим колом від Adobe [17]. Приблизно обираємо діапазон ко-

льорів (рис. 5.36) та копіюємо шістнадцяткове значення з-під кожного ви-

діленого кольору. 

 

  

Рис. 5.36. Підбір кольорів для градієнта 
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17. Подвійним кліком обираємо правий нижній повзунок і у вікні Color 

Picker вставляємо код кольору. Повторюємо цю операцію для всіх трьох кольорів 

та тиснемо кнопку New у вікні градієнта. Таким чином новий градієнт буде збе-

режений у списку шаблонів (рис.5.37). 

 

 

Рис. 5.37. Створення та збереження нового шаблону градієнта 

 

18. Новим  градієнтом  із  затиснутою  клавішею  Shift  проводимо верти-

кальну лінію (зверху вниз) по новому шару (рис. 5.38). 

 

 

Рис. 5.38. Забарвлення неба 
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19. Додаємо в документ зображення місяця, обираємо режим накладення 

Screen та створюємо шар-маску. Застосовуючи чорно-білий градієнт, проводимо 

діагональ як показано на рис. 5.39. 

 

 

Рис. 5.39. Додавання зображення місяця в проєкт 

 

20. Додаємо до нічного неба зірок. Для цього нарисуємо новий пензель 

«Зірка». Створюємо порожній шар «Зірка» та обираємо інструмент Polygon Tool 

(Багатокутник)  (U). У режимі Path, клікаємо зліва від вітрильника та обира-

ємо такі параметри для зірки (рис. 5.40). 

 

  

Рис. 5.40. Налаштування параметрів багатокутника для створення зірки  
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21.  Створюємо виділення з фігури та заливаємо зірку жовто-помаранче-

вим градієнтом (рис. 5.41). 

 

Рис. 5.41. Забарвлення зірки  

 

22. Не знімаючи виділення, створюємо пензель, який буде рисувати зір-

ками Edit→Define Brush Preset. Надаємо йому ім’я «Зоряна зірка» і видаляємо 

шар «Зірка». Створюємо новий шар та переходимо до налаштувань пензля «Зо-

ряна зірка». Вікно Brush Settings відкриваємо за таким шляхом: Windows→Brush 

Settings, або (F5) (рис. 5.42). 

 

  

 

Рис. 5.42. Налаштування пензля «Зоряна зірка» 
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23. Обираємо жовтий колір (#fff100) для нового пензля та забарвлюємо 

фон. Розмір пензля можна знизити до 30 px. Обираємо ластик (E) більшого роз-

міру та витираємо зірки з місяця. Завдяки зіркам на небі ми досягли ефекту теп-

лохолодності (рис. 5.43). Цей прийом примушує локальний колір (фон) вигля-

дати більш живим та грайливим, не порушуючи при цьому єдність основного 

кольору. Також проявляється взаємодія кольору та форми. Як відомо, жовтому 

кольору відповідають трикутні форми, синьому – круглі, а червоному – квадра-

тні. Зірки є чудовим прикладом гармонії кольору та форми. 

 

 

Рис. 5.43. Створення зоряного неба 

 

24.  Для того щоб поєднати зірки, градієнт та місяць в єдиний фон, додаємо 

ефект Grain (Зерно). Відкриваємо галерею фільтрів Filter→Filter Galler та налаш-

товуємо ефект згідно з рис. 5.44. Тиснемо Ok. Параметр Opacity (Непрозорість) 

шару «Зірки» знижуємо до 70 %. 

 

 

Рис. 5.44. Налаштування ефекту Grain (Зерно) 
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25. Щоб поєднати воду із створеним нічним пейзажом, необхідно змінити 

її кольоровий тон. Створюємо коригуючий шар Hue/Saturation, відсічну маску та 

налаштовуємо згідно з рис. 5.45. Активуємо чорно-білий градієнт і на шарі з ма-

скою проводимо вертикальну лінію до середини води. 

 

 

Рис. 5.45. Зміна кольорового тону води 

 

26. Створюємо коригуючий шар Brightness/Contrast та підвищуємо яскра-

вість до позначки 28 (рис. 5.46). 

 

  

Рис. 5.46. Підвищення яскравості зображення 
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27. Створюємо коригуючий шар Hue/Saturation над усіма поточними для 

посилення лінії обрію та зіставлення неба та води (рис. 5.47). 

 

 

Рис. 5.47. Налаштування коригуючого шару Hue/Saturation 

 

28. Інструментом Move Tool (V) піднімаємо воду таким чином, щоб та 

трохи перекривала місяць. Створюємо порожній шар. Вибираємо градієнт від чо-

рного до прозорого і заливаємо нижню частину моря (рис. 5.48). Зберігаємо 

проєкт у форматі .psd та експортуємо в формати .jpeg та .png. 

 

 

Рис. 5.48. Остаточний результат роботи 
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Запитання для самоконтролю 

 

1. Для чого необхідні кольори Pantone? 

2. У чому недолік колірної моделі HSB? 

3. Чому CMYK називається субтрактивною моделлю?  

4. Чому колірна модель RGB не може відображатися на папері? 

5. Яка колірна модель використовується для конвертації між іншими та од-

нозначно визначає колір? 
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6. ТОНОВА ТА КОЛІРНА КОРЕКЦІЯ ЗОБРАЖЕНЬ 

 

6.1. Загальні поняття 

У системі Adobe Photoshop CC реалізована потужна можливість редагу-

вання зображень за допомогою арсеналу засобів зміни яскравості, контрасту та 

кольору як усього зображення, так і його окремих ділянок, або тонових та кольо-

рових діапазонів залежно від кожного конкретного випадка та задуму автора. 

 

6.1.1. Тонова корекція 

Тонова корекція – приведення до оптимальних налаштувань яскравості і контра-

сту зображення, ґрунтуючись на гістограмі, яка відображає кількість пікселів для 

певної ділянки світлості на зображенні (рис. 6.1) [1, 2]. 

 

 

 

Рис. 6.1. Гістограма розподілу кількості пікселів залежно від їх світлості
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Точка чорного – істинно чорні області зображення, в яких не розгледіти 

деталей. Так звані «випалені» ділянки. 

Тіні – темні ділянки зображення, які несуть у собі інформацію про текс-

туру, а не суцільний чорний колір. 

Півтони – діапазон, в якому області зображення не є ні темними, ні світ-

лими, а вважаються середніми. 

Світла – області зображення з високою яскравістю, але при цьому є мож-

ливість розгледіти деталі. 

Точка білого – навіть  якщо  область  не  виглядає  білою,  але має макси-

мальну яскравість, що не дозволяє побачити деталі, її можна вважати точкою бі-

лого [6, 7, 18]. 

 

6.1.2. Корекція кольору 

Корекція кольору – внесення змін до кольору оригіналу. У більш вузькому 

сенсі корекція – це таке перетворення зображення, об’єкта чи фрагмента, коли 

новий колір оброблюваного пікселя залежить від старого значення цього пікселя 

і не залежить від сусідніх пікселів. 

Основна причина, по якій доводиться виконувати корекцію кольору, на-

ступна. Людське око має здатність адаптуватися до сили і спектральної характе-

ристики освітлення таким чином, що зберігає сприйняття кольору предметів в 

більшості випадків незалежно від спектрального складу освітлення. Камера же 

фіксує світлове випромінювання без адаптації і, при перегляді в інших умовах, 

фотографії іноді сильно відрізняються від того, що ми бачили, коли фотографу-

вали. 

Будь-яке зображення в цифровому середовищі складається з трьох кольо-

рів (каналів). Червоний, зелений і синій є основою будь-якого кольорового тво-

ріння веб-дизайнера. У Photoshop канали розташовуються у вкладці Channel (Ка-

нали) в панелі палітри шарів. За замовчуванням канали відображаються в града-

ціях сірого, але це можна відобразити і в кольорі (Edit → Preferences → Interface 
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→ Show Channels in Color). Найчастіше працюють в градаціях сірого, оскільки за 

світлістю кожної ділянки фото зрозуміло скільки в ньому міститься того чи ін-

шого кольору. Чим біліше область, тим більше в ній кольору обраного каналу – 

чим темніше –  тим менше (рис. 6.2). 

 

 

Рис. 6.2. Три основні канали, які формують зображення 

 

Усі корекції, які будуть розглянуті в цьому розділі, будуть реалізовані за 

рахунок застосування коригувальних шарів. Ті ж самі корекції можна знайти в 

меню корекцій, що випадає, за наступним шляхом Image → Adjustments. 

Головна перевага у використанні коригувальних шарів, а не меню корекцій 

полягає в тому, що коригувальний шар не має незворотних деструктивних влас-

тивостей. У будь-який момент можна звернутися до шару і вести нові налашту-

вання або зовсім його видалити коригувальний шар. Також є можливість засто-

сувати корекцію відразу до всіх шарів, що розташовані під коригувальним [1, 2, 

6, 7, 19, 20]. Для порівняння, щоб можна було редагувати корекцію, що викли-

кана через меню Image → Adjustments, її необхідно застосовувати до шару, який 

перетворений у смарт-об’єкт. 

Однак, слід зауважити, що у списку Image → Adjustments є також інші ко-

рекції, які у цьому розділі не будуть розглянуті. 
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6.2.Практичні завдання 

 

У цьому  підрозділі  освоюємо  принципи роботи та призначення коригу-

вальних шарів. Працюємо з корекцією кольору (рис. 6.3). 

 

 

Рис. 6.3. Результати роботи коригувальних шарів 

 

6.2.1. Коригувальний шар Curves (Криві) 

1. Відкриваємо зображення «BMW.jpg» і створюємо коригувальний шар 

Curves (Криві) (рис. 6.4). 

 

 

Рис. 6.4. Коригувальний шар Криві 
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2. У вікні налаштування шару Криві бачимо криву (рис.6.5), яка в початко-

вому положенні виглядає як пряма з двома повзунками на чорно-білому градіє-

нті. Сама гістограма відображає кількість пікселів різної світлості, які присутні 

в зображенні [1, 2, 6, 7, 20, 21]. Стрілками умовно позначені три області на гра-

дієнтній стрічці. Стрілка в лівому кутку вказує на найтемніші пікселі (тіні), стрі-

лка посередині вказує на півтони, і крайня права стрілка показує на область, де 

знаходяться найсвітліші пікселі (світла). Як видно з гистограми, на вихідному 

зображенні повністю відсутні пікселі з найменшою світлістю (чорні). 

 

 

Рис. 6.5. Вихідна гістограма 

 

3. Горизонтальний градієнт відображає вихідні значення світлості (Input), 

тобто ті, які ми будемо змінювати, а вертикальний – результуючі (Output), тобто 

ті, які ми отримаємо після зміни. Крива слугує для того, щоб візуально можна 

було змінити проекцію старої точки світлості на нову (рис. 6.6). Гистограма по-

казує, що результуюче значення на 59 одиниць більше вихідного і при цьому 

проекція точки знаходиться в півтонах. Це означає, що зображення стало світлі-

шим у сірих ділянках. 
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Рис. 6.6. Умовні значення вихідних і результуючих даних 

 

4. Повзунки визначають в якому діапазоні світлості буде знаходитися то-

чка чорного і точка білого. На прикладі видно, що в гістограмі відсутні повністю 

темні пікселі, це робить зображення менш контрастним. Скидаємо настройки, 

натиснувши на Reset . Додаємо вікно гістограми: Window → Histogram. З пе-

ретягуванням чорного повзунка до межі початку пікселів, тіні стають темнішими 

і в доданому вікні гістограми, ми бачимо, що вихідна гістограма розтягується за 

шириною (рис. 6.7). Тепер на зображенні є справжні тіні з чорним кольором. За 

таким же принципом працює і правий повзунок. 

 

 

Рис. 6.7. Відображення на гістограми кількості пікселів 
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5. Натискаємо Reset . Піпетки з трьома різними пігментами слугують 

для напівавтоматичної тонової та колірної корекції. Обираємо чорну піпетку і 

натискаємо по найтемнішій області зображення (ця ділянка та інші з таким же 

рівнем яскравості зафарбуються чорним кольором). За таким же принципом оби-

раємо білу область для білої піпетки і сіру для сірої піпетки (рис. 6.8). Викорис-

товуючи кольори за замовчуванням (чорний, сірий, білий), ми можемо налашто-

вувати тільки тоновий баланс, але щоб перейти до корекції кольору, необхідно 

двічі натиснути на піпетку з потрібною яскравістю та у вікні Color Picker вибрати 

колір, який ми хотіли б посилить у тінях, півтонах або в світлих областях. Нала-

штовуємо тільки тоновий баланс. 

 

 

Рис. 6.8. Тонова корекція за рахунок піпеток 

 

6. Інструмент коригування «На зображенні»  дуже корисний при ви-

значенні конкретних ділянок для корекції безпосередньо на самому зображенні, 

а не на гістограмі. Цей інструмент активний при обраному режимі редагування 

точок з метою зміни кривої . 

Натискаємо Reset . У режимі прямої корекції проводячи курсором по зобра-

женню можна побачити, що на прямій в формі кружечка відображається поточ-

ний стан курсора в області певної світлості. Клікаємо по темній області і, утри-

муючи курсор, тягнемо вниз (рис. 6.9.). Все зображення надто затемнилося, отже, 



6. ТОНОВА ТА КОЛІРНА КОРЕКЦІЯ ЗОБРАЖЕНЬ 

 

116 

 

потрібно підняти яскравість світлих тонів та/або півтонів. Для цього наводимо 

курсор на світлу область і тягнемо вгору. У результаті крива прийняла класичну 

S-подібну форму, яка використовується для налаштування контрасту. 

 

 

Рис. 6.9. Робота інструменту «На зображені» 

 

7. Рисування з метою зміни кривої . Цей інструмент передбачає прори-

совування кривої самостійно її згладжування за допомогою інструменту округ-

лення числових значень кривої  (рис. 6.10). Щоб закріпити принцип роботи, 

нарисуємо S-подібну криву і декілька разів округлимо її.  цей знак означає, 

що відображається гістограма, яка збережена у кеш-пам’яті і вона може відріз-

нятись від реальної. Щоб побачити реальну просто тиснемо на значок. Зберіга-

ємо зображення у форматах .psd і .jpg. 

 

 

Рис. 6.10. Додаткові інструменти для побудови кривої 
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8. Поки що ми працювали з композитним каналом – це сукупність черво-

ного, зеленого і синього кольорів, з яких складається будь-яке зображення в ци-

фровому просторі. У цьому режимі можна працювати тільки з тоновою корек-

цією, тобто налаштовувати лише контраст, точки чорного і білого, та яскравість 

окремих ділянок. Тепер спробуємо налаштовувати колір, використовуючи кож-

ний колірний канал окремо. Відкриваємо зображення «Motorcycle.jpg» і створю-

ємо коригувальний шар Криві (рис. 6.11). Недоліком зображення є жовта імла на 

всьому фото. Наше завдання – привести колір до природного вигляду і трохи 

збільшити контраст. 

 

 

Рис. 6.11. Додавання коригувального шару Криві 

 

9. Потрібно знизити вплив жовтого кольору на всьому зображенні, але як 

це зробити, не маючи жовтого каналу? Згадуємо колірне коло і кольори, які є 

протилежними основним (рис. 6.12). Протилежний жовтому – синій, тому збіль-

шуючи його вплив на фото, ми знижуємо вплив жовтого. 

 

 

Рис. 6.12. Протилежні кольори 
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10. Щоб виставити більш щільну сітку, утримуючи Alt, клікаємо по гісто-

грамі. Переходимо до каналу Blue та підвищуємо значення світлості цього ко-

льору в світлих ділянках та півтонах (рис. 6.13). 

 

 

Рис. 6.13. Налаштування синього каналу 

 

11. Також зменшуємо значення червоного в світлих ділянках (рис. 6.14), 

щоб хмари на зображенні набули сіро білого кольору. 

 

 

Рис. 6.14. Налаштування червоного каналу 
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12. Зменшуємо значення зеленого каналу в півтонах (рис. 6.15), щоб поз-

бавиться зеленуватого відтінку на мотоциклі. 

 

 

Рис. 6.15. Налаштування зеленого каналу 

 

13. Переходимо на композитний канал і працюємо з контрастом (рис. 6.16). 

Знижуємо значення точки білого (це яскраві хмари в центрі) і затемнюємо тіні 

від мотоцикла, роблячи акцент на передній план. Зберігаємо відредаговане зо-

браження в форматах .psd і .jpg. 

 

 

Рис. 6.16. Налаштування композитного каналу 
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14. Криві мають велику популярність серед професіоналів. Використову-

ючи лише один коригувальний шар, можна провести повну тонову та колірну 

корекцію нескладного зображення, з можливістю взаємодіяти з кожною пробле-

мною ділянкою окремо (рис. 6.17). 

 

 

Рис. 6.17. Колірна та тонова корекція за допомогою коригувального шару Криві 

 

6.2.2. Коригувальний шар Levels (Рівні) 

1. Наступний не менше поширений коригувальний шар Levels (Рівні). 

Якщо є досвід роботи з кривими, то зрозуміти принцип роботи рівнів досить не-

складно. Рівні, так само, як і криві, призначені для тонової та колірної корекції, 

але відмінність у тому, що за допомогою рівнів не можна працювати з якоюсь 

локальною ділянкою зображення [1, 2, 6, 7, 20, 22]. Розглянемо роботу з рівнями 

на прикладі зображення «Night city.jpg» (рис. 6.18).  

 

 

Рис. 6.18. Вихідне зображення 
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Створимо коригувальний шар Levels (Рівні) (рис. 6.19). 

 

 

Рис. 6.19. Створення коригувального шару Рівні 

 

2. Переміщення сірого повзунка вправо тягне за собою зменшення світло-

сті півтонів – вліво збільшення. Білий і чорний повзунки працюють так, як у Кри-

вих. Вихідні значення (рис. 6.20), діють за тим же алгоритмом, що і вихідні зна-

чення в Кривих. Піднімаючи ліву опорну точку кривої, ми збільшуємо світлість, 

так само, як якщо б ми потягнули лівий повзунок вихідних значень рівнів вправо. 

 

    

Рис. 6.20. Проведення паралелі між коригувальними шарами Рівні та Криві 
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3. Далі потрібно позбутися помаранчевого відтінку і підвищити контраст-

ність всього зображення. Помаранчевий утворюється шляхом змішування жов-

того і червоного, тому потрібно підвищити значення синього, щоб прибрати жо-

втий і знизити значення червоного. Переходимо в червоний канал і знижуємо 

його вплив, пересуваючи чорний повзунок вхідних значень вправо. Так само зни-

жуємо вплив червоного в світлих областях. Для цього пересуваємо білий повзу-

нок вихідних значень вліво. І щоб знизити інтенсивність червоного в півтонах, 

рухаємо сірий повзунок вправо (рис. 6.21). 

 

 

Рис. 6.21. Налаштування червоного каналу 

 

4. Картина перенаситилася зеленими тонами, тому переходимо до зеленого 

каналу і знижуємо його вплив у тінях, півтонах і у світлих областях (рис. 6.22). 

 

 

Рис. 6.22. Налаштування зеленого каналу 
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5. Це вже більше схоже на нічне місто, але тепер на передній план виходять 

сині кольори. Переходимо до синього каналу і знижуємо його вплив у тінях і 

світлих ділянках (рис. 6.23). 

 

 

Рис. 6.23. Налаштування синього каналу 

 

6. Залишився останній штрих – яскравість/контраст. Переходимо до ком-

позитного каналу і переміщаємо точку білого вліво, тим самим збільшуючи яск-

равість світлих ділянок. Пересуваємо точку чорного вліво, щоб затемнити небо і 

злегка збільшуємо світлість півтонів (рис. 6.24). 

 

 

Рис. 6.24. Налаштування композитного каналу 
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7. У цій ситуації важливо зберегти основні деталі (силуети будівель, лінію 

горизонту, світіння нічних вогнів) і позбутися небажаних відтінків (помаранче-

вий) на всьому зображенні (рис. 6.25). Це можна було вирішити, використовуючи 

лише Криві, але в такому випадку ми б не задіяли весь функціонал цього інстру-

менту. 

 

 

Рис. 6.25. Порівняння вихідного та результуючого зображення 

 

6.2.3. Коригувальні шари Brightness/Contrast (Яскравість/Контраст) і 

Exposure (Експозиція) 

1. До тонових корекцій належать також коригувальні шари 

Brightness/Contrast (Яскравість/Контраст) і Exposure (Експозиція) [1,2,6,7,20]. 

Яскравість/Контраст розглянемо пізніше, а зараз відкриваємо «Coffee.jpg» (рис. 

6.26) і додаємо коригувальний шар Exposure (рис. 6.27). Повзунок експозиції ре-

гулює яскравість світлих ділянок, мінімально зачіпаючи темні. Повзунок Offset 

(Зсув) коригує півтони і тіні, мінімально зачіпаючи світлі ділянки. Повзунок 

Gamma Correction (Корекція гами) відповідає за спотворення яскравості ахрома-

тичних кольорів. 

 

Рис. 6.26. Вихідне зображення 
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Рис. 6.27. Створення коригуючого шару Експозиція 

 

2. Щоб надати об’єму передньому плану, знижуємо значення експозиції та 

знижуємо зсув. І підтягуємо освітленість півтонів, трохи піднімаючи значення 

гами (рис. 6.28). 

 

Рис. 6.28. Налаштування коригуючого шару Експозиція 

 

3. Необхідно знайти баланс між експозицією і зсувом, бо можливість реда-

гування тільки світлих і тільки темних ділянок може зробити зображення надмі-

рно контрастним (рис. 6.29). 

 

 

Рис. 6.29. Порівняння вихідного і результуючого зображень 
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6.2.4. Коригувальний шар Vibrance (Соковитість) 

Розглянемо роботу коригувальних шарів, які орієнтовані на роботу з ко-

льором і насиченістю [1, 2, 6, 7, 20]. 

1. Відкриваємо зображення «Castle.jpg». Зображення досить бліде, тому в 

першу чергу будемо працювати з насиченістю. Додаємо коригувальний шар 

Vibrance (Соковитість) (рис. 6.30). Однойменний повзунок відповідає за регулю-

вання насиченості вже насичених областей, тобто це більш вибіркова корекція, а 

повзунок Saturation (Насиченість) відповідає за збільшення насиченості рівномі-

рно на всьому зображенні. 

 

 

Рис. 6.30. Створення коригуючого шару Соковитість 

 

2. У нашому випадку є сенс скористатися двома параметрами і підвищити 

їх значення (рис. 6.31). 

 

 

Рис. 6.31. Налаштування шару Соковитість 
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3. Завдяки збільшенню насиченості зображення стало більш контрастним. Ско-

ристаємося ще й коригувальним шаром Brightness/Contrast (Яскравість/Конт-

раст). Збалансуємо контрастність композиції знизивши яскравість і підвищивши 

контраст (рис. 6.32). Команда Use Legacy (Використовувати попередні) відсікає 

найяскравіші і найтемніші ділянки зображення, тому її використання тут неба-

жане. 

4. Потрібно трохи підвищити яскравість точки чорного, щоб тінь від паго-

рба не вважалася великою чорною плямою. Додаємо ще один шар 

Brightness/Contrast (Яскравість/Контраст), інвертуємо маску, натиснувши Ctrl + I 

і, вибравши білий м’який пензель, працюючи на шарі-масці, фарбуємо тіньову 

область зображення (рис. 6.33) 

 

 

Рис. 6.32. Налаштування яскравості та контрасту Рис. 6.33. Коригування тіні від холма 

 

Принцип роботи шар-маски – білий колір проявляє накладену корек-

цію/ефект/зображення/колір, чорний – приховує). По закінченню піднімаємо 

значення яскравості на значення 104. Зберігаємо в форматах .psd і .jpg. Таким 
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чином, без втрати контрастної складової можна надати нового вигляду одино-

кому сірому замку (рис. 6.34). 

 

 

Рис. 6.34. Порівняння вихідного та відредагованого зображень 

 

6.2.5. Коригувальний шар Color Balance (Кольоровий баланс) 

1. Наступний коригувальний шар Color Balance (Баланс кольорів). Відкри-

ваємо зображення «Window view.jpg» і додаємо коригувальний шар Color 

Balance (рис. 6.35). Спробуємо надати  зображенню більш природних кольорів. 

 

 

Рис. 6.35. Створення коригувального шару Баланс кольорів 
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2. Інструмент дозволяє легко налаштовувати колір шляхом змішування пе-

рвинних і вторинних кольорів у тінях, півтонах і світлих ділянках. Залишаємо 

прапорець на пункті Preserve Luminosity (Зберегти світіння) для того, щоб при 

змішуванні кольорів не змінювалося їх світіння і зберігався тоновий баланс зо-

браження. Працюємо у півтонах. Знижуємо вплив синього, поступаючись місцем 

жовто-зеленому, і компенсуємо зелений відтінок зменшенням впливу зеленого 

(рис. 6.36). Так само додаємо червоного, щоб знизити вплив синьо-зеленого. 

 

 

Рис. 6.36. Налаштування вмісту кольорів у півтонах 

 

3. У світлих ділянках повторюємо ті ж операції, але вже з меншим впливом 

вторинних кольорів (рис. 6.37). 

 

 

Рис. 6.37. Налаштування вмісту кольорів у світлах 



6. ТОНОВА ТА КОЛІРНА КОРЕКЦІЯ ЗОБРАЖЕНЬ 

 

130 

 

4. Для того щоб підкреслити більш чіткі висотки на передньому плані, до-

даємо коригувальний шар Brightness/Contrast. Заливаємо шар-маску чорно-білим 

лінійним градієнтом, приховуючи небо і залишаючи для корекції лише будівлі 

на передньому плані. Підвищуємо значення яскравості до 114 (рис. 6.38). 

 

 

Рис. 6.38. Корекція яскравості 

 

5. Зображення набуло природного вигляду і, за рахунок освітлення ниж-

ньої його частини був зроблений акцент на передній план (рис. 6.39). 

 

 

Рис. 6.39. Порівняння вихідного та відредагованого зображень 
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6.2.6. Коригувальний шар Hue/Saturation (Кольоровий тон/Насиченість) 

1. Шар (Тон/Насиченість) вже відомий з розділу з виділенням кольорового 

діапазону. Але є безліч випадків, коли можна обійтися налаштуванням одного 

лише коригувального шару [1, 2, 6, 7, 20, 23]. Відкриваємо зображення 

«Lamborghini.jpg», створюємо коригувальний шар Hue/Saturation (рис. 6.40). 

 

 

Рис. 6.40. Створення коригувального шару Колірний тон/Насиченість 

 

2. Щоб вибрати кольоровий діапазон автоматично, переходимо в режим 

прямої корекції і клікаємо по авто на фото. Вибралися сині тони. Стрілка вказує 

на обраний діапазон на паралельних градієнтах з кольоровим спектром (рис. 

6.41). Верхній демонструє вихідний колірний діапазон, нижній – змінений, як 

вхідні і вихідні значення у Кривих і Рівнях. Colorize (Тонування) передбачає ро-

боту з тоном (у вигляді напівпрозорої плівки одного кольору, яку раніш приби-

рали на фото з мотоциклом) усього зображення. На цьому кроці немає необхід-

ності в тонуванні. 

3. Змінюємо колір, пересуваючи повзунок Hue (Тон). Якщо не всі кольори 

були захоплені з першої спроби, то є два способи виправити це. Або вибираємо 

піпетку  і натискаємо на залишках фрагментів змінного кольору, або розсову-

ємо повзунки між паралельними градієнтами, захоплюючи додаткові відтінки 
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(рис. 6.42). Для того щоб зробити колір більш реалістичним, підсилюємо насиче-

ність і трохи зменшуємо яскравість. Колір обираємо самостійно. Зверніть увагу 

на результуючий градієнт. 

 

 

Рис. 6.41. Обраний діапазон кольорів 

 

 

Рис. 6.42. Налаштування червоного каналу 
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4. Використовуючи Криві або Рівні, підтягуємо контраст зображення (рис. 

6.43). Зберігаємо в форматах .psd і .jpg. 

 

 

Рис. 6.43. Порівняння вихідного та відредагованого зображень 

 

6.2.7. Коригувальний шар Channel Mixer (Мікшування каналів) 

1. Наступний коригувальний шар, який буде розглянуто, – Channel Mixer 

(Мікшування каналів). Цей шар дозволяє контролювати взаємодію трьох колір-

них каналів: червоного, зеленого і синього (рис. 6.44). Розберемо детально на 

прикладі зображення «Yacht.jpg». 

 

 

Рис. 6.44. Створення коригувального шару Змішувач каналів 
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2. На відміну від коригувального шару Колірний баланс, цей не працює з 

кольором у світлих ділянках, півтонах і тінях. Вибравши червоний канал у меню, 

що випадає, Output Channel (Вихідний канал), бачимо три повзунки, які відпові-

дають не за інтенсивність червоного, зеленого і синього у відповідних областях 

зображення, а за вміст червоного кольору в червоних, зелених і синіх ділянках 

зображення. За аналогією працюють синій і зелений канали. Повзунок Constant 

(Константа) відповідає за збільшення/зменшення відсоткової складової відразу 

трьох колірних областей. При пересуванні цього повзунка на невеликий крок, 

можна досягти ефекту тонування. Оскільки небо має трохи зеленуватий відтінок 

з боку заходу, збільшуємо вплив червоного в зелених ділянках фото (рис. 6.45). 

 

 

Рис. 6.45. Налаштування червоного каналу 

 

3. Переходимо до синього каналу і знижуємо вплив синього в червоному 

діапазоні (рис. 6.46). На кольоровому колі протилежний колір синьому – жовтий, 

тому, зменшуючи вплив синього в червоних тонах, додаємо жовтого в область 

заходу. Жовтий змішується з червоним, який був доданий у попередньому кроці, 

і результуючим кольором стає помаранчевий. Треба звернути увагу на значення 
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параметра Total (Всього). Значення цього параметра допомагає відстежити кіль-

кість обраного кольору на всьому зображенні. Якщо значення 100 % – зміни не 

були внесені, якщо більше 100 % – то працюємо з надлишком кольору, якщо 

менше 100 % – то «відкидається» частина наявного. 

 

 

Рис. 6.46. Налаштування синього каналу 

 

4. Переходимо до зеленого каналу і зменшуємо вплив зеленого в синіх то-

нах, щоб прибрати зелений відтінок з світіння вище лінії горизонту (рис. 6.47). 

 

 

Рис. 6.47. Налаштування зеленого каналу 
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5. Насиченість помаранчевого збільшилася, це означає, що сонце знахо-

диться на горизонті, і тому яскравість всього зображення повинна бути трохи 

вище поточної  (рис. 6.48). Додаємо коригувальний шар Яскравість/Контраст і 

підвищуємо яскравість на значення 46. 

 

 

Рис. 6.48. Порівняння вихідного та відредагованого зображень 

 

6.2.7. Коригувальний шар Black & White (Чорно-біле) 

1. Коригувальний шар Black & White своєю назвою говорить про майбут-

ній результат [1, 2, 6, 7, 20]. Пояснимо принцип роботи. Відкриваємо зображення 

«Couple.jpg», створюємо коригувальний шар Black & White (рис. 6.49). 

 

 

Рис. 6.49. Створення коригувального шару Black & White 
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2. Усі правила змішування кольорів зберігаються. Керуючись цим, а також 

тим, що кожному з повзунків відповідає яскравість певної ділянки пікселів на 

зображенні, надаємо зображенню глибину. Вибираємо інструмент «На зобра-

женні» і, помістивши курсор на темну ділянку у правому верхньому куті, тяг-

немо вліво. Тим самим затемнюємо яскравість синього кольору, який на зобра-

женні, як і всі кольори, інтерпретується в градаціях сірого. За аналогією підви-

щуємо значення жовтого і червоного, щоб трохи висвітлити обличчя дівчини. 

Пурпурний і синій домінують у тінях. Оскільки синій був уже відкоригований, 

трохи знижуємо пурпурний (рис. 6.50). 

 

 

Рис. 6.50. Налаштування окремих ділянок зображення  

 

3. Повзунки зеленого і синьо-зеленого не чіпаємо, оскільки на фото цих 

тонів мінімальна кількість і їх корекція, у цьому випадку, не спричинить ніяких 

істотних змін. Підключаємо Tint (Відтінок), щоб надати зображенню ретро стиль 

(рис. 6.51). Колір, який був використаний: #e1cfa7. 
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Рис. 6.51. Порівняння вихідного та відредагованого зображень 

 

6.2.8. Коригувальні шари Photo Filter (Фотофільтр) та Сolor search  

(Пошук кольору) 

1. Шар Photo Filter (Фотофільтр) імітує техніку, коли об’єктив камери пе-

рекривається кольоровим фільтром, який змінює колірний баланс і колірну тем-

пературу світла, що проходить крізь об’єктив і впливає на фотоплівку [1, 2, 6, 7, 

20]. Оскільки його освоєння не вимагає великих зусиль, скомбінуємо цей шар із 

шаром Color Lookup (Пошук кольору) (рис. 6.52). Останній дозволяє коригувати 

колір зображення, налаштовуючи світлість, колірний діапазон, а також нейтралі-

зувати відтінок кольору. Відкриваємо зображення «Seafront.jpg», додаємо кори-

гувальні шари. 

 

 

Рис. 6.52. Створення коригувального шару Фотофільтр та Пошук кольору 
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2. У властивостях фотофільтру обираємо колір: #ff0042. Для цього переми-

каємося з запропонованих фільтрів на Color (Колір) та збільшуємо Density (Щіль-

ність) до 86 % (рис. 6.53). Щоб не втратити тоновий баланс, включаємо або за-

лишаємо включеним Preserve Luminosity (Зберегти світіння). 

 

 

Рис. 6.53. Налаштування шару Фотофільтр 

 

3. Налаштовуємо коригувальний шар Сolor search (Пошук кольору). Із за-

пропонованих пресетів обираємо 3DLUT File (3D – працює з трьома каналами 

зображення, LUT (Lookup table) – таблиці пошуку кольору, нерідко використо-

вуються в кіноіндустрії для створення звичних для нас кольорових контрастів). 

Два інших із списку шаблонів Abstract (Абстрактний) і Device Link (Зв’язок з 

пристроєм) надають шаблони, які самостійно використовуються не часто. Dither 

(Дизеринг) додає легкий шум зображення. Вибираємо HorrorBlue.3DL, виділя-

ємо два коригувальних шари, групуємо (Ctrl + G) і знижуємо непрозорість до 70 

%, як показано на рисунку 6.54. 

 

 

Рис. 6.54. Налаштування шару Пошук кольору 
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4. Не треба намагатися перенаситити фото зайвим контрастом або вібра-

цією невиразних відтінків. Насправді, навколо існує дуже мало об’єктів, які міс-

тять у собі максимальну інтенсивність якогось кольору, тому іноді достатньо 

лише змінити відтінок, випромінюваного сонцем світла, і зображення відразу 

знайде тишу і рівновагу (рис. 6.55). 

 

 

Рис. 6.55. Порівняння вихідного та відредагованого зображень 

 

6.2.9. Коригувальні шари заливки 

Найпростіша група коригувальних шарів – це заливні. До неї входить Solid 

Color (Колір), Gradient (Градієнт) і Pattern (Візерунок) (рис. 6.56). Замість того 

щоб створювати новий шар та інструментом заливка, заливати документ без мо-

жливості подальшої корекції, ці коригувальні шари спрощують цю послідовність 

дій до одного кліку [1, 2, 6, 7, 19]. 

 

 

Рис. 6.56. Група коригувальних шарів заливки 
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6.2.10. Коригувальні шари непрямої корекції 

1. Наступна група коригувальних шарів використовується для непрямої 

корекції,  тобто  без використання режимів накладання, масок або додаткових 

фільтрів [1, 2, 6, 7, 20]. Вони досить рідко знаходять застосування у простій об-

робці (рис.6.57). 

 

Рис. 6.57. Група коригувальний шарів для непрямої корекції 

 

2. Нижче подані приклади і принцип роботи кожного з цих шарів на прик-

ладі рисунка 6.58. 

 

 

Рис. 6.58. Вихідне зображення 

 

3. Коригування за допомогою Invert (Інверсія) змінює кольори зображення 

на протилежні (рис. 6.59). Можна використовувати її в процесі створення крайо-

вої маски для посилення різкості (на межі об’єктів) та застосування інших кори-

гувань до виділених ділянок зображення. 
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Рис. 6.59. Застосування шару Інверсія 

 

4. Коригування Posterize (пастеризувати) дозволяє вказати число тональ-

них рівнів (або значень яскравості) для кожного каналу в зображенні, а потім 

прив’язує пікселі зображення до найближчого відповідного рівня (рис. 6.60). На-

приклад, якщо вибрати два тональних рівня для зображення в режимі RGB, це 

дасть шість кольорів: два для червоного, два для зеленого і два для синього ка-

налу. Це коригування підходить для створення особливих ефектів, наприклад ве-

ликих однотонних ділянок на фотографіях. Дія найбільш очевидна при змен-

шенні числа рівнів сірого на зображенні у відтінках сірого, але вона також дає 

цікаві результати на кольорових зображеннях. 

 

 

Рис. 6.60. Застосування шару Пастеризація  
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5. Коригування Threshold (Поріг) перетворює кольорові зображення і зо-

браження у відтінках сірого у дуже контрастні чорно-білі зображення (рис. 6.61). 

Можна вибрати як поріг певний рівень. Усі пікселі світліше цього порогового 

значення будуть перетворені в білі; всі пікселі темніше його – в чорні. 

 

 

Рис. 6.61. Застосування шару Поріг 

 

6. Коригування Gradient Map (Мапа градієнта) прив’язує еквівалент відті-

нків сірого на зображенні до кольорів певної градієнтної заливки (рис. 6.62). 

 

 

Рис. 6.62. Застосування шару Мапа градієнта 
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Якщо вказати, наприклад, двобарвну градієнтну заливку, то тіні на зображенні 

будуть прив’язані до однієї з кінцевих точок заливки, світлі ділянки – до іншої 

кінцевої точки, а середні тони – до градацій між ними. Dither (Дизеринг) додає 

випадковий шум, згладжує градієнтну заливку і зменшує ефект створення смуг. 

(Інверсія) змінює напрям градієнта на протилежний, при цьому градієнтна мапа 

перевертається. 

7. Selective Color (Вибіркове коригування кольору) – це техніка, яка засто-

совується висококласними сканерами і програмами поділу для зміни обсягу 

складових кольорів у кожному з основних колірних компонентів зображення. 

Можна вибірково змінити обсяг складеного кольору в будь-якому з основних ко-

льорів, не змінюючи інші основні кольори (рис. 6.63). 

 

 

Рис. 6.63. Параметри налаштування шару Selective Color 

 

Наприклад, вибіркове коригування кольору можна застосувати, щоб істотно зме-

ншити обсяг блакитного кольору в зеленому компоненті зображення, залиши-

вши блакитний у синьому компоненті в первісному обсязі. Relative (Відносно) 

Змінює поточний обсяг блакитного, пурпурного, жовтого або чорного кольору 

залежно від його відсоткового вмісту в загальному значенні кольору. Наприклад, 
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якщо обрати піксель, що містить 50 % пурпурового кольору, і додати до нього 

10 %, то до загального колірного значенням пікселя буде додано 5 % пурпурного 

(10 % від 50 % = 5 %). В результаті вийде піксель, що містить 55 % пурпурового 

кольору. Absolute (Абсолютно) Коригує колір в абсолютних значеннях. Напри-

клад, якщо обрати піксель, що містить 50 % пурпурового кольору, і додати 10 %, 

то в підсумку вийде піксель, що містить 60 % пурпурного. На відміну від мікшу-

вання каналів, цей шар більше підходить для роботи з кольором в окремих обла-

стях, 

 за рахунок того, що в ньому є можливість редагувати вміст кольорів не тільки в 

канал RGB, але і в CMY, а також у тінях, півтонах і в світлих ділянках. 

 

Запитання для самоконтролю 

 

1. Що таке гістограма і навіщо вона у Photoshop? 

2. Чи можна за допомогою Кривих зробити все те, що можна зробити за 

допомогою Рівнів? 

3. Для чого потрібен параметр Preserve Luminosity? 

4. Як застосовувати корекції, щоб була можливість їх редагування згодом? 

5. Який параметр регулює насиченість вже насичених ділянок зображення? 
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7. РОБОТА З ТЕКСТОМ 

 

7.1. Загальні поняття 

 

Графічний редактор Adobe Photoshop надає можливість користувачеві пра-

цювати не тільки із зображеннями, але і з текстовими складовими проєктів різ-

номанітного обсягу та спрямування. Арсенал засобів для роботи з текстом дозво-

ляє реалізовувати найсміливіші дизайнерські рішення, особливо в рекламній 

сфері при створенні акцидентних авторських заголовків, написів та ін. 

 

7.1.1. Основні параметри шрифтів 

1. Шрифт – це графічний рисунок накреслень букв і знаків, що становлять 

єдину стилістичну та композиційну систему, набір символів визначеного розміру 

і рисунка. 

2. Гарнітура – це родина шрифтів, які можуть відрізнятися зображенням, 

або кеглем, але незмінно однакові за характером рисунка і розроблені для вико-

ристання зазвичай разом (наприклад Adobe Garamond). 

3. Стиль шрифту – це варіант конкретного шрифту в гарнітурі. Зазвичай 

члени сімейства шрифтів, що мають у назві слово Roman або Plain (у різних гар-

нітурах по-різному), являють собою базовий шрифт, який може включати в себе 

різні стилі: звичайний, жирний, напівжирний, курсив і напівжирний курсив. 

Якщо в шрифті потрібний стиль відсутній, можна застосувати псевдостилі псев-

донапівжірний, псевдокурсив, надрядковий і підрядковий індекс, всі великі та 

капітель (рис. 7.1). 

4. Інтерліньяж – це вертикальний інтервал між рядками тексту. Для пря-

мого шрифту інтерліньяж вимірюється від базової лінії одного рядка тексту до 

базової лінії рядка, що розташований над нею.  

5. Базова лінія – це невидима лінія, за якою вирівнюється нижній край бі-

льшості букв.
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Рисунок 7.1. Вікно налаштувань параметрів шрифту: 

А – гарнітура; В – розмір шрифту; С – кернінг; D – вертикальний масштаб; Е – зсув базової 

лінії; F – стиль; G – лігатура; Н – мова; І – накреслення; J – інтерліньяж; К – трекінг; L – 

горизонтальний масштаб; М – колір; N – метод згладжування. 

 

6. Кернинг і трекінг. Кернинг – це збільшення або зменшення відстані між 

конкретними парами символів. Трекінг – це розширення або звуження інтервалу 

між символами у виділеному тексті або у всьому блоці тексту [1, 2 ,6, 25, 26]. 

 

7.1.2. Інструменти для роботи з текстом 

1. Horizontal Type Tool (Горизонтальний текст)  

2. Vertical Type Tool (Вертикальний текст)  

3. Vertical Type Mask Tool (Вертикальний текст-маска)  

4. Horizontal Type Mask Tool (Горизонтальний текст-маска)  

 

7.1.3. Операції над текстом 

1. Створення межі виділення тексту. При використанні інструментів «Го-

ризонтальний текст-маска» або «Вертикальний текст-маска» створюється виді-

лення за формою тексту. Виділення тексту з’являється на активному шарі і може 

бути переміщено, скопійовано, залите та обведено. 

2. Перетворення тексту в фігури При перетворенні тексту в фігуру текст 

заміщається шаром з векторною маскою. Її можна редагувати і застосовувати до 

шару різні стилі, але не можна редагувати символи в шарі як текст. 
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3. Деформація тексту та її скасування. Текст можна деформувати, щоб 

створити спеціальний ефект. Обраний стиль деформації є атрибутом текстового 

шару і може змінюватися. Параметри деформації надають повне керування оріє-

нтацією і перспективою ефекту деформації [27]. 

4. Растеризування текстового шару. Деякі команди і інструменти (засоби 

розмальовки та фільтри) для текстових шарів недоступні. Перед їх застосуван-

ням текст необхідно растеризувати що перетворює текстовий шар у звичайний і 

робить його текстовий вміст нередагованим [28]. 

5. Способи створення тексту такі. 

‒ Початок набору являє собою горизонтальний або вертикальний рядок те-

ксту, що починається в тому місці зображення, де активується курсор. 

‒ Тип абзацу для керування потоком символів використовує межу (горизо-

нтальну, або вертикальну). Введення тексту таким способом зручне тоді, коли 

потрібно створити кілька абзаців тексту (наприклад макет брошури). 

‒ Текст вздовж контуру розташовується уздовж краю відкритого або за-

критого контуру. Під час введення тексту горизонтально символи з’являються 

уздовж контуру перпендикулярно нижній лінії шрифту. Під час введення тексту 

по вертикалі символи з’являються уздовж контуру паралельно нижній лінії шри-

фту [29]. 

‒ Завдання вирівнювання. Вирівнювання тексту вліво – вирівнює текст 

вліво, залишаючи правий край абзацу нерівним. Вирівнювання тексту по центру 

– вирівнює текст по центру, залишаючи обидва краї абзацу нерівними. Вирівню-

вання тексту вправо – вирівнює текст вправо, залишаючи лівий край абзацу не-

рівним. 

‒ Вказівка вирівнювання для типу абзацу. Вирівнювання останнього рядка 

вліво – вирівнює всі рядки, крім останнього, який вирівнюється по лівій стороні. 

Вирівнювання останнього рядка по центру – останній рядок вирівнюється по 

центру. Вирівнювання останнього рядка вправо – останній рядок вирівнюється 
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по правій стороні. Повне вирівнювання – вирівнює всі рядки, включаючи й 

останній, який також вирівнюється. 

7.1.4. Стилі шарів 

‒ Drop Shadow (Тінь) – додає тінь, що відкидається вмістом шару. 

‒ Inner Shadow (Внутрішня тінь) – надає шару ефект «притопленого ка-

дру», додаючи до об’єктів тіні, що відкидаються тільки всередині меж шару. 

‒ Outer Glow and Inner Glow (Зовнішнє світіння і внутрішнє світіння) – до-

дає джерела світла, що розташовані зовні або всередині меж шару. 

‒ Bevel and Emboss (Тиснення) – додає до шару різні комбінації підсвічу-

вання та затінення. 

‒ Satin (Глянець) –додає внутрішнє затінення, додає глянсовий ефект. 

‒ Color, Gradient, and Pattern Overlay (Накладення кольору, градієнта, візе-

рунка) – заповнює вміст шару кольором, градієнтним колірним переходом або 

візерунком. 

‒ Stroke (Обведення) – додає обведення об’єкта поточного шару кольором, 

градієнтним колірним переходом або візерунком. Цей ефект особливо корисний 

при роботі з фігурами з різкими контурами, такими як текст. 

 

7.1.5. Параметри стилю шару 

‒ Attitude (Висота) – задає висоту джерела світла для ефекту «Тиснення». 

Значення 0 задає рівень поверхні, значення 90 – розташування прямо над шаром. 

‒ Angle (Кут) – задає кут, під яким освітлення падає на шар. Кут освітлення 

для ефектів «Тінь», «Внутрішня тінь» та «Глянець» може регулюватися за допо-

могою миші у вікні документа. 

‒ Anti-alias (Згладжування) – накладаються крайові пікселі контуру або ко-

нтуру глянцю. Цей параметр найбільш корисний при слабких тінях та складних 

контурах. 

‒ Blend Mode (Режим накладення) – визначає спосіб накладення стилю 

шару на нижні шари (вмикаючи або не вмикаючи активний шар). Наприклад, 
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внутрішня тінь накладається тільки на об’єкти активного шару, оскільки зазна-

чений ефект застосований до нього, в той час як звичайна тінь накладається 

тільки на шари, що розташовані нижче активного. У більшості випадків налаш-

тування за замовчуванням забезпечують найкращий результат застосування ефе-

ктів. 

‒ Choke (Стягнути) – стягує межі підкладки ефекту «Внутрішня тінь» або 

«Внутрішнє світіння» перед розмиванням. 

‒ Color (Колір) – задає колір тіні, світіння та підсвічування. Для вибору ко-

льору треба клікнути на його зразок. 

‒ Contour (Контур) –дозволяє створювати кільцеподібні прозорі ділянки в 

одноколірному світінні. При роботі з градієнтним світінням параметр дозволяє 

створювати різні варіанти чергування одноколірних та градієнтних зафарбова-

них ділянок. При роботі з ефектом «Тиснення» параметр дозволяє створювати 

складки, западини та вигини, що затінюються в процесі тиснення. При роботі з 

тінями параметр використовується для завдання ступеня ослаблення кольору. 

‒ Distance (Зсув) – задає дальність зміщення для ефекту «Тінь» або «Гля-

нець». Значення зсуву задається у вікні документа за допомогою миші. 

‒ Depth (Глибина) – задає глибину скоса. Також використовується для за-

вдання глибини візерунка. 

‒ Use Global Light (Глобальне освітлення) – параметр дозволяє задавати 

«головний» кут освітлення, який потім може використовуватися в усіх шарах, де 

застосовується ефект затінення: «Тінь», «Внутрішня тінь» або «Тиснення». При 

завданні для зазначених ефектів параметра «Глобальне освітлення» вводиться 

єдине значення кута освітлення, спільне для всіх ефектів. Будь-який інший 

ефект, для якого задається параметр «Використовувати загальне освітлення», ав-

томатично використовує це значення кута. 

‒ Gloss Contour (Контур глянцю) – надає шару вид глянцевого, металевого 

зображення. Параметр «Контур глянцю» застосовується після затінення скоса 

або тиснення. 
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‒ Gradient (Градієнт) – задає градієнт ефекту шару. Для відображення вікна 

«Редактор градієнтів» необхідно клацнути на градієнті або інвертованій стрілці 

та обирати градієнт у висхідній панелі. 

‒ Highlight or Shadows Mode (Режим підсвічування і затінення) – задає ре-

жим накладення підсвічування або тіні на ефекти тиснення. 

‒ Jitter (Коливання) – задає параметри накладення кольору і ступеню не-

прозорості градієнта. 

‒ Layer Knocks Out Drop Shadow (Шар вибиває тінь, що падає) – визначає 

параметри відображення тіні на напівпрозорому шарі. 

‒ Noise (Шум) – задає кількість випадкових елементів в області підсвічу-

вання або затінення. Значення вводиться в текстове поле або за допомогою пов-

зунка. 

‒ Opacity (Непрозорість) – задає ступінь непрозорості ефекту шару. Зна-

чення вводиться в текстове поле або за допомогою повзунка. 

‒ Pattern (Візерунок) – задає візерунок ефекту шару. 

‒ Position (Положення) – задає положення ефекту «Обведення». Можливі 

значення: «Зовні», «Всередині», «По центру». 

‒ Range (Діапазон) – задає фрагмент або діапазон світіння для контуру. 

‒ Size (Розмір) – задає радіус і рівень розмиття або розмір тіні. 

‒ Soften (Пом’якшення) – розмиває зображення, яке отримується після на-

кладення тіні, з метою усунення небажаних спотворень. 

‒ Source (Джерело) – визначає джерело внутрішнього світіння. Для розта-

шування джерела світіння в центрі вмісту шару виберіть значення «З центру», 

для розміщення джерела біля межі шару оберіть значення «На краях». 

‒ Spread (Розмах) – розширює межі підкладки ефекту перед розмиванням. 

‒ Style (Стиль) – задає стиль скосу: параметр «Внутрішній скіс» визначає 

створення скосу на внутрішніх межах вмісту шару; параметр «Зовнішній скіс» 

визначає створення скосу на зовнішніх межах вмісту шару; параметр «Тиснення» 

імітує тиснення вмісту шару щодо нижніх шарів; параметр «Контурне тиснення» 
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імітує ефект втискування країв шару в нижні шари; параметр «Обвідне тис-

нення» обмежує застосування ефекту тиснення шару межами поширення ефекту 

«Обведення». (Ефект «Обвідне тиснення» стає доступний тільки після застосу-

вання ефекту «Обведення».) 

‒ Technique (Метод) – ефект «Тиснення» має параметри «Плавний», «Жо-

рстке огранювання», «М’яке огранювання». Ефекти «Внутрішнє світіння» та 

«Зовнішнє світіння» мають параметри «М’який» та «Точний». «Плавний» трохи 

розмиває краї підкладки. Застосовується для всіх типів підкладки незалежно від 

ступеня розмиття її меж. При роботі з великими об’єктами деталізація дрібних 

ліній знижується. «Жорстке огранювання» використовує метод вимірювання від-

станей і застосовується при роботі зі згладженими фігурами на сильно обмеже-

них підкладках. Використання цього параметра в порівнянні з методом «Згла-

джений» забезпечує кращу деталізацію дрібних об’єктів. «М’який» здійснює ро-

змиття зображення. Застосовується для всіх типів підкладки незалежно від сту-

пеня розмиття її меж. Застосування параметра «М’який» при роботі з великими 

об’єктами знижує деталізацію дрібних ліній. «Точний» при завданні освітлення 

використовує метод вимірювання відстаней і застосовується при роботі зі згла-

дженими фігурами на сильно обмежених підкладках (наприклад, при роботі з те-

кстомТexture (Текстура) – застосовує текстуру. Для зміни розміру текстури ви-

користовується параметр «Масштаб». У разі якщо необхідно переміщати текс-

туру разом із шаром, треба активувати параметр «Зв’язати з шаром». Для інвер-

тування текстури використовується параметр «Інверсія». Параметр «Глибина» 

використовується для налаштування кута та напрямку (вгору або вниз) застосу-

вання текстури. Команда «Притягнути до початку» використовується для сумі-

щення початку координат зразка з початком координат документа (якщо пара-

метр «Зв’язати з шаром» неактивний) або для розміщення початку координат у 

лівому верхньому кутку шару (в разі, коли вибрано «Зв’язати з шаром») . Для 

розміщення текстури на шарі треба її просто перетягнути. 
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7.1.6. Зміна ефектів шару за допомогою контурів 

При створенні стилів шарів за замовленням для завдання меж зміни форми 

таких ефектів, як «Тінь», «Внутрішня тінь», «Внутрішнє світіння», «Зовнішнє 

світіння», «Тиснення» та «Глянець», використовуються контури. Наприклад, 

«Лінійний контур» ефекту «Тінь» завдає область тіньового лінійного переходу. 

Для створення унікального тіньового переходу використовується «Контур за за-

мовленням». Для вибору, відновлення, видалення та зміни параметрів перегляду 

контурів використовують панель, що розкривається, «Контури» та засіб «Керу-

вання зразками» [1, 2, 6, 7, 30]. 

 

7.2. Практичні завдання  

 

7.2.1.Основи роботи з текстом. Створення постеру 

Застосуємо фігуру як контейнер для тексту на прикладі розробки стиль-

ного постеру, який розповість історію відомої автомобільної марки ASTON 

MARTIN (рис. 7.2). 

 

 

Рис. 7.2. Бажаний результат роботи 
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1. Відкриваємо зображення «Car.jpg» та, обравши інструмент Crop Tool 

(Обрізання)  (C), перетягуємо лівий край рамки, що утворилася, до значення 

в 1000 px (це ширина фото, яка залишиться після кадрування). Правий край пе-

ресуваємо до значення 902px і тиснемо Enter (рис. 7.3). 

 

 

Рисунок 7.3. Кадрування зображення авто 

 

2. Додаємо коригувальні шари Curves, Gradient Fill та Color Lookup. Кри-

вими знижуємо світлість тіней. Вертикальним градієнтом на все зображення, від 

прозорого (зверху) до кольору # 160e06 (знизу), затемнюємо фон, щоб виділити 

майбутні написи (рис. 7.4). У вікні пошуку кольору обираємо режим 

filmstock_50.3dl (рис .7.5). 

 

 

Рис. 7.4. Зниження світлості тіней та накладення градієнта 
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Рис. 7.5. Обрання режиму filmstock_50.3dl 

 

3. Непрозорість шару Color Lookup знижуємо до 53 %. Режим накладення 

для шару з градієнтом обираємо Multiply (Множення) (рис. 7.6). 

 

Рис. 7.6. Налаштування прозорості та режиму накладення шару Color Lookup 

 

4. Виставляємо вертикальну напрямну на позначку в 852px. Створюємо 

майбутній контейнер для тексту. Обираємо Rectangle Tool  (U) і рисуємо пря-

мокутник у режимі Shape (рис. 7.7). Вирівнюємо прямокутник по колесу та даху 
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автомобіля. Прибираємо заливку, залишаючи тонкий тимчасовий контур, щоб 

бачити де буде розміщений текст. 

 

Рис. 7.7. Прямокутник-контейнер для розміщення тексту 

 

5. Інструментом  Add Anchor Point Tool додаємо 6 опорних точок лівій 

стороні прямокутника. Інструментом Direct Selection Tool  (A) вигинаємо 

криву по контуру авто, зберігаючи однакову відстань від нього (рис. 7.8). 

 

 

Рис. 7.8. Створення форми контейнеру для розміщення тексту 
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6. Відкриваємо вікно Paragraph и Character: Window → Character, Window 

→ Paragraph (рис. 7.9). 

 

   

Рис. 7.9. Вікна редагування тексту Paragraph и Character 

 

7. Обираємо інструмент Horizontal Type Text (Горизонтальний текст)  

(T). На обраному шарі з контейнером розміщуємо курсор в область прямокут-

ника і клікаємо ЛКМ (ліва клавіша миші). Вставляємо такий текст (рис. 7.10): 

 

Рис. 7.10. Текстовий вміст постеру 

 



7.РОБОТА З ТЕКСТОМ 

 

158 

 

8. У вікні Character обираємо гарнітуру шрифту SF UI Display, стиль 

Ultralight, розмір 16pt, колір: # ffd6a6. Цей шрифт є в теці «Шрифти» . Розбиваємо 

текст на абзаци та обираємо рівномірне вирівнювання по лівому краю . 

Верхню сторону фігури-контейнера можна опустити для рівномірного розподілу 

тексту по всій площі фігури. Для цього, залишаючись на текстовому шарі, виби-

раємо інструмент Direct Selection Tool  (A), виділяємо одразу дві верхні опо-

рні точки, опускаємо їх вниз, доки текст не буде розподілено як на рис. 7.11. 

 

 

Рис. 7.11. Надання тексту форми контейнеру 

 

9. Непрозорість текстового шару знижуємо до 85 %. Видаляємо шар з фі-

гурою. Змінити форму контейнера можна буде, працюючи з текстовим шаром 

(рис. 7.12). 

 

Рис. 7.12. Видалення шару з фігурою та зниження непрозорості текстового шару 
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10.  Створюємо коригувальний шар з лінійним чорно-прозорим градієн-

том. Режим накладення – Multiply (Множення) (рис. 7.13). 

 

 

Рис. 7.13. Параметри градієнтного шару 

 

11.  Додаємо ще одну напрямну на відстані 50px від краю зображення. 

Створюємо текстовий шар, в якому розміщуємо брендовий слоган «ASTON 

MARTIN – POWER, BEAUTY AND SOUL». Гарнітура шрифту Optima Cyr, стиль 

Regular, розмір 19,58 pt, колір # b07b3b. Шрифт також є в теці Шрифти. У вікні 

Character збільшуємо відстань між буквами  до 630 (рис. 7.14). 

 

 

Рис. 7.14. Налаштування параметрів шрифту та додавання слогану 
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12.  Додаємо напис «AMBITIOUS AND INNOVATIVE» та вирівнюємо по 

першій літері основного тексту. Гарнітура шрифту SF UI Display, стиль Ultralight, 

розмір 23,37 pt, колір # ffd6a6. Відстань між символами  300 (рис. 7.15). 

 

 

Рис. 7.15. Налаштування параметрів шрифту та додавання підзаголовка 

 

13.  Додаємо коригувальний шар «Заливання кольором», щоб текст за ра-

хунок загального відтінку природніше поєднувався з тоном зображення. Колір # 

9b764a, режим накладення Multiply, Непрозорість шару 27 % (рис. 7.16). 

 

 

Рис. 7.16. Додавання та налаштування коригувального шару «Заливання кольором» 
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14. Трохи висвітлюємо напівтони та світла за допомогою коригувального 

шару «Криві» (рис. 7.17). 

 

 

Рис. 7.17. Додавання коригувального шару «Криві» 

 

15. Додаємо підкладку. Відкриваємо зображення «Nowadays.jpg». Підлаш-

товуємо під розміри документа. Додаємо маску зображенню та заливаємо її чо-

рно-білим градієнтом, щоб приховати нижню частину фото (рис. 7.18). 

 

 

 Рис. 7.18. Додавання підкладки та маскування її частини 

 

16. Копіюємо коригувальні шари «Пошук кольору» та «Заливка кольо-

ром». Застосовуємо відсічну маску до доданого зображення. Непрозорість обох 

шарів 100 % (рис. 7.19). 
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Рис. 7.19. Налаштування кольорового балансу 

 

17. Додаємо заголовок, використовуючи два текстових шари. Напис «The 

history of» з такити настройками: Гарнітура шрифту Trajan Pro, стиль: Regular, 

розмір 42,5pt, колір: # e2b956. Відстань між символами 45. Напис «ASTON 

MARTIN» має налаштування: гарнітура шрифту Trajan Pro, стиль Regular, розмір 

87,76 pt, колір # e2b956. До шару ASTON MARTIN додаємо маску і заливаємо 

чорно-білим градієнтом, як на рисунку 7.20. 

 

 

Рис. 7.20. Додавання заголовка 
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18. Останній штрих. Додаємо тінь під літерами. Створюємо порожній шар. 

Вибираємо еліптичне виділення. Вибираємо чорний фоновий колір. Створюємо 

виділення у вигляді тонкого еліпса та поєднанням клавіш Ctrl + Delete, заливаємо 

виділення. Знімаємо виділення і розмиваємо еліпс методом розмивання за Га-

уссом (Filter → Blur → Gaussian Blur). Радіус розмиття 4 px, непрозорість шару 

35 % (рис. 7.21). Зберігаємо документ у форматах «.psd» та «.jpg». 

 

 

Рис. 7.21. Додавання тіні під літерами 

 

7.2.2. Використання тексту як контейнер 

Створимо мотиваційний напис, використавши текст як контейнер 

(рис.7.22). 

 

Рис. 7.22. Бажаний результат роботи 
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1. Створюємо новий документ з роздільною здатністю Full HD з білим фо-

ном. Додаємо коригувальний градієнтний шар від сірого # a6a6a6 до прозорого. 

Повзунок непрозорості зміщуємо на позначку 32 % (рис. 7.23). 

 

 

Рис. 7.23. Створення нового файлу та додавання градієнта 

 

2. Створюємо слово TRY. Кожна літера на окремому текстовому шарі. Га-

рнітура шрифту UkrainianFuturis, стиль Bold, розмір 776,02 pt, колір # будь-який. 

Вирівнюємо по центру полотна (рис. 7.24). 

 

 

Рис. 7.24. Створення трьох текстових шарів з однією літерою в кожному 

 

3. Додаємо зображення «Swing.jpg». Створюємо відсічну маску літері Т, 

масштабуємо та вирівнюємо як на рисунку 7.25. 
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Рис. 7.25. Додавання зображення та відсічної маски літері Т 

 

4. Дублюємо шар Swing (Ctrl + J). Створюємо маску і вибравши чорний 

жорсткий пензель, приховуємо маскою все зайве, окрім гойдалки та ніг дівчини. 

Виділяємо всі три шари (з маскою, відсічною маскою та літерою Т) і створюємо 

групу (Ctrl + G) (рис. 7.26). 

 

 

Рис. 7.26. Створення групи літери Т 

 

5. На шарі-масці інструментом Blur (Розмиття)  проходимо по виріза-

них краях, щоб згладити різкі піксельні виступи. Над відсічною маскою розта-

шовуємо два коригувальних шари: «Соковитість» та «Рівні» (рис. 7.27). 
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Рис. 7.27. Вікна коригувальних шарів «Рівні» та «Соковитість» 

 

6. Створюємо коригувальний шар «Соковитість» для шару з маскою і виб-

равши такі налаштування (рис. 7.28), прив’язуємо корекцію тільки до шару з ма-

скою (рис. 7.29). 

 

Рис. 7.28. Налаштування коригувального шару «Соковитість» 

 

 

Рис. 7.29. Коригування шару з маскою 
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7. За алгоритмом третього і четвертого кроку позиціонуємо та приховуємо 

маскою зайві частини зображення «Rock.jpg». Для виступу скелі, який виходить 

за літеру R, залишаємо дуже тонку лінію фонового зображення, як показано на 

рисунку 7.30. Створюємо групу для літери R. 

 

 

Рис. 7.30. Створення групи літери R 

 

8. Створюємо порожній шар та відсічну маску для шару з маскою. За до-

помогою інструмента Clone Stamp Tool (Штамп)  (S) з жорсткими краями, 

100 % непрозорістю та 100 % натиском, беремо зразок близько до краю скелі і 

зафарбовуємо раніше залишену лінію із заднім планом (рис. 7.31). 

 

 

Рис. 7.31. Уточнення контуру літери R 
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9. Підвищуємо світлість тіней та насиченість. Додаємо коригувальні шари 

«Криві» і «Соковитість» (рис. 7.32), виставляємо налаштування (рис. 7.33). 

 

 

Рис. 7.32 Додавання коригувальних шарів «Криві» і «Соковитість» 

 

  

 

Рис. 7.33. Налаштування коригувальних шарів «Криві» і «Соковитість» 

 

10. Додаємо зображення «Jump.jpg» і активуємо інструмент Content-Aware 

Move Tool (J). Виділивши виступ скелі в лівому кутку, переміщаємо його під 
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ногу дівчині. Натискаємо Enter. Потім створюємо відсічну маску, шар-маску та 

приховуємо зайве (рис. 7.34). 

 

Рис. 7.34. Редагування зображення «Jump.jpg» 

 

11. Використовуємо Color Range (Колірний діапазон). Виділяємо небо, 

створюємо коригувальний шар «Тон/Насиченість» і налаштовуємо його 

(рис.7.35). 

 

 

Рис. 7.35. Використання коригувального шару Color Range (Колірний діапазон) 
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12. Додаємо «Криві», «Соковитість», «Пошук кольору» і «Рівні». Підви-

щуємо насиченість, збільшуємо яскравість у тінях, додаємо Fuji пресет. Для рів-

нів інвертуємо маску та, вибравши м’який білий пензель, проходимо по кінчиках 

волосся дівчини, щоб їх затемнити (рис. 7.36, 7.37). 

 

  

Рис. 7.36. Налаштування коригувальних шарів «Рівні» та «Криві» 

 

 

 
Рис. 7.37. Налаштування коригувальних шарів «Соковитість» та «Пошук кольору» 
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13.  Перевіряємо впорядкованість групи літери Y (рис. 7.38) 

 

 

Рис. 7.38. Група літери Y 

 

14. Вибираємо літеру Т і переходимо до налаштування стилів текстового 

шару. Для цього двічі клікаємо по шару або натискаємо на іконку і вибираємо 

потрібний ефект. Щоб надати букві невеликий об’єм, або трохи «втиснути» її в 

фоновий шар, налаштовуємо Inner Shadow (Внутрішню тінь), Inner Glow (Внут-

рішнє світіння) та Outer Shadow (Тінь, що відкидається). Для внутрішньої тіні 

вибираємо колір чорний, Opacity (Непрозорість) 40 %, Кут джерела світла 90°, 

Distance (Зсув) 11px, Choke (Стягування) 0 %, Size (Розмір) 16px (рис.7.39). 

 

 

Рис. 7.39. Налаштування стилів текстового шару 
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15.  Налаштовуємо «Внутрішнє світіння». Range (Діапазон) 86 % та інші 

параметри (рис. 7.40). 

 

 

Рис. 7.40. Налаштування «Внутрішнього світіння» 

 

16.  Завершуємо налаштування стилів «Тінню, що відкидається». Задаємо 

Spread (Розмах) 7px та інші параметри (рис. 7.41). 

 

 

Рис. 7.41. Налаштування «Тіні, що відкидається» 
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17.  Тиснемо Ok та, клікнувши ПКМ по текстовому шару, копіюємо засто-

совані стилі (рис. 7.42). 

 

 

Рис. 7.42. Копіювання застосованих стилів 

 

18.  Так само вставляємо скопійовані стилі на текстові шари літер R та Y. 

Вплив внутрішньої тіні на літеру R можна трохи підсилити, підвищивши непро-

зорість до 80 % (рис. 7.43). 

 

 

Рис. 7.43. Вставка застосованих стилів для літер R та Y 
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19. Додаємо два текстових шари Just і life. Вирівнюємо по краях написи 

TRY, для зручності можна використовувати вертикальні напрямні. Гарнітура 

шрифту SF UI Display, стиль Thin, розмір +133,59 pt, колір # a5a5a7 (для Just), 

колір # ffffff (для life) (рис. 7.44). 

 

 

Рис. 7.44. Додавання шарів Just і life 

 

19. За необхідністю виділяємо всі шари, крім фонового, та вирівнюємо 

текст по вертикалі таким чином, щоб поля з обох боків були однакові. Додаємо 

коригувальний шар «Пошук кольору» над усіма і вибираємо пресет Fuji F125 

(рис.7.45). Зберігаємо документ у форматах «.psd», «.jpg». 

 

 

Рис. 7.45. Остаточний результат роботи 
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7.2.3.Робота з вертикальним текстом 

Навчаємося роботі з вертикальним текстом на прикладі зображення по-

льоту хижого птаха над гірським масивом (рис. 7.46). 

 

 

Рис. 7.46. Бажаний результат роботи 

 

1. Створюємо документ 1080px на 1080px. Виставляємо 4 напрямних з від-

ступом по 50px з кожного боку View → New Guide, створюємо коригувальний 

шар Pattern та, прямуючи крокам (рис. 7.47), вибираємо потрібну текстуру. 

 

 

Рис. 7.47. Вибір текстури 
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2. Вибираємо інструмент Vertical Type Tool (Вертикальний текст)  (T), 

друкуємо EAGLE з такими налаштуваннями: гарнітура шрифту Deadpool Movie 

(RUS BY LYAJKA), стиль Regular, розмір 195,38 pt, колір # будь-який, відстань 

між буквами  35. Дублюємо отриманий текстовий шар чотири рази (Ctrl + J) 

та переміщаємо верхній шар до правої вертикальної напрямної. Виділяємо всі 

текстові шари та з обраним інструментом Move Tool  (V) рівномірно розпо-

діляємо текст по ширині, натиснувши . Групуємо всі текстові шари (рис. 7.48). 

 

 

Рис. 7.48. Створення, вирівнювання та групування текстових шарів 

 

3. Додаємо зображення «Autumn forest.jpg». Створюємо відсічну маску для 

групи з текстом. Додаємо коригувальні шари «Соковитість» і «Рівні». Трохи збі-

льшуємо контраст зображення і підвищуємо насиченість (рис. 7.49). 

4. Додаємо зображення «Eagle.jpg». Застосовуємо метод виділення за до-

помогою каналів (Розділ 2). Переходимо у вкладку Channels у палітрі шарів, ви-

бираємо синій, клікаєм по ньому з затиснутою клавішею Ctrl. Потім створюємо 

маску, натиснувши іконку . Вибираємо альфа-канал, переходимо Image → 

Adjustments → Levels і намагаємося так налаштувати рівні, щоб між птахом і фо-

ном була чітка чорно-біла межа (рис. 7.50). 
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Рис. 7.49. Налаштування коригувальних шарів «Соковитість» та «Насиченість» 

 

 

Рис. 7.50. Виділення необхідних фрагментів зображення 

 

5. Тиснемо Ok та, залишаючись на альфа-каналі, беремо білий жорсткий 

пензель і виставляємо для нього режим накладення Overlay (Перекриття). При 

роботі в цьому режимі чорне залишається чорним, а біле – білим, але сірий колір 
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з кожним мазком пропадає. Проходимося по краях та, перемикнувшись на чор-

ний колір і на режим рисування Normal, прибираємо всі білі плями на зображенні 

птаха (рис. 7.51). 

 

 

Рис. 7.51. Коригування виділення 

 

6. З затиснутою клавішею Ctrl клікаємо по альфа-каналу та, перейшовши 

до шарів, створюємо маску шару з орлом. Інвертуємо маску (Ctrl + I) (рис. 7.52). 

 

 

Рис. 7.52. Створення маски шару з орлом 



7.РОБОТА З ТЕКСТОМ 

 

179 

 

7. Залишаючись на масці, зафарбовуємо чорним пензлем залишки фону. 

Щоб трохи згладити надто піксельні краї крил, вибираємо інструмент Blur Tool 

(Розмиття) і проходимо ним по краях на масці (рис. 7.53). 

 

 

Рис. 7.53. Коригування зображення птаха 

 

8. Підвищуємо контрастність зображення орла, щоб надати йому більше 

об’єму і відокремити від менш контрастного фону. Додаємо коригувальний шар 

«Рівні». Створюємо відсічну маску (рис. 7.54). 

 

 

Рис. 7.54. Створення відсічної маски та налаштування коригувального шару «Рівні» 
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9. Двічі натискаємо на іконку з шаром птаха та у вікні стилів налаштовуємо 

«Тінь, що відкидається» (рис. 7.55). Зберігаємо документ у форматах «.psd», 

«.jpg». 

 

 

Рис. 7.55. Налаштування стилю «Тінь, що відкидається» 

 

7.2.4. Розробка емблеми 

Створюємо мотивуючий пост для інстаграм з використанням тексту, що 

прив’язаний до контуру (рис. 7.56). 

 

 

Рис. 7.56. Бажаний результат роботи 
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1. Створюємо файл з розмірами як у попередньому прикладі: 1080 х 

1080px. Додаємо зображення «Lion.jpg». Виділяємо голову з гривою будь-яким 

зручним інструментом виділення, наприклад Quick Selection Tool (Швидке виді-

лення)  (W). Точність виділення неважлива. Створюємо маску (рис.7.57). 

 

 

Рис. 7.57. Виділення голови лева та створення маски 

 

2. Інструментом «Швидке виділення» виділяємо морду і створюємо кори-

гувальний шар «Криві». Поверх кривих створюємо коригувальний шар Threshold 

(Поріг). Вигинаємо криву таким чином, щоб вплив порога давав максимальну 

деталізацію морди лева. Значення Threshold Level (Поріг) виставляємо 171. Ство-

рюємо відсічну маску «Ізогелією» (рис. 7.58). 

 

 

Рис. 7.58. Виділення морди лева та створення відсічної маски 
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3. Повторюємо цей алгоритм для гриви. Значення порога 128, криву виги-

наємо як на рис. 7.59. Решту контурів можна приховати, пройшовши білим пен-

злем по масці кривих. 

 

  

Рис. 7.59. Виділення гриви лева та створення відсічної маски 

 

4. Інструментом «Гумка» проходимо по вихідному зображенню в самих те-

мних ділянках (рис. 7.60). 

 

 

Рис. 7.60. Редагування вихідного зображення інструментом «Гумка» 

 

5. Виставляємо натиск і непрозорість гумки на 30 %, налаштовуємо м’які 

краї та, залишаючись на шарі «Lion», робимо зарубки, щоб прибрати умовний 

контур з кінців гриви (рис .7.61). 
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Рис. 7.61. Редагування контуру гриви 

 

6. Інструментом Ellipse Tool (Еліпс)  (U) у режимі Shape створюємо два 

кола різного діаметра, як показано на рисунку 7.62. Розташовуємо менше коло 

поверх більшого, суміщаючи їх центри. Об’єднуємо кола в один шар і, виділи-

вши їх інструментом Path Selection Tool (Виділення контуру)  (A), застосо-

вуємо команду Subtract Front Shape (Відняти передню фігуру) . 

 

 

Рис. 7.62. Створення круглого контуру 

 

7. Тепер маємо коло в режимі Path (Контур). Поєднуємо центри з раніше 

створеними колами. Інструментом «Текст», навівши курсор на контури, клікаємо 

по верхній частині кола і друкуємо такий текст: «EVEN IF YOU ARE A CAT». 
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Гарнітура шрифту Capture it (RUS BY LYAJKA), стиль Regular, розмір: 61,71 pt, 

колір: # ffffff. Шрифт є у вкладенні. У вікні Paragraph вирівнюємо текст по цен-

тру. Відстань між символами 200 (рис. 7.63). 

 

 

Рис. 7.63. Додавання верхнього напису 

 

8. Щоб симетрично розташувати текст щодо вертикальної напрямної (View 

→ New Guide ... → Vertical 540 px), зміщуємо текст уздовж контуру інструмен-

том Path Selection Tool (Виділення контуру)  (A). Підносимо курсор до ро-

мба, що з’явився  і, як тільки поруч з курсором з’являться двосторонні стрілки, 

можемо пересувати текст. Створюємо коло в режимі контуру для нижнього на-

пису. Для того щоб напис відобразивася з внутрішньої частини кола, перетягу-

ємо напис всередину, навівши курсор на ромб. Стрілками з обох боків відзначені 

маніпулятори межі рядка (рис.7.64). 

 

 

Рис. 7.64. Додавання та вирівнювання написів 
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9. У режимі фігури рисуємо два кола без заливки. Товщина обведення 5 px, 

колір: чорний (рис. 7.65). 

 

 

Рис. 7.65. Додавання двох кіл з чорним обведенням 

 

10. Інструментом Custom Shape Tool (Довільна форма) створюємо зірку і 

повертаємо її так, щоб вона спиралася на внутрішнє коло як і верхній напис. На-

лаштувавши одну зірку, дублюємо шар з нею, і в режимі вільної трансформації 

переносимо радіус обертання на вертикальну напрямну. Горизонтально відобра-

жаємо зірку (рис. 7.66). 

 

 

Рис. 7.66. Додавання зірок 

 

10. Створюємо коло в режимі фігури, який буде покривати площу всього 

знаку з невеликими виступами. Прибираємо обведення, вирівнюємо по центру 
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знаку. Вибираємо заливку градієнтом. Налаштовуємо як показано на рисунку 

7.67 та застосовуємо заливку до кола. Отриманий результат роботи (рис. 7.56) 

зберігаємо в форматах «.psd», «.jpg». 

 

 

Рис. 7.67. Налаштування градієнтної заливки 

 

Запитання для самоконтролю 

 

1. У чому різниці між кернингом і трекінгом? 

2. У чому полягає автоматизація глобального освітлення? 

3. Яке призначення параметра інтерліньяж? 

4. Який з трьох каналів необхідно обирати для використання складного ви-

ділення? 

5. Після яких перетворень не можна редагувати текст? 
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8. ВИКОРИСТАННЯ ФІЛЬТРІВ І РЕЖИМІВ НАКЛАДАННЯ. СТВОРЕННЯ ЖИВОПИСНИХ 

ІЛЮСТРАЦІЙ. ПАКЕТНА ОБРОБКА ЗОБРАЖЕНЬ (ACTION) 

 

8.1. Загальні поняття 

 

8.1.1. Режими накладання 

Від режиму накладання, зазначеного в елементах керування панелі пара-

метрів, залежить, який вплив будуть відчувати пікселі в зображенні при викори-

станні певного інструменту рисування або редагування. 

Режими накладання діляться на наступні групи (рис. 8.1). 

 

 

Рис. 8.1. Групи режимів накладання 

 

Розглянемо режими накладення, які використовуються частіше за інших: 

Перекриття, М’яке світло, Множення і Екран. 

‒ Перекриття. У цьому режимі кольори перемножуються або освітлю-

ються залежно від основного кольору. Візерунки або кольори перекривають іс-

нуючі пікселі, залишаючи незмінними світлі і темні ділянки основного кольору. 
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Базовий колір не замінюється, а змішується з кольором, що суміщається, 

це дозволяє відобразити наявність світлих або темних ділянок вихідного ко-

льору. На зображенні, яке накладається, нейтральний сірий колір ніяк не впливає 

на основний, а просто зникає. 

‒ М’яке світло (Розсіяне світло). У цьому режимі кольори стають темні-

шими або світлішими залежно від суміщеного кольору. Отриманий ефект анало-

гічний висвітленню зображення розпливчастим світлом прожектора. Якщо сумі-

щений колір (джерело світла) є світлішим за 50 % сірого, то зображення стає сві-

тліше, як після освітлення. Якщо суміщений колір є темнішим за 50 % сірого, 

зображення стає темніше, як після затемнення. Розфарбовування чистим чорним 

або білим кольором створює виразні, темні або світлі зони, але чистого чорного 

або білого кольору не утворюється. Відрізняється від режиму Перекриття тільки 

тим, що надає більш м’який вплив на результуючий шар. 

‒ Множення. У цьому режимі розглядається інформація про колір у кож-

ному каналі, і значення основного кольору множиться на значення суміщеного 

кольору. Результуючий кольором завжди є більш темний. У результаті множення 

значення будь-якого кольору на значення чорного кольору виробляється чорний 

колір. У результаті множення значення будь-якого кольору на значення білого 

кольору колір залишається незмінним. При рисуванні кольорами, що відмінні від 

чорного або білого кольору, штрихи, що йдуть підряд, що накладаються за допо-

могою інструменту рисування, створюють все більш темні кольори. Цей ефект 

аналогічний рисуванню зображення за допомогою декількох маркерів. 

‒ Екран (Освітлення). У цьому режимі розглядається інформація про колір 

у кожному каналі і перемножуються зворотні значення суміщеного і основного 

кольору. Як результуючий колір завжди залишається більш світлий колір. При 

освітленні із застосуванням чорного кольору колір залишається незмінним. При 

перекритті із застосуванням білого кольору колір стає білим. Отриманий ефект 
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аналогічний накладенню одного на один зображень численних фотографічних 

слайдів за допомогою проектора [1, 2, 6, 7, 31]. 

 

8.1.2. Фільтри 

Фільтри використовуються для очищення і ретушування фотографій, для 

застосування спеціальних художніх ефектів, які надають зображенню вигляд на-

черку або картини в імпресіоністському стилі, а також специфічних трансформа-

цій з використанням ефектів спотворення та освітлення. Всі фільтри, що пропо-

нуються Adobe, містяться в меню «Фільтр». Деякі фільтри, які постачаються сто-

ронніми розробниками, доступні у вигляді зовнішніх модулів. Після установки 

вони відображаються в нижній частині меню «Фільтр». 

Смарт-фільтри, що застосовуються до смарт-об’єктів, дозволяють викону-

вати операції недеструктивним чином. Вони зберігаються на панелі «Шари» у 

вигляді шарових ефектів і можуть бути переналаштовані, оскільки застосову-

ються до вихідних даних зображення, що зберігаються в смарт-об’єкті. Список 

фільтрів, що підтримують документи з глибиною 16-і 32-біт канал. 

‒ Усі фільтри групи Розмиття (за винятком Розмиття при малій глибині рі-

зкості і Розумне розмиття). 

‒ Усі фільтри групи Спотворення. 

‒ Фільтр Шум → Додати шум. 

‒ Усі фільтри групи Оформлення. 

‒ Усі фільтри групи Рендеринг (за винятком фільтра Ефекти освітлення). 

‒ Усі фільтри групи Посилення різкості (за винятком Різкість на краях). 

‒ Наступні фільтри в групі Фільтри → Стилізація: Дифузія, Тиснення, Ко-

нтурування. 

‒ Усі фільтри групи Відео. 

‒ Усі фільтри в групі Фільтр → Інше [1, 2, 6, 7, 32]. 
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8.1.3. Галерея фільтрів 

Галерея фільтрів забезпечує попередній перегляд для багатьох фільтрів 

спеціальних ефектів. Вона дозволяє застосовувати кілька фільтрів, вмикати або 

вимикати їх ефект, скидати параметри і змінювати порядок їх застосування. У 

діалоговому вікні «Галерея фільтрів» доступні не всі фільтри, що наявні в меню 

«Фільтр» (рис .8.2) [1, 2, 6, 7, 33]. 

 

Рис. 8.2. Інтерфейс діалогового вікна «Галерея фільтрів» 

 

Художні фільтри. Фільтри з підменю «Художні» допомагають досягнути 

художніх ефектів для образотворчого мистецтва або комерційного проєкту. Ці 

фільтри відтворюють природні або традиційні медіа-ефекти. Усі художні філь-

три можуть застосовуватися через «Галерею фільтрів». 

Фільтри розмиття. Фільтри «Розмиття» пом’якшують виділений фраг-

мент або все зображення. Зручні для ретушування. Вони пом’якшують переходи 

шляхом усереднення пікселів біля різких меж визначених ліній та заштрихова-

них ділянок на зображенні. 
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Фільтри мазків пензля. Подібно до художніх фільтрів, фільтри «Штрихи» 

створюють живописний або мистецький вигляд, застосовуючи різні пензлі та 

ефекти обведення фарбою. Усі фільтри «Штрихи «можуть застосовуватися з Га-

лереї фільтрів. 

Фільтри деформації. Фільтри деформації геометрично викривляють зо-

браження, створюючи тривимірні та інші структурні ефекти. Однак, ці фільтри 

можуть потребувати великого обсягу пам’яті. Фільтри «Розсіяне світіння», 

«Скло» та «Океанські хвилі» можуть бути застосовані з Галереї фільтрів. 

Фільтри шуму. Фільтри «Шуму» додають або усувають шум або пікселі з 

випадково поширеними колірними рівнями. Це допомагає змішувати виділення 

з оточуючими пікселями. Шумові фільтри можуть створювати незвичайні текс-

тури або видаляти проблемні ділянки, наприклад, пил та подряпини. 

Фільтри оформлення. Фільтри в підменю «Оформлення» різко визначають 

область виділення, групуючи пікселі зі схожими значеннями кольорів у комірки. 

Фільтри візуалізації. Фільтри візуалізації створюють тривимірні фігури, 

візерунки з хмарами, візерунки заломлення та симульовані відображення світла 

на зображенні. Також можна керувати об’єктами у 3D-просторі, створювати 3D-

об’єкти, а також створювати заливку текстурою у файлах з градаціями сірого, 

щоб створити 3D-подібні ефекти для освітлення. 

Фільтри різкості. Фільтри різкості фокусують розмиті зображення, збіль-

шуючи контраст сусідніх пікселів. 

Фільтри ескізів. Фільтри у підменю «Ескіз» додають текстуру до зобра-

жень, найчастіше для 3D-ефекту. Фільтри також зручні для створення образот-

ворчого вигляду та вигляду рисування від руки. Усі ескізні фільтри можуть за-

стосовуватися через Галерею фільтрів. 

Фільтри стилізації. Фільтри стилізації створюють нарисований та імпре-

сіоністський ефект на виділеній ділянці шляхом заміщення пікселів та завдяки 

виявленню і збільшенню контрастності зображення. Після застосування фільтрів 
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на кшталт «Виділення країв» та «Контурування», що здійснюють виділення меж, 

можна скористатися командою «Інверсія», щоб окреслити краї кольорового зо-

браження зафарбованими лініями, або окреслити краї зображення у градаціях сі-

рого білими лініями. 

Фільтри текстур. Фільтрами текстури користуються щоб симулювати ви-

гляд глибини або речовини, або надати зображенню більш природного вигляду. 

Відеофільтри. Підменю «Відео» містить фільтри «Усунення черезрядкової 

розгортки» та «Кольори NTSC». 

Інші фільтри. Фільтри з меню «Інші» дозволяють створювати власні філь-

три, використовувати фільтри для коригування масок, здійснювати зсув області 

виділення на зображенні та швидко налаштовувати колірні параметри. 

Виправлення перспективи. Властивість «Виправлення перспективи» збері-

гає правильну перспективу під час редагування зображень, що містять площини 

перспективи (наприклад стіни будівлі). 

Фільтр «Галерея Розмиття». Кожен інструмент з галереї розмиття має ін-

туїтивні органи керування, які дозволяють налаштувати параметри ефекту. Після 

встановлення розмиття можна використати елементи керування «Боке», щоб на-

дати ефекту остаточний стилізований вигляд. Photoshop дозволяє попередньо пе-

реглянути результат застосування ефектів з галереї розмиття в повному розмірі 

в режимі реального часу. 

Фільтр «Адаптивний широкий кут». Адаптивний ширококутний фільтр 

використовується, щоб виправити викривлення, внесені ширококутними 

об’єктивами. Можна швидко виправити лінії, які здаються кривими на панора-

мах, або фотографіях, зроблених об’єктивами «риб’яче око» і ширококутними 

об’єктивами. Наприклад, при використанні ширококутного об’єктива будівлі мо-

жуть виглядати нахиленими всередину кадру. Фільтр визначає модель лінзи і ка-

мери та використовує інформацію про характеристики лінзи для корекції зобра-

ження. Можна додати обмеження, що позначають прямі лінії в різних частинах 
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зображення. За допомогою цих даних фільтр «Адаптивний широкий кут» вида-

ляє спотворення. 

Фільтр «Корекція лінз». Фільтр «Корекція лінз» виправляє такі поширені 

оптичні дефекти, як бочкоподібне і подушкоподібне спотворення, віньєтування 

і хроматична аберація. Цей фільтр підтримує тільки 8- і 16-бітові зображення в 

режимі RGB або «Градації сірого». За допомогою цього фільтра можна повер-

тати зображення або виправляти спотворення перспективи при нахилі фотоапа-

рата при зйомці. Сітка зображення дозволяє спростити ці виправлення і зробити 

їх акуратніше, ніж при використанні команди «Трансформування». 

 

8.1.3. Actions (Дії) 

Для часто виконуваних завдань можна записати операції, які дозволяють 

підвищити продуктивність роботи з Adobe Photoshop. Записуючи дії, слід дотри-

муватися таких інструкцій: 

‒ В дію дозволено записувати майже всі команди. 

‒ Дозволено записувати операції, що виконуються інструментами «Об-

ласть», «Переміщення», «Багатокутник», «Ласо», «Чарівна паличка», «Кадру-

вання», «Фрагмент», «Чарівна гумка», «Градієнт», «Заливка», «Текст», «Фі-

гура», «Примітки», «Піпетка» та «Колірна піпетка», а також операції, що вико-

нуються за допомогою панелей «Історія», «Зразки», «Колір», «Контури», «Ка-

нали», «Шари», «Стилі» та «Дії». 

‒ Результати залежать від типу файлів, а також від змінних програмних па-

раметрів, таких як активний шар та колір переднього плану. Наприклад, фільтр 

«Розмиття за Гауссом» зі значенням 3px дасть різні результати у файлах із роз-

дільною здатністю 72ppi та 144ppi. Аналогічно баланс кольорів не діятиме у ви-

падку вибору формату файлу «градації сірого». 

‒ Під час запису дій, що передбачають вибір параметрів у діалогових вік-

нах та панелях, у діях буде застосовано параметри, чинні на момент запису. У 
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випадку зміни параметрів діалогових вікон чи панелей під час запису, запису-

ється змінене значення. 

‒ Модальні операції та інструменти, а також інструменти, що фіксують по-

ложення об’єктів, використовують одиниці виміру, що вказані для лінійці. Мо-

дальна операція чи модальний інструмент – це така операція чи інструмент, що 

вимагає натискання клавіш «Enter» або «Return» для застосування своєї дії. Ін-

струменти, для яких записується положення об’єкта такі: «Область», «Фраг-

мент», «Градієнт», «Ласо», «Фігура», «Контур», «Піпетка» та «Примітки». 

‒ Якщо записати команду «Відтворити», що є в списку меню панелі «Дії», 

то одна дія буде виконувати іншу [1, 2, 6, 7, 34]. 

 

8.2. Практичні завдання 

 

8.2.1. Використання розмиття для виділення головного і другорядного 

на фото з декількома об’єктами. 

Розглянемо можливості застосування ефекту розмиття з метою виділення 

композиційного центру та надання композиції динамічних властивостей 

(рис.8.3). 

 

Рис. 8.3. Результат роботи 
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1. Відкриваємо зображення «Cake.jpg». Перетворюємо в смарт-об’єкт і за-

стосовуємо «Розмиття діафрагми» Filter → Iris Blur (рис. 8.4) 

 

 

Рис. 8.4. Застосування фільтра 

 

2. Перетаскуємо центр розмиття на відрізаний шматок торта і виставляємо 

маркери кордону розмиття, як на скріншоті. Для незалежного переміщення мар-

керів затисніть і утримуйте Alt при переміщенні. Розмиття: 29px (рис. 8.5). 

 

 

Рис. 8.5. Налаштування розмиття  
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3. Завдяки смарт-об’єкту є можливість e будь-який момент регулювати на-

лаштування смарт-фільтра, а також область його дії. Переходимо на шар-маску. 

Чорним м’яким пензлем робимо чіткими частини виделки, грані тарілки і шма-

точок торта (рис. 8.6). Зберігаємо у форматі .psd. 

 

 

Рис. 8.6. Маска смарт-фільтра 

 

4. Відкриваємо «Tea.jpg» перетворюємо в смарт-об’єкт і застосовуємо «На-

хил-зміщення». Filter → Tilt-Shift (рис. 8.7). 

 

 

Рис. 8.7. Застосування фільтра 
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5. Пунктирні лінії регулюють розмір області без розмиття, а суцільні роз-

межовують повне розмиття і плавний перехід до чіткої частини зображення, як і 

в попередньому способі розмиття. Повертаємо на кут 17,7° Розмиття:15px (рис. 

8.8). Зберігаємо у форматі .psd. 

 

 

Рис. 8.8. Налаштування фільтру 

 

6. Також нерідко використовується «Розмиття в русі», щоб позначити ви-

соку швидкість рухомого об’єкта. У нашому випадку надаємо прискорення 

спортсмену. Відкриваємо зображення «Runner.jpg». Дублюємо шар. Виділяємо 

будь-яким зручним способом бігуна і створюємо маску (рис. 8.9). 

 

 

Рис. 8.9. Створення маски 
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7. Переходимо на нижній шар. Виділяємо спортсмена будь-яким зручним 

способом, при цьому виділенням захоплюємо невелику частину фону. Викону-

ємо заливку відповідно до вмісту Edit → Fill (Shift + F5). При необхідності по-

вторюємо операцію для частин газону, які могли з’явитися зліва (рис. 8.10). 

 

 

Рис. 8.10. Заливка відповідно до вмісту 

 

8. Перетворюємо нижній шар у смарт-об’єкт і застосовуємо «Розмиття в 

русі». Filter → Blur → Motion Blur (рис. 8.11) 

 

 

Рис. 8.11. Фільтр «Розмиття в русі» 
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9. Налаштовуємо розмиття (рис. 8.12)і включаємо видимість шару з бігу-

ном. Зберігаємо у форматі .psd (рис. 8.13). 

 

 

Рис. 8.12. Налаштування фільтру 

 

 

Рис. 8.13. Результат роботи 

 

8.2.2. Нанесення зображення на довільну рельєфну поверхню 

 

Буде потрібно всього два фільтри, щоб нанести будь-яке зображення на до-

вільну поверхню (рис.8.14). Розглянемо фільтри «Виправлення перспективи» і 

«Зміщення». 
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Рис. 8.14. Результат роботи 

 

1. Відкриваємо зображення «Wall.jpg». Дублюємо шар. Задаємо перспек-

тиву для майбутніх графіті. File → Vanishing Point (Виправлення перспективи). 

У вікні розставляємо опорні точки по контуру жовтої стіни. Ґрунтуючись на ко-

льорах сітки, можна визначити найбільш природне позиціонування майбутніх 

об’єктів. Найбільш сприятливий колір сітки перспективи – синій, жовтий – не-

прийнятний, червоний – неприйнятний. На рисунку 8.15. стрілками показані опо-

рні точки. Після створення і вирівнювання сітки натискаємо Ok. 

 

 

Рис. 8.14. Налаштування перспективи 
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2. Створюємо карту зміщення. За її допомогою Photoshop надасть рельєф 

зображенню і, використовуючи фільтр зміщення, накладе графіті на ребристу по-

верхню стіни. На вкладці Канали натискаємо ПКМ по зеленому каналу, бо він 

краще за інших відображає контраст граней, що виступають на стіні, і вибираємо 

Duplicate Channel (рис .8.16). У вікні вибираємо відобразити як новий документ 

і називаємо Displace (Зсув). 

 

Рис. 8.16. Створення нового документа 

 

3. Переходимо у вкладку з новим документом. Застосовуємо корекцію 

Levels (Рівні) Image → Adjustments → Levels (Ctrl + L) для підвищення контрасту 

(рис. 8.17). 

 

Рис. 8.17. Налаштування рівнів 

 

4. Щоб зсув не здавався «рваним», трохи розмиваємо карту зміщення. За-

стосовуємо розмиття за Гауссом  Filter → Blur → Gaussian Blur (рис. 8.18). Збе-

рігаємо документ у форматі .psd. Закриваємо карту зміщення. 
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Рис. 8.17. Налаштування розмиття за Гауссом 

 

5. Додаємо в документ, в якому ми працювали з перспективою зображення 

з графіті. Створюємо порожній шар над копією шару зі стіною. Затиснувши Ctrl 

натискаємо по графіті, яке буде розташовуватися ближче, щоб створити виді-

лення. Після цього копіюємо графіті (Ctrl + C) і вимикаємо видимість шару. Пе-

рейшовши на порожній шар, включаємо фільтр «Виправлення перспективи». На-

тискаємо (Ctrl + V), щоб помістити графіті в вікно виправлення перспективи. 

Вільною трансформацією (Ctrl + T) максимально зменшуємо вуличне творіння і 

тільки потім перетягуємо на сітку перспективи (рис. 8.19). Після досягнення не-

обхідного результату, натискаємо Ok. 

 

 

Рис. 8.19. Розміщення графіті на сітці перспективи 
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6. Повторюємо ті ж операції для другого графіті (рис. 8.20). Перетворимо 

шари з отриманими графіті в смарт-об’єкти (ті шари, на яких розміщували ско-

пійовані рисунки). Шари, з яких робили копії, можна видалити. 

 

 

Рис. 8.20. Застосування перспективи до другого графіті 

 

7. Застосовуємо фільтр «Зсув» з відповідними налаштуваннями до одного 

з двох смарт-об’єктів Filter → Distort → Displace (рис. 8.21). 

 

 

Рис. 8.21. Налаштування фільтру «Зсув» 
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8. Застосовуємо фільтр Шум, щоб графіті не виглядало таким глянцевим 

(рис.8.22). 

 

Рис. 8.22. Застосування фільтра Шум 

 

9. Переходимо до налаштування режиму накладення. Двічі натискаємо по 

шару з графіті і у вкладці Blending Options (Налаштування накладання) пересу-

ваємо повзунок нижнього шару на значення 204, таким чином підвищуємо види-

мість нижнього шару на поточному. Для досягнення більш делікатного ефекту, 

натискаємо на білий повзунок, утримуючи Alt (рис. 8.23). Верхній градієнт від-

повідає за видимість поточного шару, його ми не чіпаємо. 

 

 

Рис. 8.23. Налаштування параметрів накладання 
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10. Виставляємо непрозорість редагованого шару 80 % (рис. 8.24). Утри-

муючи Alt, перетягуємо застосовані фільтри на шар з другим графіті і повторю-

ємо налаштування режиму накладання та непрозорості шару. Зберігаємо проєкт 

у форматі .psd (рис. 8.14). 

 

 

Рис. 8.24. Застосування фільтрів для другого графіті 

 

8.2.3. Прийоми автоматизації. Створення Action 

Записуємо Action для створення олівцем начерку. Використовуємо режими 

накладення. Використовуємо галерею фільтрів (рис. 8.25). 

 

 

Рис. 8.25. Результат роботи 
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1. Відкриваємо зображення «Notebook.jpg». Додаємо вікно Action (Дії). 

Window → Actions (Alt + F9) (рис. 8.26). Якщо є необхідність, закріплюємо в па-

нелі швидкого доступу. 

 

 

Рис. 8.26. Вікно дій 

 

2. Для створення власних дій, натискаємо на мініатюру папки у вікні 

Action, називаємо «My actions». Створюємо дію. Для цього натискаємо на пікто-

граму «Нова дія», називаємо «Pencil sketch» і натискаємо Record (Почати запис) 

(рис. 8.27). З цього моменту всі наші дії в Photoshop будуть записані, тому чита-

ємо уважно хід роботи, щоб потім не видаляти зайві кроки. 

 

 

Рис. 8.27. Початок запису дій 

 

3. Створюємо коригувальний шар Solid Color (Колір) (рис. 8.28) і вибира-

ємо білий колір. Розміщуємо (перетягуємо) зображення «Trees.png» у поточний 

документ. 

4. Виділяємо коригувальний шар і шар з деревами та конвертуємо їх у 

смарт-об’єкт. Додаємо фільтр Graphic Pen (Туш). Filter → Filter Gallery → Sketch 
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→ Graphic Pen. Параметри довжини штрихів і тоновий баланс виставляємо як на 

рисунку 8.29. Натискаємо Ok. 

 

 

Рис. 8.28. Створення коригувального шару 

 

 

Рис. 8.29. Налаштування параметрів фільтра 

 

5. Застосовуємо розмиття за Гаусом, щоб прибрати неприродну різкість 

рисунка. Filter → Blur → Gaussian Blur. Радіус розмиття 0,4px. Змінюємо режим 

накладання смарт-об’єкта на Multiply (Множення) (рис. 8.30). «Множення» на-

лежить до групи режимів накладення, що відповідають за затемнення зобра-

ження. Білий колір буде повністю виключений, чорний залишиться чорним, а 

градації адаптуються під фоновий шар. 
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Рис. 8.30. Режим накладання Множення  

 

6. Знижуємо непрозорість смарт-об’єкта до 68 %. (Якщо віконце зі значен-

ням непрозорості залишається підсвіченим синім контуром, натисніть Enter). 

Створюємо коригувальний шар Solid Color (Колір) і вибираємо колір #643b00. 

Створюємо відсічну маску шару «Trees». Змінюємо режим накладення коригую-

чого шару на Screen (Екран) (рис. 8.31). «Екран» належить до групи режимів на-

кладення, що відповідають за освітлення зображення. Дія цього режиму повні-

стю протилежна множенню. Білий колір залишиться недоторканим, чорний буде 

виключений, а градації адаптуються під фоновий шар тим самим освітливши 

його. 

 

 

Рис. 8.31. Режим накладання Екран 
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7. Створюємо коригувальний шар Color Lookup (Пошук кольору). У ре-

жимі 3D LUT File вибираємо Candleight.CUBE і знижуємо значення непрозорості 

коригуючого шару до 33 % (рис. 8.32). (Якщо віконце зі значенням непрозорості 

залишається підсвіченим синім контуром, натисніть Enter). 

 

 

Рис. 8.32. Налаштування коригуючого шару та непрозорості 

 

8. Для зупинки запису всіх дій натискаємо на кнопку . Для того щоб 

зробити дію універсальною для всіх зображень, нам необхідно зробити зупинки 

(паузи) на ті кроки, які потребують індивідуальної настройки для кожного зобра-

ження. Такими кроками є: Place (Додавання файлу) і Filter Gallery (Галерея філь-

трів). Клікаємо по порожньому прямокутнику напроти кожного (рис. 8.33). 

9. Випробуємо нашу дію на практиці. Видаляємо всі шари, крім фонового, 

і, виділивши операцію «Pencil Sketch», натискаємо на кнопку . Коли Action 

зробить зупинку на кроці Place, додаємо будь-яке зображення формату «.png», 

інтуїтивно розміщуємо на білому полотні і натискаємо Enter. Наступна зупинка 

Filter Gallery, там налаштовуємо тоновий баланс, щоб зображення не виглядало 

занадто темним і натискаємо Enter. По закінченню роботи операції, масштабуємо 

зображення по сторінці і зберігаємо у форматі «.jpg». Повторіть операцію для 

зображень: «wizard.png» і «Guitar.png» (рис. 8.34). 
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Рис. 8.33. Налаштування зупинок під час виконання дії 

 

   

Рис. 8.34. Результат роботи  

 

10. Для того щоб була можливість застосувати записану дію на будь-якому 

іншому ПК, зберігаємо Action у папку з результатами нашої роботи (рис. 8.35). 

Щоб завантажити збережений Action з зовнішнього носія, переходимо за шляхом 

(рис. 8.35) і вибираємо Load Action. 
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Рис. 8.35. Збереження записаних дій 

 

8.2.4. Розробка текстури на основі фотореференсів 

Створюємо абстрактну текстуру обличчя для міфічного персонажа 

(рис. 8.36). Розширюємо знання про фільтри і режими накладення. 

 

 

Рис. 8.36. Результат роботи 
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1. Відкриваємо зображення «Houses.jpg», дублюємо шар (Ctrl + J) і перево-

димо дублікат у смарт-об’єкт. Застосовуємо розмиття по контуру, вказуючи стрі-

лками напрямок розмиття (рис. 8.37). Filter → Blur Gallery → Path Blur ... Натис-

каємо Enter. 

 

 

Рис. 8.37. Налаштування векторів розмиття 

 

2. Застосовуємо шум, щоб надати розмитості трохи текстури. Filter → 

Noise → Add Noise ... У розділі Distribution (Розподіл) вибираємо Uniform (Рів-

номірне) і включаємо монохромний режим, щоб виключити кольорові точки 

(рис. 8.38). 

 

Рис. 8.38. Налаштування шуму 
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3. Дублюємо отриманий шар і відображаємо спочатку по горизонталі, по-

тім по вертикалі (рис. 8.39). 

 

 

Рис. 8.39. Застосування вільної трансформації 

 

4. Додаємо коригувальний шар Vibrance (Коливання). Коливання: 68 %, 

Насиченість: 39 %. Для того щоб виключити сірий колір, який перекриває всю 

нижню частину зображення, скористаємося режимом накладення Overlay (Пере-

криття) з контрастної групи (рис. 8.40). Цей режим повністю виключає 50 % -й 

сірий з зображення, яке накладається. 

5. Сірий колір видалився, а й разом з ним і насиченість у верхній частині 

зображення. Цей режим працює на контраст, тому він просто зробив світлою ді-

лянку шару знизу ще світліше за рахунок накладання. Вирішуємо це дублюючи 

блідий шар разом з Коливанням (рис. 8.41). 
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Рис. 8.40. Режим накладення Перекриття 

 

 

Рис. 8.41. Дублікат групи шарів для збільшення насиченості 

 

6. Створюємо групу з усіх шарів, крім фонового, і називаємо «Right Part». 

Створюємо коригувальний шар Solid Color (Колір) (#06d6b6) і інвертуємо його 

маску (Ctrl + I). Білим м’яким пензлем рисуємо білок майбутнього ока (рис. 8.42). 
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Рис. 8.42. Забарвлення ока 

 

7. Додаємо зображення «Eye.jpg». Виділяємо райдужну оболонку і зіницю, 

створюємо маску. Масштабуємо, підрівнюємо маскою межі райдужної оболонки 

(рис. 8.43). 

 

Рис. 8.43. Виділення зіниці й райдужки за допомогою маски 

 

8. Створюємо шар Curves (Криві) і називаємо «Shadows». Затемнюємо пів-

тони. Інвертуємо маску. Створюємо відсічну маску шару «Eye». Вибравши 

м’який білий пензель, проявляємо темні ділянки по межі райдужної оболонки 

(рис. 8.44). 
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Рис. 8.44. Створення тіні 

 

9. Для того щоб додати контрасту оку, немає необхідності вигинати криву. 

Досить просто створити коригувальний шар Криві і змінити режим накладення 

на Overlay (Перекриття) (рис. 8.45). Коригувальний шар створює віртуальну ко-

пію шару, до якого будуть застосовуватися корекції, і тому при застосуванні ре-

жиму накладення до нього ефект буде таким самим, як якщо б ми застосували 

Накладення до дубліката шару. Недолік використання дубліката в тому, що всі 

зміни на нижньому шарі, будуть відображатися на верхньому як непотрібні ар-

тефакти. Знижуємо непрозорість до 40 %. 

 

 

Рис. 8.45. Створення шару Криві 
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10. Щоб око поєднувалося з навколишнім середовищем додаємо шум. 

Filter → Noise → Add Noise. Amount: 36 % (рис. 8.46). Прибираємо шум з зіниці, 

використовуючи чорний м’який пензель і маску смарт-фільтра. 

 

 

Рис. 8.46. Додавання шуму  

 

11. Створюємо групу з шарів «Eye», які були використані для створення 

ока. Визначаємо розмір отриманого зображення: Image → Image Size (Ctrl + Alt 

+ I) і запам’ятовуємо розмір. Зберігаємо документ у форматі «.psd». Створюємо 

новий документ з розмірами 1150 х 720px з прозорим фоном. Створюємо пов’яза-

ний смарт-об’єкт File → Place Linked ... (Помістити зв’язаний) і вибираємо доку-

мент, в якому створювалася права частина обличчя. Таким чином ми зменшили 

розмір файлу зі 115Мб до 2,37Мб, при цьому залишили можливість вносити ко-

рекції в вихідний документ на будь-якому етапі створення поточного. Всі зміни, 

застосовані до вхідного документа, відобразяться в поточному. Про наявність 

зв’язку свідчить невелика іконка на доданому шарі (рис. 8.47). 

 

 

Рис. 8.47. Зв’язаний файл 
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12. Дублюємо вихідний шар (Ctrl + J) і відображаємо по горизонталі. Роз-

міщуємо в лівій частині полотна. Створюємо копію всіх шарів (Ctrl + Alt + Shift 

+ E). Вибираємо прямокутне виділення і виділяємо порожню область між части-

нами особи, трохи заходячи на текстуру. Заливаємо відповідно до вмісту. Edit → 

Fill ... (Shift + F5) (рис. 8.48). 

 

 

Рис. 8.48. Заливка відповідно до вмісту 

 

13. Додаємо фото «Face.jpg» (рис. 8.49). 

 

 

Рис. 8.49. Нове зображення 

 

14. Масштабуємо фото з дівчиною так, щоб перенісся перебувало між очей 

нашої текстури і при цьому були дотримані приблизні пропорції. Додаємо маску 

збільшеному шару. Для уточнення масштабу і вирівнювання по текстурі, змен-

шуємо непрозорість обличчя до 35 % (рис. 8.50). 
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Рис. 8.50. Позиціонування та масштабування зображення  

 

15. Тепер накладаємо створену текстуру. Повертаємо 100 % непрозорість 

шару з дівчиною і знебарвлюємо його, щоб при накладенні текстура зберегла свої 

первинні кольори. Для швидкості процесу викликаємо корекцію Hue / Saturation 

(Колірний тон / Насиченість) (Ctrl + Shift + U) і скидаємо насиченість на нуль. 

Переміщаємо знебарвлений колір під текстуру і викликаємо корекцію Levels (Рі-

вні) (Ctrl + Shift + L). Налаштовуємо тоновий баланс (рис. 8.51). До шару з текс-

турою застосовуємо режим накладення Multiply (Множення). Білі ділянки об-

личчя дівчини повністю перекриються текстурою, а чорні залишаться незмін-

ними, таким чином, буде видний мінімальний об’єм і контури майбутнього ви-

гляду. 

 

Рис. 8.51. Налаштування рівнів 
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16. Чорним м’яким пензлем великого розміру перекриваємо маскою очі, 

брови і волосся, що належать дівчині (рис. 8.52). 

 

 

Рис. 8.52. Робота за маскою 

 

17. Необхідно зробити обличчя дівчини трохи вужчим. Застосовуємо 

фільтр «Пластика». Filter → Liquify ... (Ctrl + Shift + X) до шару з дівчиною. За-

звичай обличчя ідентифікується автоматично. Якщо цього не відбудеться, кліка-

ємо по іконці з людиною зліва. Перетягуємо зазначену на скріншоті опорну то-

чку вліво, щоб зменшити обличчя в ширині (рис. 8.53). Це необхідно для того, 

щоб в наступному кроці задіяти більшу площу текстури для обтікання обличчя. 

 

 

Рис. 8.53. Застосування Пластики 



8. ВИКОРИСТАННЯ ФІЛЬТРІВ І РЕЖИМІВ НАКЛАДАННЯ. СТВОРЕННЯ ЖИВОПИСНИХ ІЛЮСТРАЦІЙ. ПАКЕТНА ОБРОБКА ЗО-

БРАЖЕНЬ (ACTION) 

 

 

221 

 

18. Переходимо до шару з текстурою і застосовуємо йому Пластику. Filter 

→ Liquify ... (Ctrl + Shift + X). Для інструменту палець налаштовуємо Size (Роз-

мір): 200, Pressure (Натиск) 15, Density (Щільність): 50. Налаштовуємо режим по-

переднього перегляду в розділі Show Background (Додаткові параметри). Use 

(Використовувати): Face, Mode (Режим): In Front (На передньому плані), Opacity 

(Непрозорість): 27 %. Захоплюємо курсором частину текстури за межами об-

личчя й уривчасто перетягуємо її на щоки (рис. 8.54). За таким принципом про-

ходимо по периметру всього обличчя, включаючи чоло. 

 

 

Рис. 8.54. Застосування пластики до шара з текстурою 

 

19. Міняємо розмір пензля (пальця) на 100/120 і повторюємо ту ж саму опе-

рацію з носом, переніссям і очницею. Чим більше деталей рельєфу обличчя буде 

враховано, тим реалістичніше ляже текстура. Рисунок 8.55 демонструє спроще-

ний варіант. 
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Рис. 8.55. Накладення текстури 

 

20. Після досягнення необхідного результату натискаємо Ok. Регулюючи 

прозорість, натиск і м’якість пензля, приховуємо порожнечі по межах зобра-

ження, перебуваючи на масці смарт-фільтра (рис. 8.56). 

 

 

Рис. 8.56. Робота з маскою смарт-фільтра 
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21. Залишилося збільшити тоновий контраст і освітлити зображення. По-

вертаємося до корекції Рівні на шарі «Face». Налаштовуємо рівні, додаємо роз-

миття за Гауссом з потрібними налаштуваннями (рис. 8.57). 

 

  

Рис. 8.57. Робота з рівнями та розмиттям за Гауссом 

 

22. Створюємо копію всіх шарів (Ctrl + Shift + Alt + E). Переводимо в 

смарт-об’єкт. Додаємо розмиття за Гауссом. Filter → Blur → Gaussian Blur. Радіус 

розмиття: 1,5px. На масці смарт-фільтра робимо видимим все те, що перебуває 

поза обличчям (рис. 8.58). 

 

 

Рис. 8.58. Розмиття меж зображення  



8. ВИКОРИСТАННЯ ФІЛЬТРІВ І РЕЖИМІВ НАКЛАДАННЯ. СТВОРЕННЯ ЖИВОПИСНИХ ІЛЮСТРАЦІЙ. ПАКЕТНА ОБРОБКА ЗО-

БРАЖЕНЬ (ACTION) 
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23. Додаємо коригувальний шар Соковитість над шаром з текстурою (рис. 

8.59). 

 

 

Рис. 8.59. Налаштування шару Соковитість 

 

Запитання для самоконтролю 

 

1. Які групи режимів накладання ви знаєте? 

2. Чи працює автоматизація (Action) з інструментами рисування 

3. За допомогою яких можливостей можна застосувати відразу декілька фі-

льтрів, змінювати їхній порядок та видимість? 

4. За допомогою яких фільтрів можна розмістити зображення на різних по-

верхнях? 

5. Які фільтри можна використовувати для створення текстури зобра-

ження? 
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9. СТВОРЕННЯ АНІМАЦІЇ 

 
9.1. Загальні поняття 

 

9.1.1. Види анімації 

Анімація – послідовність нерухомих зображень, що змінюють одне одного 

з певною частотою. Розрізняють такі види анімації (рис. 9.1). 

 

 

Рис. 9.1. Види анімації 

 

Анімований текст. Найчастіше використовується у вигляді рядка, що бі-

жить, на новинних сайтах. Можливо також застосування на звичайних сайтах то-

варів і послуг: наприклад, у вигляді анімованих заголовків або окремих рядків 

тексту. 

Анімовані об’єкти. Найпростіший варіант, який досить часто застосову-

ється на різних сайтах. Це окремі зображення і об’єкти, які показуються корис-

тувачеві. Наприклад, курсор, що рухається, плаваюча кнопка «вгору», кнопки за-

клику до дії, що змінюють колір, та ін. 

Анімовані зображення. Найпростіший приклад – анімовані рекламні ба-

нери на сайті. Вони можуть вести на картки товарів, внутрішні сторінки, блог 

або перенаправляти відвідувача на інший сайт. 

 

9.1.2. Стратегії анімації 

Розрізняють такі стратегії анімації (рис. 9.2). 
 

 

Рис. 9.2. Стратегії анімації
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Анімація очікування. Підходить для дій, які займають певну кількість часу. 

Наприклад, процес реєстрації, скачування з сайту PD – або Excel-документа, 

здійснення оплати. Якщо не показувати користувачеві, що дія виконується, він 

може запанікувати і почати тиснути на всі кнопки підряд. Анімація ж ніби про-

мовляє: спокійно, все йде за планом, залишилося почекати ще трохи. Як це реа-

лізувати? За допомогою анімованого пісочного годинника, що обертається, ци-

ферблата, файлів, які переміщуються з однієї папки в іншу, як при стандартному 

копіюванні. Тобто будь-яким способом показати рух і дати зрозуміти, що процес 

йде успішно. 

Анімація оповідання. Сторітеллінг – прекрасний інструмент маркетингу. 

Це коли замість звичайної реклами сповідається історія, пов’язана з конкретною 

компанією, товарами, покупцями. Людям цікавіше читати життєві ситуації, ніж 

дивитися стандартні фото товарів та заклики їх купити. Не оминув сторітеллінг 

стороною і анімацію. З її допомогою теж можна розповісти історію – тільки не 

текстом, а картинками, гіфками, короткими мультфільмами. 

Анімація підтвердження. Найпростіший варіант, який не несе цілі продати 

товар або послугу, лише викликає необхідні емоції. Наприклад, на головній сто-

рінці інтернет магазину користувач відкрив одну з категорій товару, одразу з’яв-

ляється анімація, яка привітно повідомляє: «Ммм, ножі та виделки – відмінний 

вибір!». Після додавання товару в кошик з’являється ще одна анімація: «Вітаємо, 

тепер цей товар у вас в кошику!». Тобто анімація як би підтверджує кожну дію, 

фіксуючи її в пам’яті відвідувача та викликаючи позитивні емоції [35]. 

Анімації шкали часу. Щоб анімувати вміст шару в режимі шкали часу, клю-

чові кадри на панелі «Шкала часу» встановлюються при переміщенні індикатора 

поточного часу до іншого часу (або кадру), а потім змінюється положення, не-

прозорість або стиль вмісту шару. Послідовність кадрів між двома існуючими 

кадрами автоматично додається або редагується, рівномірно змінюючи параме-

три шару (положення, непрозорість і стиль) між новими кадрами для створення 

враження руху [36]. 
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9.1.3. Робочий процес створення кадрів анімації 

У Photoshop для створення кадрів анімації існує панель «Шкала часу». Ко-

жен кадр являє собою структуру шарів. Доступні такі корекції шарів. 

‒ Вмикання або вимикання видимості для різних шарів. 

‒ Зміна положення об’єктів або шарів для створення враження руху вмісту. 

‒ Зміна непрозорості шару для поступового появлення або зникнення вмі-

сту. 

‒ Зміна режиму накладання шарів. 

‒ Додавання до шарів стилів [37]. 

 

9.1.4.Рисування в кадрах відеошарів 

Для створення анімації, додавання вмісту або видалення непотрібних дета-

лей можна редагувати окремі відеокадри або рисувати на них. Крім всіх інстру-

ментів рисування пензлем, можна використовувати інструменти «Штамп», «Ві-

зерунковий штамп», «Пензель відновлення» або «Точковий пензель віднов-

лення». Редагувати відеокадри можна також за допомогою інструмента «Латка». 

 

9.2. Практичні завдання 

 

9.2.1.Анімація об’єктів 

Початковий рівень. Створюємо кнопку зворотного виклику. (рис. 9.3, зра-

зок анімації у файлі «Callback.gif»). 

 

 

Рис. 9.3. Анімація кнопки зворотного виклику 
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1. Створюємо документ: 1080х1080 px, роздрібна здатність 72 ppi, прозорий 

фон. Перетягуємо зображення «handset.png» на центр полотна (рис. 9.4). 

 

 

Рис. 9.4. Розміщення вихідного зображення вікні проекту 

 

2. Додаємо вікно Інформація Window → Info або (F8), щоб зіставити розміри 

елементів, що будуть пізніше створені. На рисунку 9.5 позначені ті параметри, 

які потрібно буде налаштувати максимально точно для безперервної та плавної 

анімації. 

 

  

Рис. 9.5. Додавання вікна Інформація 
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3. У режимі вільного трансформування пропорційно збільшуємо телефонну 

трубку до 514х514 px (рис. 9.6). 

 

 

Рис. 9.6. Встановлення розмірів телефонної трубки 

 

4. Створюємо три кола в режимі фігура з такими налаштуваннями. 

‒ Велике коло. Розмір 905х905 px, непрозорість 20 %, колір 46b616. 

‒ Середнє коло. Розмір 737х737 px, непрозорість 35 %, колір 46b616. 

‒ Мале коло. Розмір 577х577 px. непрозорість 50 %. колір 46b616. 

Розміщуємо всі три фігури під шаром з трубкою. Позиціонуємо згідно з 

рисунком 9.7. 

 

 

Рис. 9.7. Позиціонування елементів зображення 
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5. Додаємо шкалу часу Window → Timeline. У вікні вибираємо «Create Video 

Timeline» (рис. 9.8). 

 

 

Рис. 9.8. Додавання шкали часу 

 

6. На шкалі часу обмежуємо тривалість анімації до 1,10с. Для цього при 

необхідності збільшуємо масштаб шкали часу, пересуваючи повзунок 

 вправо. Потім, захоплюємо курсором кінець шару з тру-

бкою і перетягуємо на позначку 10f, яка слідує за 1.00f на шкалі часу. Теж повто-

рюємо і для кіл (рис. 9.9). 

 

 

Рис. 9.9. Завдання тривалості анімації 

 

7. Для досягнення більш плавного руху об’єктів збільшуємо частоту кадрів 

до 60 fps. (Тільки в тому випадку, якщо індикатор ефективності не нижче ніж 
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95 %. Якщо ефективність нижче ніж 95 %, то треба пропустити цей крок, тому 

що на виході анімація може не зберегтися) (рис. 9.10). На панелі шкали часу пе-

реходимо в настройки анімації і вибираємо «Set Timeline Frame Rate» (Задати 

швидкість зміни кадрів на шкалі часу). Вводимо 60. Знову обмежуємо тривалість 

анімації до 1,10с (рис. 9.11). 

 

 

Рис. 9.10. Індикатор ефективності 

 

 

 

Рис. 9.11. Збільшення частоти кадрів анімації 
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8. Для того щоб анімувати розмір кіл, переводимо всі шари в смарт-

об’єкти. Потім відкриваємо налаштування анімації шару і встановлюємо ключові 

кадри для рядка «Transform№, щоб задати точку відліку масштабування фігури 

(рис. 9.12). 

 

 

Рис .9.12. Встановлення першого ключового кадру для рядка «Transform» 

 

9. Перемістимо індикатор поточного часу на 0:00:00:21 і в режимі вільного 

трансформування пропорційно збільшимо розмір трубки до 545 px. Тиснемо 

Enter, щоб встановити другий ключовий кадр (рис. 9.13). 

 

 

 

 

Рис. 9.13. Встановлення другого ключового кадру 
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10. Створюємо ефект вібрації. Встановлюємо індикатор поточного часу на 

0:00:00:32. У режимі вільного трансформування робимо поворот трубки не бі-

льше ніж на 3° за годинниковою стрілкою і натискаємо Enter. Переміщаємо ін-

дикатор поточного часу на 0:00:00:34 і в режимі вільного трансформування ро-

бимо поворот трубки 3 градуси проти годинникової стрілки. Повторюємо ці опе-

рації до 0:00:00:42. До цього часу має накопичитися 6 ключових кадрів, що від-

повідають за вібрацію під час дзвінка (рис. 9.14). 

 

 

Рис. 9.14. Створення ефекту вібрації 

 

11. Для того щоб вихідні і кінцеві параметри масштабу збігалися, перетя-

гуємо індикатор поточного часу на кінець шару з трубкою (рис. 9.15). У режимі 

вільного трансформування виставляємо розмір 514 px. Натискаємо Enter. Щоб 

переглянути анімацію телефонної трубки, тиснемо пробіл або кнопку Play на 

програвачі. 

 

 

Рис. 9.15. Коригування масштабу зображення та запуск перегляду анімації 
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12. Анімуємо кола. Переносимо індикатор поточного часу на початок 

шкали часу. Натиснувши на секундомір для рядка «Transform2, встановлюємо 

ключові кадри для кожного кола. Потім переносимо індикатор поточного часу в 

кінець часової шкали і натискаємо на жовтий квадрат У рядку «Transform», щоб 

встановити ключові кадри з такими ж параметрами масштабу (рис. 9.16). 

 

 

Рис. 9.16. Створення шкали часу для кожного кола 

 

13. Виставляємо індикатор поточного часу на 0:00:00:34. У режимі віль-

ного трансформування зменшуємо розмір кожного окремо взятого кола до таких 

значень: велике коло – 538х538 px, середнє коло – 505х505 px, мале коло – 

481х481px (рис. 9.17). 

 

 

Рис. 9.17. Зміна розміру кіл 
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14. Зберігаємо анімацію File → Export → Save For Web (Legacy) 

(Ctrl+Alt+Shift+S). Слід звернути увагу на виділені параметри (рис. 9.18). 

 

Рис. 9.18. Збереження анімації 

 

9.2.2. Анімація зображення 

Створюємо паралакс-ефект (рис. 9.19, зразок анімації – у файлі 

«Parallax.gif»). 

 

 

Рис. 9.19. Створення паралакс ефекту 
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1. Відкриваємо зображення «youth.jpg». Необхідно зменшити розмір зо-

браження, щоб не виникало проблем при збереженні анімації. Зменшуємо до 

1000х667 px. Image → Image Size (Ctrl + Alt + I) (рис. 9.20). 

 

 

Рис. 9.20. Зменшення розмірів зображення 

 

2. Інструментом “Quick Selection Toolˮ  виділяємо пару і землю. Вста-

вляємо на новий шар (Ctrl + C, Ctrl + V) (рис. 9.21). На рисунку відключена ви-

димість фонового шару тільки для того, щоб показати яку частину зображення 

необхідно виділити. 

 

 

 

Рис. 9.21. Створення нового шару з парою 
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3. Знову здійснюємо виділення пари. Для цього натискаємо на іконку шару 

з затиснутою клавішею Ctrl. Розширюємо межі виділення Select → Modify → 

Expand та вводимо 10 px (рис. 9.22). 

 

 

Рис. 9.22. Розширення меж виділення 

 

4. Не знімаючи виділення переходимо на фоновий шар і виконуємо зали-

вку з урахуванням вмісту Edit → Fill → Content-Aware (Shift + F5) (рис. 9.23). На 

рисунку відключена видимість шару з парою тільки для того, щоб показати ре-

зультат заливки з урахуванням вмісту. 

5. Створюємо відблиск. Для цього створюємо порожній шар (Ctrl + Shift + 

N). Натискаємо D, щоб скинути основний і фоновий колір на базові (чорний та 

білий). Натискаємо X, щоб чорний став фоновим. Натискаємо поєднання клавіш 

Ctrl + Shift + Del, щоб залити порожній шар чорним кольором. Переходимо в 

Filter → Render → Lens Flare і налаштовуємо вікно (рис. 9.24). 
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Рис. 9.23. Здійснення заливки з урахуванням вмісту 

 

  

Рис.9.24. Налаштування параметрів відблиску 

 

6. У режимі вільної трансформації зменшуємо відблиски до 759х507 px. 

Відображаємо шар по горизонталі. Щоб позбутися чорного фону, вибираємо ре-

жим накладення «Screen» (Екран). Непрозорість шару – 85 % (рис. 9.25). 
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Рис. 9.25. Зменшення відблисків 

 

7. Додаємо шкалу часу для початку анімації Window → Timeline. Вибира-

ємо «Create Video Timeline». Для анімації масштабування переводимо всі три 

шари в смарт-об’єкти. Дублюємо кожен шар (Ctrl + J). Виставляємо тривалість 

кожного шару 0:00:03:10. Потім зміщуємо початок кожного другого шару на кі-

нець попереднього (рис. 9.26). 

 

 

Рис. 9.26. Створення шарів на шкалі анімації 

 

8. Встановлюємо індикатор поточного часу на початок першого фонового 

шару і додаємо ключовий кадр, натиснувши на секундомір. Потім переміщаємо 

індикатор поточного часу на кінець першого фонового шару і в режимі вільного 
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трансформування пропорційно з центру збільшуємо шар до 1118х746 px. Натис-

каємо Enter. Переходимо до другого фонового шару і виставляємо для нього такі 

ж ключові кадри, але в зворотному порядку. Перший буде 1118х746 px, останній 

– 1000х667 px (рис. 9.27). 

 

 

Рис. 9.27. Анімація фонового шару 

 

9. Так само анімуємо пару. На початку першого шару ставимо ключовий 

кадр. У кінці – у режимі вільної трансформації перетягуємо правий верхній мар-

кер рамки, утримуючи клавішу Shift (рис. 9.28). Збільшуємо шар до 879 * 393 px 

(значення можуть не співпадати через неоднаковість виділення). На другому 

шарі з парою повертаємо вихідні розміри, як було у кроці 8. 

 

 

Рис. 9.28. Анімація шару з парою 
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10. Анімуємо відблиски. Встановлюємо ключовий кадр на початку пер-

шого шару. Переносимо індикатор поточного часу на кінець шару і в режимі ві-

льного трансформування повертаємо відблиск на 63° проти годинникової стрі-

лки. На другому шарі з відблисками перший ключовий кадр буде зі значенням 

63° проти годинникової стрілки, останній – 0° (повернеться до первісної позиції) 

(рис. 9.29). 

 

 

Рис. 9.29. Анімація відблисків 

 

11. Зберігаємо анімацію (Ctrl+Alt+Shift+S) з налаштуванням параметрів 

згідно з рисунком 9.30. 

 

 

Рис. 9.30. Збереження анімації 
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9.2.3. Покадрова анімація зображення 

Створюємо Glitch эффект на прикладі зображення виконавця Джареда 

Лето (рис. 9.31, зразок анімації – у файлі «Glitch-effect.gif»). 

 

 

Рис. 9.31. Покадрова анімація зображення 

 

1. Створюємо документ 1080х1080 px. Додаємо зображення «Leto.jpg». 

Додаємо коригувальний шар «Black White», виставляємо значення червоного на 

74 і масштабуємо як на рисунку 9.32. 

 

 

Рис. 9.32. Додавання в проєкт вихідного зображення та коригувального шару до нього 
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2. Виділяємо два шари і конвертуємо в смарт-об’єкт. Дублюємо отриманий 

шар. Клікаємо по верхньому шару два рази, щоб викликати вікно стилю шару. 

Залишаємо активним тільки червоний канал і натискаємо Ok (рис. 9.33). 

 

 

Рис. 9.33. Активація червоного каналу у вікні стилю шару 

 

3. Вибравши інструмент «Move Tool» (Переміщення)  (V), переміщу-

ємо стрілками на клавіатурі верхній шар вліво (рис. 9.34). 

 

 

Рис. 9.34. Результат зсуву копії шару 
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4. Дублюємо нижній шар. Вибираємо продубльований шар і шар, в якому 

редагували канали. Зводимо ці шари. Отриманий шар конвертуємо в смарт-

об’єкт (рис. 9.35). 

 

 

Рис. 9.35. Об’єднання шарів та перетворення результату у смарт-об’єкт 

 

5. Інструментом «Rectangle Marque Tool» (Прямокутне виділення)  (M) 

створюємо n-ну кількість прямокутників різних розмірів (рис. 9.36). 

 

 

Рис. 9.36. Створення виділення з прямокутників різних розмірів 
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6. Копіюємо і вставляємо прямокутники на новий шар (Ctrl + C, Ctrl + V). 

Повертаємося на другий шар і знову створюємо n-ну кількість прямокутників рі-

зних розмірів. Теж копіюємо їх на новий шар (Ctrl + C, Ctrl + V). Переходимо на 

шар з прямокутниками і інструментом «Move Tool» (Переміщення)  (V) змі-

щуємо їх вліво. Другий шар з прямокутниками зміщуємо вправо (рис. 9.37). 

 

 

Рис. 9.37. Додавання та пересування двох шарів з фрагментами зображення 

 

7. Дублюємо другий шар. Збільшуємо його і двічі застосовуємо фільтр «Ві-

тер» Filter → Stylize → Wind. У перший раз напрямок вітру зліва, у другий – 

справа (рис. 9.38). 

 

 

Рис. 9.38. Застосування ефекту Вітер 
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8. Виділяємо всі шари, крім першого, і приховуємо їх Layer → Hide Layers 

(Ctrl +). Створюємо шкалу часу, для чого вибираємо «Create Frame Animation». 

Першому шару виставляємо тривалість 1с. Створюємо новий кадр, клікаючи по 

іконці (рис. 9.39). 

 

 

Рис. 9.39. Додавання кадрів на шкалі часу. 

 

9. Щоб другий кадр відрізнявся від першого, вмикаємо видимість другого 

шару. Виставляємо для другого кадру тривалість 0.1с. Створюємо третій кадр 

(рис. 9.40). 

 

 

Рис. 9.40. Додавання третього кадру на шкалі часу та вмісту другого. 

 

10. Для третього кадру вмикаємо видимість одного з шарів з прямокутни-

ками. Виставляємо для третього кадру тривалість 0.1с. Створюємо четвертий 

кадр (рис. 9.41). 
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Рис. 9.41. Додавання четвертого кадру на шкалі часу та вмісту третього 

 

11. Для четвертого кадру вимикаємо видимість шару з прямокутниками з 

попереднього кадру і вмикаємо видимість невикористаного. Виставляємо четве-

ртому кадру тривалість 0.2с. Створюємо п’ятий кадр (рис. 9.42). 

 

 

Рис. 9.42. Додавання п’ятого кадру на шкалі часу та вмісту четвертого 

 

12.  Вміст п’ятого кадру повторює вміст третього (рис. 9.43). 

 

 

Рис. 9.43. Додавання вмісту п’ятого кадру на шкалі часу 
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13.  Зберігаємо анімацію (Ctrl + Alt + Shift + S) з налаштуваннями як на 

рисунку 9.30. Зверніть увагу на те, що вся анімація повинна бути зацикленою. 

 

9.2.4. Покадрова анімація за допомогою відеошару 

Створюємо покадрову анімацію з додаванням відеошару (рис. 9.44, зразок 

анімації у файлі Click.gif). Здається, що цей титан не такий вже і страшний. 

 

 

Рис. 9.44. Покадрова анімація за допомогою відеошару 

 

1. Відкриваємо відео «Click.mp4». Інструментом «Crop Tool» (Рамка)  

(С) кадруємо полотно (рис. 9.45). 

 

 

Рис. 9.45. Кадрування вихідного полотна. 
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2. Для того щоб менше прорисувати кадрів скорочуємо Frame Rate до 12 

кадрів у секунду. Оскільки ми працюємо з відеошаром, то його частоту відтво-

рення потрібно налаштувати окремо від шкали часу. Layer → Video Layers → 

Interpret Footage (рис. 9.46, рис. 9.47). 

 

 

 

Рис. 9.46. Відкриття вікна «Interpret 

Footage» 

Рис. 9.47. Встановлення частоти відтворення 

відеошару 

 

3. Встановлюємо частоту шкали часу. Вводимо значення 12 fps (рис. 9.48). 

 

 

Рис. 9.48. Встановлення частоти шкали часу 
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4. Розтягуємо шар до 0:00:14:08с. Створюємо порожній відеошар Layer → 

Video Layers → Blank Video Layer. Для того щоб розмістити новий шар над фо-

новим, вибираємо в палітрі шарів «Video Group 1». Розгруповуємо групу (Ctrl + 

Shift + G). Розміщуємо новий шар над фоновим (рис. 9.49). 

 

 

Рис. 9.49. Встановлення тривалості анімації та створення нового шару 

 

5. Прорисовуємо перший кадр – це літера I. Натискаємо на галочку на ві-

деодоріжці, щоб відстежувати розстановку кадрів. За допомогою білого пензлю 

(діаметр 16 px, 100% непрозорість) недбало прорисовуємо літеру I. При цьому на 

відеодоріжці відразу з’явитися відмітка про створений кадр (рис. 9.50). 

 

 

Рис. 9.50. Створення кадру з літерою І 
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6. Перемикаємося на наступний кадр стрілкою на клавіатурі. Для того щоб 

бачити попередній кадр і рисувати поверх нього вмикаємо режим кальки. Рису-

ємо на другому кадрі апостроф і заново літеру I (рис. 9.51). 

 

Рис. 9.51. Рисування в режимі кальки 

 

7. Не потрібно в кожному наступному кадрі створювати літеру (символ), 

бо вони з’являться буквально миттєво. Бажано прорисовувати однакову кількість 

кадрів (наприклад три), щоб букви з’являлися послідовно. Повторюємо попере-

дній крок, поки не буде написаний весь вираз «I’m inevitable». Стежимо за три-

валістю анімації напису: він повинен зникнути до клацання (рис. 9.52). 

 

 

Рис. 9.52. Створення повного напису 

 

8. Після створення напису переміщаємося на позначку 0:00:09:08 та рису-

ємо в 6 кадрах результат клацання (рис. 9.53). 

9. За аналогією переміщуємо індикатор поточного часу на 0:00:12:03 і про-

рисовуємо знаки питання (рис. 9.54). Вони повинні з’являтися послідовно, як у 

прикладі, що наведений у файлі «Click.gif». 
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Рис. 9.53. Прорисовування клацання Рис. 9.54. Прорисовування знаків питання 

 

10.  Зберігаємо проєкт та анімацію в форматі.gif  так само, як і в попередніх 

підрозділах (рис. 9.30). 

 

9.3. Завдання на самостійну роботу 

 

Анімація об’єктів. Підвищений рівень.  

Створити Guide для додатку, що продає, згідно зі зразком (рис. 9.55, зразок 

анімації наведений у файлі «Guide.gif»). 

 

 

Рис. 9.55. Анімоване керівництво для покупця 
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Запитання для самоконтролю 

 

1. У чому сильна сторона анімації розповіді? 

2. Які методи створення анімації використовує Adobe Photoshop? 

3. Які види анімації бувають? 

4. У чому полягає принцип створення анімації за ключовими кадрами? 

5. Як ви розумієте механіку роботи паралакс-ефекту? 
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10. РОЗРОБКА МАКЕТА СТОРІНКИ САЙТУ 

 

10.1 Загальні поняття  

 

10.1.1. Визначення та види сайтів 

Дизайн-макет сайту – це візуальний образ майбутнього сайту, розроблений 

з урахуванням технічних можливостей HTML верстки. Такий макет є демонст-

рацією того, як візуально буде виглядати ваш сайт після верстки та наповнення 

контентом. 

Специфіка розробки графічного дизайн-макета стосовно сайту виглядає як 

поєднання технічних і візуальних параметрів майбутнього сайту. Це опрацю-

вання розташування і розміру елементів сайту з точки зору зручності пошуку і 

використання інформації на сайті. 

Основою для розробки дизайн-макета сайту є надані замовником матері-

али: логотип, фірмовий знак, фірмові кольорі, слоган, графічні елементи, фотог-

рафії та інші елементи дизайну. 

Макети можна розділити на кілька великих груп: 

‒ макети з фіксованою шириною; 

‒ еластичні; 

‒ гумові; 

‒ адаптивні; 

‒ комбіновані. 

Розглянемо всі групи більш детально. 

‒ Фіксований макет сайту. Вважається, що фіксований дизайн є найпрос-

тішим варіантом макета сайту. Зазвичай він розташовується по центру вікна і має 

фіксовані параметри ширини. Його розміри не залежать від роздільної здатності, 

він у будь-якому випадку зберігає задані значення. Переваги такого варіанта оче-

видні. По-перше, цей макет дуже легко верстати. Усі параметри: ширину майбу-

тнього сайту, розміри його текстових модулів, графічних зображень і так далі
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розробник задає вже на стадії підготовки, так що верстальнику залишається 

тільки слідувати цим вказівкам. Крім того, коли відома ширина всіх колонок, ро-

зміри зображень добирати значно простіше. Браузери набагато краще сприйма-

ють саме фіксований макет сторінки сайту, тому на налагодження роботи витра-

чається набагато менше часу. 

Однак є і мінуси, головний з яких – неефективне використання вільного 

простору. Так, якщо задати дуже велику ширину, то на компактних екранах нет-

буків сайт буде відображатися вкрай непривабливо: з’явиться горизонтальна 

смуга прокрутки. А при роздільній здатності монітора, наприклад 1920 х 1080px, 

по краях сторінки сайту шириною 960рх залишаться дві білі смуги. 

‒ Гумовий макет сайту. Він має ширину, встановлену в процентному спів-

відношенні. Таким чином ширина і висота сайту також змінюються при зміні ро-

зміру вікна. На відміну від фіксованого макета, який на великих екранах відобра-

жається непривабливо, «гумовий сайт» займає всю площу вікна. Такі веб-сторі-

нки вдало виглядають не тільки на моніторах персональних комп’ютерів або но-

утбуків, але і на екранах телефонів. Однак на великих моніторах текст сильно 

розтягується, читати його стає некомфортно. Звичайно, в цьому випадку дуже 

допомагає контроль ширини за допомогою властивості max-width, а деякі влас-

ники великих моніторів просто зменшують розмір вікна. Крім того, розробникам 

набагато важче тестувати такі сайти тому налагодження відбувається набагато 

складніше. 

‒ Еластичний макет сайту. За своїм зовнішнім виглядом такі .psd макети 

сайтів нічим не відрізняються від гумових або фіксованих до того моменту, поки 

користувач не спробує змінити в браузері розмір шрифту. В цьому випадку разом 

з параметрами шрифту змінюються й інші модулі вебсторінки: шапка, футер, 

графічні елементи. Це відбувається тому, що розмір всього макета в цілому, так 

само як і його окремих модулів, задається не в пікселях або відсотках, а в em – 

відносній одиниці довжини. 
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Переваги цього макета: по-перше, сайт зберігає стабільне співвідношення 

елементів у будь-якій ситуації і не «розвалюється» при збільшенні шрифту. «Ела-

стичний» веб-ресурс добре виглядає у будь-якій операційній системі, однак вер-

стати його не дуже зручно, а тестувати сайт потрібно досить довго. Сфера засто-

сування подібного дизайну обмежена. І все ж багато розробників віддають пере-

вагу саме йому, оскільки сайт у цьому випадку завжди зберігає цілісність елеме-

нтів і первинний зовнішній вигляд, а це дуже важливо для його розкрутки. 

‒ Адаптивний макет сайту. Адаптивний макет сайту – це навіть не один, 

а відразу кілька ескізів, що показують, як буде відображатися сторінка з різною 

роздрібною здатністю. Тобто фактично дизайнер створює не один макет сайту, а 

безліч варіантів однієї і тієї ж сторінки. У ході верстки заготовлюється кілька 

правил під кожен варіант роздрібної здатності, а також скрипти, які визначають, 

яким правилом слід користуватися у цьому конкретному випадку. 

Основна перевага даного дизайну – його безперечна зручність для відвіду-

вача. Однак для розробника це найважчий тип дизайну, оскільки потрібно фак-

тично створити не один, а відразу кілька макетів з унікальною графікою і своїм 

CSS. Ось чому його розробка і верстка віднімають так багато часу, хоча тесту-

вати його легше, ніж еластичний або гумовий макет. 

‒ Комбінований макет сайту. Комбінований тип не може вважатися само-

стійним, оскільки лише поєднує в собі елементи чотирьох попередніх видів вер-

стки. Однак це найбільш мобільний, самий гнучкий вид. Комбінованим може 

бути макет сайту інтернет-магазину, візитки, корпоративного сайту та іншого 

будь-якого вебресурсу. Додаючи при розробці елементи гумової, еластичної, фі-

ксованої, адаптивної верстки, розробник може створити ідеальний макет сайту, 

приховати недоліки і підкреслити сильні сторони того чи іншого типу. 

 

10.1.2. Основні рекомендації при створенні макета сторінки сайту 

1. Необхідно дотримуватися всіх вимог інтерактивного дизайну: 

‒ застосовувати колірну моделі RGB [38] при створенні макета. Це стан-

дарт для моніторів і екранів; 
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‒ використовувати модульну сітку, щоб вирівнювати контент всередині 

макета [39, 40]; 

‒ не збільшувати маленькі картинки; 

‒ при зміні розміру зображень для збереження пропорцій треба використо-

вувати затиснуту клавішу Shift; 

‒ при необхідності використання похилого або жирного тексту, треба за-

стосовувати один зі стилів шрифту. Для зміни зовнішнього вигляду літер псев-

достилі не використовують. 

2. Необхідно позбавлятися дрібних відстаней. 

Усі розміри відстаней та відступів повинні бути виражені цілими парними 

числами. Непарні числа і дроби використовувати не рекомендовано. 

3. Необхідно впорядковувати шари та монтажні області. 

Якщо дизайнер розміщує шари в хаотичному порядку, не іменує їх, прихо-

вує невідповідні варіанти, то з таким макетом складно працювати верстальнику 

та іншим фахівцям. Для впорядкування шарів необхідно: 

‒ видаляти приховані і порожні шари; 

‒ групувати шари за змістом; 

‒ присвоювати назву кожному шару. 

4. Необхідно розміщувати елементи на окремій монтажній області. 

Усі елементи, які не можна відобразити за допомогою HTML і CSS, вино-

сяться на окрему сторінку макета. Це іконки, картки і деякі кнопки. Елементи 

можна відразу експортувати в формат PNG або SVG. 

5. Треба додавати до макета шрифти та іконки 

Якщо в макеті використовуються непоширені шрифти, то треба додати 

файл з ними разом з макетом. Якщо шрифт є в сервісі Google Fonts [41], треба 

дати розробнику посилання на нього. У цьому випадку файл не знадобиться, 

тому що на сайт його підключають через цей сервіс. В архів до макета приклада-

ють усі елементи, які експортувалися з монтажної області. Якщо ці файли в фо-

рматі PNG, то потрібно зробити версії в декількох роздрібних здатностях. 



9.РОЗРОБКА МАКЕТА СТОРІНКИ САЙТУ 

 

258 

 

6. Застосовувати анімацію, щоб показати рух елементів. 

Анімовані макети використовують не тільки для демонстрації сайту в 

портфоліо або презентації замовнику. Якщо потрібно, щоб елементи рухалися і 

взаємодіяли один з одним, створюється інтерактивний прототип і демонстру-

ється розробнику.  

7. Використовувати спеціалізоване програмне забезпечення. 

Adobe Photoshop – універсальний редактор, придатний у тому числі і для 

створення макетів сайтів. Але його досить непросто освоїти. У подальшому, 

якщо спеціалізуватися на виготовленні великої кількості макетів сторінок сайтів, 

доцільно використовувати нове покоління програм, призначених спеціально для 

вебдизайну: Adobe XD, Figma, Sketch. 

 

10.2. Практичне завдання 

 

Створюємо макет головної сторінки сайту з виготовлення та продажу екс-

клюзивних гітар (рис. 10.1) (див. «SiteLayout.jpg»). 

 

 

Рис. 10.1. Результат роботи 
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1. Створюємо документ з необхідними параметрами (рис. 10.2). Для того 

щоб працювати не зі звичайним полотном, а саме з монтажною областю 

(Artboard) – вибираємо тип документа Web, а потім задаємо розміри і колірний 

профіль. 

 

Рис. 10.2. Налаштування документу 

 

2. Створюємо макет напрямних (рис. 10.3). Будемо використовувати стан-

дартну 12-ти стовпчикову сітку. View → New Guide Layout... (Вид → Новий ма-

кет напрямних). 

 

 

Рис. 10.3. Налаштування макета напрямних 
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3. Робота з шарами має важливу роль при підготовці макета до верстки, 

тому приділяємо увагу точному найменуванню латинськими термінами і групу-

ванню шарів відповідно до ієрархії сайту (рис. 10.4). 

 

 

Рис. 10.4. Початок побудови ієрархії сайту 

 

4. Перш ніж перейти до створення макета, необхідно визначити колірну 

палітру сайту. Для цього можна використовувати сервіс Adobe Color [1] 

(рис. 10.5) (це буде дуже корисно і для майбутніх проєктів). 

 

 

Рис. 10.5. Сервіс Adobe Color 

 

5. Щоб використовувати попередньо завантажену палітру, переходимо в 

панель Swatches (Зразки) і в меню панелі вибираємо Load Swatches (Завантажити 
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зразки). Відкриваємо папку «Исходники» і змінюємо розширення на «.ASE». Ви-

бираємо файл з цим розширенням і бачимо, що наша палітра поповнилася но-

вими кольорами (рис. 10.6, 10.7). 

  

Рис. 10.6. Завантаження палітри кольорів 

 

   

Рис. 10.7. Підключення палітри 

 

6. Для створення першого екрана виділяємо під нього 874px по вертикалі. 

Оскільки висота всієї сторінки залежить від кількості першочергового контенту 

на ній, будемо постійно «розтягувати» наш Artboard по вертикалі. Клікнувши по 

монтажній області, трохи розтягуємо її вниз і виставляємо напрямну на позначці 

874px, щоб обмежити перший екран по вертикалі (рис. 10.8). 
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Рис. 10.8. Збільшення висоти документа 

 

7. Створюємо блок меню. Як правило, меню займає близько 10 % від пер-

шого екрана. Щоб блок не вийшов занадто високим (87px), задаємо йому розміри 

1280х80px. Вибираємо Rectangle Tool (Прямокутник)  (U), натискаємо в 

будь-якому місці монтажної області і вводимо розміри 1280х80px. Вирівнюємо 

по верхньому краю монтажної області і по центру (рис. 10.9). 

 

 

Рис. 10.9. Створення блоку меню 

 

8. Знімаємо обведення у прямокутника і вибираємо темно-синій колір для 

заливки з встановленої палітри (рис. 10.10). 

 

 

Рис. 10.10. Колір блоку меню 
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9. Додаємо логотип, сторінки і іконки (геолокація, особистий кабінет і ко-

шик) (рис. 10.11). Відкриваємо документ «Info.psd» і копіюємо перераховані 

вище елементи. Зменшуємо логотип до 49х50px. Іконку геолокації повертаємо 

на 60° за годинниковою стрілкою. Пропорційно зменшуємо розмір іконок (кож-

ної окремо) до 22px у висоту. Розміщуємо елементи в панелі меню. Спершу ви-

рівнюємо логотип і кошик за першою і останньою напрямними відповідно. (То-

чно «приліпити» об’єкти допомагають швидкі напрямні, які підсвічуються роже-

вим кольором). 

 

 

Рис. 10.11. Іконки навігації 

 

10. Потім виділяємо всі додані елементи з урахуванням блоку меню і ви-

конуємо вирівнювання по горизонталі . Після цього за рахунок швидких на-

прямних вирівнюємо по ширині іконки (рис. 10.12). Відстань між іконками має 

бути 22px. 

 

 

Рис. 10.12. Вирівнювання іконок 

 

11. Додаємо посилання на сторінки. Створюємо порожній шар. Вибираємо 

інструмент Horizontal Type Tool (Текст)  (T), натискаємо в будь-якому місці 

на панелі меню, починаємо прописувати: «ГЛАВНАЯ КАТАЛОГ ДОСТАВКА 

О МАГАЗИНЕ НОВОСТИ КОНТАКТЫ». Налаштовуємо параметри шрифту 
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(рис. 10.13). Між сторінками відстані по 5 пробілів. Вирівнюємо текстовий шар 

за напрямною так, щоб пікселі літери «Г» впритул упиралися в вертикальну на-

прямну. Після вирівнювання виділяємо всі елементи блоку меню, включаючи па-

нель меню, і знову вирівнюємо по вертикалі . 

 

 

 

Рис. 10.13. Налаштування штифту та позиціонування пунктів меню 

 

12. Присвоюємо назви шарам з пунктами меню і групуємо перші резуль-

тати в папку «Menu» (рис. 10.14). 

 

 

Рис. 10.14. Група шарів меню 

 

13. Створюємо блок новинок, спеціальних пропозицій і ексклюзивних мо-

делей. Додаємо в проєкт зображення «First_screen.jpg». Дублюємо (Ctrl + J) і при-

ховуємо видимість верхнього шару (рис. 10.15). Нижній шар збільшуємо доти, 

поки він не займе ширину всього документа, не виходячи за його межі. Вирівню-
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ємо фото по панелі меню за рахунок швидких напрямних. (Тут і в наступних кро-

ках не повинно бути накладення шарів один на одного з метою перекрити/при-

ховати якісь похибки). 

 

Рис. 10.15. Фонове зображення першого екрана 

 

14. До видимого шару застосовуємо корекцію і фільтр, щоб зменшити його 

яскравість і чіткість і таким чином вивести шар дублікат на перший план. Для 

цього використовуємо Криві і розмиття за Гауссом. Переходимо Image → 

Adjustments → Curves (Зображення → Корекції → Криві) (Ctrl + M). Потім пере-

ходимо Filter → Blur → Gaussian blur... (Фільтри → Розмиття → Розмиття за Га-

уссом) (рис. 10.16). 

 

 

Рис. 10.16. Використання Кривих і розмиття за Гауссом 
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15. Обрізаємо розмиті межі зображення. Для цього растризуємо шар і пря-

мокутним виділенням виділяємо область зображення до нерозмитих пікселів 

(рис. 10.17). Видаляємо, і стрілками на клавіатурі переміщуємо впритул до па-

нелі меню. 

 

 

Рис. 10.17. Виділення розмитих меж зображення зверху 

 

16. Потім, прямокутним виділенням виділяємо нижню частину фото аж до 

напрямної (874px) і видаляємо зайві пікселі (рис. 10.18). 

 

 

Рис. 10.18. Виділення нерозмитих пікселів знизу 

 

17. Отримуємо такий результат (рис. 10.19). 

 

 

Рис. 10.19. Чіткі межі зображення  
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18. Створюємо градієнт. Вибираємо Rectangle Tool (Прямокутник)  (U) 

і створюємо прямокутник 1280х324px. Вибираємо градієнтну заливку і налашто-

вуємо градієнт як показано на рисунку 10.20. Після чого розміщуємо блок з гра-

дієнтом у верхній частині фото. 

 

Рис. 10.20. Налаштування градієнта 

 

19. Включаємо видимість шару дубліката. Масштабуємо його так, щоб він 

ідеально розмістився в межах 12 -ти стовпчикової сітки. Розміщуємо фото на ви-

соті 80px від панелі меню. Цю відстань зручно заміряти прямокутником. Ство-

рюємо прямокутник будь-якої ширини висотою в 80px і розміщуємо його між 

фото і меню (рис. 10.21). Після того як відміряли і виставили фото, видаляємо 

прямокутник. 

 

 

Рис. 10.21. Розміщення слайда на відстані 80px 
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20. Застосовуємо корекцію Curves (Криві) (Ctrl + M) так само, як і для фо-

нового фото. Двічі натискаємо по шару з фото, щоб викликати стилі шару. Вклю-

чаємо тінь і налаштовуємо як на рисунку 10.22. 

 

Рис. 10.22. Налаштування тіні 

 

21. Повторюємо процедуру створення градієнта, тільки тепер для прямо-

кутника з розмірами 1036х308px (рис. 10.23). 

 

 

Рис. 10.23. Створення градієнта 
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22. Створюємо напис для першого слайду. Створюємо порожній шар. Оби-

раємо інструмент Текст і прописуємо таку назву: «Fender Stratocaster». Налашто-

вуємо параметри шрифту (рис. 10.24). 

 

 

Рис. 10.24. Налаштування шрифту 

 

23. Вирівнюємо текстовий шар за напрямною (рис. 10.25). Колір шрифту 

беремо піпеткою із зразків. Це перший колір праворуч від синього. Не забуваємо 

про найменування шарів. 

 

 

Рис. 10.25. Вирівнювання напису 

 

24. На висоті 23px від напису створюємо посилання «подробнее». Вирів-

нювання за тією ж напрямною, за якою рівняли назву гітари. Налаштування шри-

фту показано на рисунку 10.26. 

 

 

Рис. 10.26. Налаштування шрифту 
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25. Створюємо кнопки перемикання між слайдами і робимо першу кнопку 

активною. Вибираємо інструмент Ellipse Tool (Еліпс)  (U) і створюємо чо-

тири кола розміром 12х12px. Розміщуємо їх у нижній частині першого слайда і 

вирівнюємо по центру монтажної області, а потім і за шириною кнопок . Ко-

лір для обведення і заливки кнопок той же, що і для шрифтів (рис. 10.27). Групу-

ємо кнопки в групу «Pages». 

 

 
Рис. 10.27. Створення та позиціонування кнопок 

 

26. Створюємо рядок пошуку. Створюємо прямокутник 508х43px. Задаємо 

йому радіус округлення 5px і товщину обведення 1px. Колір заливки #f2eadf, ко-

лір обведення #bfa18f. Додаємо іконку пошуку з файлу «Info.psd». Задаємо роз-

міри іконки 16х32px і обертаємо її на 45° за годинниковою стрілкою. Пропису-

ємо текст «Знайдіть свою гітару...» і налаштовуємо його параметри як на рисунку 

10.28. Виділяємо все і вирівнюємо за горизонталлю . Виділяємо рядок по-

шуку між меню і слайдом головного екрана. Для того щоб відміряти однакову 

відстань зверху та знизу, знов скористаємося тим самим прямокутником та вирі-

внюванням за горизонталлю . Групуємо всі елементи пошуку в окрему групу 

«Search». 

 

  

Рис. 10.28. Налаштування шрифту і вирівнювання рядку пошуку  
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27. Створюємо класифікацію. Створюємо прямокутник 1280х324px. При-

бираємо обведення і заливаємо темно-синім кольором з палітри. Після цього 

створюємо чотири кола 244х244px. Позиціонуємо кола (рис. 10.29), вирівнюючи 

все за напрямними. 

 

 

Рис. 10.29. Створення та позиціонування класифікації 

 

28. Додаємо чотири зображення з групи «Класифікація», які стануть фоно-

вими для надписів. Розміщуємо в такій послідовності: Класична, Акустична, 

Електро, Укулеле. Масштабуємо кожне фото так, щоб воно займало три колонки. 

Створюємо відсічну маску для кожного кола (рис. 10.30). Виділяємо всі елементи 

класифікації разом з панеллю і вирівнюємо за горизонталлю. 

 

 

Рис. 10.30. Застосування відсічної маски та позиціонування зображень 

 

29. Дублюємо кожне коло (тільки коло, не фото) і в палітрі шарів перемі-

щуємо дублікат поверх відсічної маски і фото. Після цього маска може відклю-
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читися. Це не проблема, просто підключіть її назад. Для всіх дублікатів вибира-

ємо заливку: #8c493a і виставляємо непрозорість 65 %. Щоб не губитися в шарах, 

створіть окрему групу для кожної кнопки панелі класифікації (рис. 10.31). 

 

 

Рис. 10.31. Ієрархія шарів 

 

30. Створюємо текст для кожної кнопки. Щоб вирівняти текст по вертикалі 

в кожній кнопці, виділяємо текст і коло, на якому він написаний, і вирівнюємо 

по вертикалі . Щоб вирівняти текст по горизонталі, встановлюємо напрямну 

на позначку 1480px. View → New Guide (Вид → Нова напрямна) (рис. 10.32). 

 

  

Рис. 10.32. Створення та позиціонування тексту 

 

31. Далі створюємо інтерактивний блок, який залежно від вибору буде ре-

комендувати продукцію з різним бюджетом і якістю виконання. Розтягуємо мо-

нтажну область вниз. Створюємо прямокутник 983х793px. Інструментом вида-

лення опорних точок  видаляємо правий нижній кут прямокутника. Знімаємо 
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обведення, даємо довільну заливку і дублюємо трикутник (Ctrl + J). Відобража-

ємо дублікат по горизонталі і по вертикалі. Розміщуємо обидва трикутника, як 

показано на рисунку 10.33. 

 

 

Рис. 10.33. Створення фігур-контейнерів для інтерактивного блоку 

 

32. Додаємо зображення з папки «Кто вы» і засобами відсічної маски об-

межуємо зображення створеними фігурами (рис. 10.34). 

 

 

Рис. 10.34. Застосування відсічної маски 

 

33. Підключаємо тінь через стилі шару для кожної фігури і виставляємо 

значення як на рисунку 10.35. 
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Рис. 10.35. Налаштування тіні для лівого та правого прямокутника відповідно 

 

34. Створюємо тонування для кожного зображення кнопки так само, як це 

робили в класифікації, щоб по всьому макету простежувалася єдність кольорової 

палітри (рис. 10.36). Дублюємо кожен трикутник, переносимо на передній план, 

заливаємо темно-синім з палітри і знижуємо непрозорість до 50 %. 

 

 

Рис. 10.36. Створення тонування 

 

35. Створюємо текст. Як і в панелі класифікації, найкраще створити групу 

шарів для новачка і для профі окремо. Прописуємо слова «Новичок» і «Профи» 

з настройками, які наведені нижче. Вирівнюємо за допомогою все тих же прямо-

кутників. Для «новачка» відступ зверху (а для «профі» – знизу) 204px. «Новичок» 

вирівнюємо за напрямною другої колонки, а «Профи» по букві «и» передостан-

ньої колонки (рис. 10.37). 
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Рис. 10.37. Налаштування та позиціонування тексту 

 

36. Розміщуємо поверх зображення питання: «Кто вы?». Налаштування 

шрифту наведені нижче. Колір шрифту #bfa18f. Створюємо блок, який стане фо-

ном для двох трикутників із зображеннями. Створюємо прямокутник з розмірами 

1280х793px. Знімаємо обведення і заливаємо прямокутник темно-синім кольо-

ром. Переміщуємо прямокутник на задній план і не знімаючи виділення перехо-

димо в режим вільної трансформації (Ctrl + T). Після того як біля прямокутника 

з’явилася рамка з маркерами для трансформації, встановлюємо горизонтальну 

напрямну у середині фото і відносно неї вирівнюємо текст «Кто вы?» (рис. 10.38). 

 

 

 

Рис. 10.38. Створення та позиціонування тексту 
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37. Перевіряємо правильність найменувань шарів і їх групи (рис. 10.39). 

 

 

Рис. 10.39. Ієрархія шарів 

 

38. Додаємо зображення «Медиатор.jpg». Масштабується так, щоб фото 

займало всю ширину монтажної області (1280px). Вирівнюємо по інтерактив-

ному блоку. Створюємо прямокутник такого ж розміру, як і фото. Для того щоб 

дізнатися розміри відмасштабованого зображення, в режимі вільної трансформа-

ції (Ctrl + T) відкриваємо вікно Info (якщо його немає, переходимо Window → 
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Info (Вікно → Інформація)). Там будуть параметри фото . Побачивши роз-

міри фото, створюємо прямокутник таких же розмірів, який слугуватиме градіє-

нтом. Кольори градієнта: від #1e1c26 до #bfa18f (рис. 10.40). 

 

 

Рис. 10.40. Налаштування градієнта 

 

39. Додаємо заголовок. «Добейтесь максимального звукоизвлече-

ния» і налаштування для шрифту (рис. 10.41). Вирівнюємо текст за остан-

ньою (12-ю) колонкою сітки. 

 

 

Рис. 10.41. Створення та вирівнювання напису  
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40. Посилання «подробнее» прописуємо з тимиж параметрами, що і для 

першого екрана. Розміщуємо на висоті 24px від «Добейтесь максимального зву-

коизвлечения» (рис. 10.42). 

 

  

Рис. 10.42. Налаштування та позиціонування тексту 

 

41. Додаємо назва бренду «Big Stubby». Налаштовуємо як на рисунку 

10.43. Вирівнюємо по правій напрямній 12-ї колонки. 

 

 

 

Рис. 10.43. Налаштування та розміщення тексту 
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42. Перевіряємо впорядкованість шарів (рис. 10.44). 

 

 
 

Рис. 10.44. Ієрархія шарів 

 

43. Додаємо блок «Гітари на замовлення, як у знаменитостей». Розтягуємо 

монтажну область вниз. Створюємо прямокутник 1280х832px. Знімаємо обве-

дення і заливаємо: #bfa18f. Додаємо зображення з виконавцями. Розміщуємо та-

ким чином, щоб одне зображення займало рівно чотири колонки (рис. 10.45). 

Фото Фредді Меркьюрі вимагає додаткової обробки, тому растеризуємо його, ін-

струментом Прямокутне виділення (М) виділяємо і видаляємо зайві пікселі. 

 

 

Рис. 10.45. Розміщення зображень з виконавцями 
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44. Додаємо тінь усім артистам. Досить додати одному, а для інших, через 

контекстне меню, скопіювати стиль шару і вставити його (рис. 10.46). 

 

  

Рис. 10.46. Застосування тіні 

 

45. Створюємо градієнт для трьох виконавців (рис. 10.47). Розмір прямо-

кутників з градієнтом повинен збігатися з розмірами зображень. Кольори граді-

єнта: від #1e1c26 до #8c493a. 

 

 

Рис. 10.47. Градієнт для зображень 
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46. Прописуємо імена артистів. Налаштування шрифту вказані нижче. Ко-

жний напис вирівнюємо по вертикалі і горизонталі відповідного фото 

(рис. 10.48). 

 

 

 

Рис. 10.48. Створення та позиціонування тексту 

 

47. Створюємо Check Box для кожного фото. Інструментом Еліпс створю-

ємо коло 30х30px, товщина обведення 2px, колір обведення #f2eadf. Розміщуємо 

в правому нижньому куті кожного фото на відстані 20px від країв. Всередині 

першої окружності створюємо коло 20х20px (рис. 10.49). 

 

   

Рис. 10.49. Створення Check Box 
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48. Прописуємо назву блоку. Вирівнюємо по центру монтажної області. 

Ставимо напрямну на верхню сторону блоку (фону) і ще одну на фото артистів. 

Між ними створюємо прямокутник і вирівнюємо текст по горизонталі прямоку-

тника (рис. 10.50). 

 

 

 

Рис. 10.50. Створення та вирівнювання назви блоку 

 

49. Створюємо кнопку «Заказать». Створюємо прямокутник 196х60px з ра-

діусом заокруглення 10px. Колір: #8c493a. Вирівнюємо по двом центральним ко-

лонам і відступаємо від нижньої межі блоку (фону) на 24px (рис. 10.51). 

 

 

Рис. 10.51. Створення та вирівнювання кнопки 
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50. Додаємо напис «Заказать». Вирівнюємо по горизонталі і по вертикалі 

кнопки (рис. 10.52). 

 

 

 

Рис. 10.52. Створення напису 

 

51. Розміщуємо слайдери. З файлу «Info.psd» перетягуємо слайдери. Вирі-

внюємо по горизонтальній напрямній, яка проходить точно посередині всіх 

трьох зображень. Масштабуємо (рис. 10.53). Відступаємо на 6px від краю зобра-

ження. 

 

 

Рис. 10.53. Розміщення слайдерів 
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52. Впорядковуємо шари (рис. 10.54). 

 

 

Рис. 10.54. Ієрархія шарів 

 

53. Створюємо «блок надійності сервісу». Створюємо прямокутник 

1280х500px. Прибираємо обведення, даємо колір заливки #1e1c26. Створюємо 

три квадрати і вирівнюємо їх по сітці (рис. 10.55. Відстань від нижнього краю 

блоку 50px. 

 

 

Рис. 10.55. Створення блоку з трьома контейнерами 
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54. Додаємо зображення з папки «Хто ми». За рахунок відсічної маски ро-

зташовуємо зображення в квадратах. Вирівнюємо фото таким чином, щоб стала 

видима найважливіша інформація (рубанок, край дощечок і музикант). Дублю-

ємо всі три фігури, ставимо на передній план, створюємо градієнт. Для градієнта 

використовуємо один колір: #8c493a (рис. 10.56). 

 

 

Рис. 10.56. Створення градієнта 

 

55. Підписуємо кожне фото. «40 лет опыта», «Качественные материалы» і 

«Одобрение профессионалов». Вирівнюємо текст по горизонталі і по вертикалі 

кожного окремого квадрата (рис. 10.57). 

 

 

 

Рис. 10.57. Створення та розміщення тексту 



9.РОЗРОБКА МАКЕТА СТОРІНКИ САЙТУ 

 

286 

 

56. Додаємо питання «Почему мы?». Налаштовуємо як на рисунку 10.56. 

Вирівнюємо по вертикалі монтажної області. І відступаємо на 42px від фото 

вгору (рис. 10.58). 

 

 

 

Рис. 10.58. Створення та розміщення тексту 

 

57. Перевіряємо впорядкованість шарів (рис. 10.59). 

 

 

Рис. 10.59. Ієрархія шарів 
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58. Створюємо Footer (Підвал). За необхідністю розтягуємо вниз монтажну 

область. Створюємо прямокутник 1280х436px. Прибираємо обведення і встано-

влюємо заливку #1e1c26. Перетягуємо іконки соціальних мереж з документа 

«Info.psd». Виділивши групу іконок, переходимо в режим вільної трансформації 

(Ctrl + T) і пропорційно збільшуємо\зменшуємо розмір групи до 210х43px. Роз-

міщуємо на висоті 16px від верхнього краю «підвалу» (рис. 10.60). 

 

 

Рис. 10.60. Додавання іконок соціальних мереж 

 

59. Встановлюємо напрямну на позначці 4492px. Створюємо текстовий 

блок. Інструментом Текст виділяємо область для першої колонки «Контакти». 

Кожен текстовий блок буде займати по три колонки. Налаштовуємо шрифт 

(рис. 10.61). Відстань між «Контактами» і першим номером – 2 інтервали. 

 

  

Рис. 10.61. Створення та налаштування текстового блоку 
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60. За аналогією створюємо ще три колонки. Заголовки робимо жирним 

шрифтом (рис. 10.62). 

 

 

Рис. 10.62. Доповнення Footer-у 

 

61. Додаємо іконку зміни мови. Вибираємо інструмент Custom Shape Tool 

 (U). Зі списку запропонованих фігур вибираємо потрібну іконку. Розмір: 

20х20px, колір #f2eadf (рис. 10.63). 

 

 

Рис. 10.63. Додавання іконки зміни мови 



9.РОЗРОБКА МАКЕТА СТОРІНКИ САЙТУ 

 

289 

 

62. Розміщуємо іконку в правому нижньому куті, виставляючи її по напря-

мних (рис. 10.64). 

 

Рис. 10.64. Позиціонування іконки зміни мови 

 

63. Перевіряємо, щоб розмір монтажної області точно збігався з крайніми 

елементами макета (Header, Footer). Перевіряємо шари Footer-a. Перевіряємо 

впорядкованість усіх груп (рис. 10.65). Видаляємо всі невикористані або прихо-

вані шари, видаляємо всі горизонтальні напрямні, щоб вони не заважали в пода-

льшому верстальнику. 

 

  

Рис. 10.65. Впорядкованість структури документа 

 

64. Зберігаємо документ у форматі «.psd» і «.png». PSD буде використаний 

під час верстки для перегляду координат і властивостей всіх об’єктів, а PNG буде 

використовуватися для Mockup і для замовника. JPG не використовуємо, оскі-

льки це формат спотворює контури шрифтів. Зберігаємо для Web (Ctrl + Alt + 

Shift + S) (рис. 10.66). 
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Рис. 10.66. Збереження проєкту 

 

10.3. Завдання на самостійну роботу 

 

Розробити макет головної сторінки сайту, обравши тематику із переліку 

запропонованих. 

Запитання для самоконтролю 

 

1. Які основні правила створення макету ви знаєте? 

2. Який тип сайту сприймається браузерами найкраще? 

3. Чому є необхідність використовувати 12-ти колонну модульну сітку? 

4. Чому зберігати зображення краще у PNG форматі? 

5. Чому необхідно стежити за порядком у палітрі шарів?
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